
 DBDOC Release Notes  

Version 11.3 – March, 2022

Overall:
1. BuildPlus "automagically" detects and builds the latest version of time/date stamped data for 

SPO SPlus Operations Databases (time-stamped .XLSX files) and SPE 2.x Backups,
without user having to rename or move files.

2. New handling to extract DBDOC data from the SPlus Engineering PostgreSQL database 
automatically and include it in your DBDOC project

3. The first pass at browser Hyperview has been implemented.

Hyperview:
1. Pan & Zoom:

a. The default pan and zoom mode has been changed to a “drag-pan” and “scroll-zoom” 
interface (7493), similar to that found in other applications, and necessary in a touch-
screen context. The legacy interface of “scrollbar-pan” and “rubberband-zoom” is still 
available via a setting in Options, or by pressing CTRL. 

2. Hotspots
a. Hotspots now highlight when you mouse over them (previously, only a tooltip was 

shown).  This makes it easier to identify hotspot size and location, particularly on 
graphics. (16963)

b. Support for hotspot rotation by arbitrary angles (relevant on some types of graphics). 
(17081)

c. Extra debugging info about hotspots can be displayed  (17095)
3. Search:

a. Hit context strings, showing text surrounding a search hit, can be displayed as part of text 
search results. (17216)

b. DBDOC file name displayed on search results dialog (16895)
c. Multiple lines and columns can be searched for in database pages (17537)
d. Search tokenizer change – need 11.3 Hyperview to search 11.3 dbdoc file. (17538)

4. Live Data:
a. Option added to show block number instead of block value when in demo data mode (for 

debugging purposes). (16957)
b. When Hyperview recieves the error “ERROR ERR_HOPC_TYPE: Failed to determine 

output type” for a block, live data for the block is no longer requested from CIUMon until 
Hyperview is restarted. (17248)

c. When Hyperview recieves the error “ERROR 32 Destination Node Off-line” or “ERROR 

ERR_OPC_UNK_TYPE: Failed to determine datatype” for a block, live data for the block is no 
longer requested from CIUMon until Hyperview is restarted. (17311)

5. Thumbnails:
a. Option to enable CAD/CLD thumbnails separately from graphics thumbnails. (16850)

6. Error Browser:
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a. New Group-By attribute File Type added to Error Browser.  This allows errors to be 

grouped largely by file suffix (so different types of graphics will be distinguished, for 
example). (17084)

b. Responsiveness of cancelling an Error tree build greatly improved. (17291)
c. Improvements made to prevent crash when closing an Error Browser with tree build in 

progress. (17338)
d. Bug fix -- Error broswer shows that a negative number of errors have been filtered out  

(17352)
e. Hyperview can crash when error browser closed during tree build  (17422)

7. External Linked Documents:
a. Support for opening particular pages of function code documentation in applications other 

than Adobe Acrobat Reader.  PDFs will now open to the specified page in Edge and 
Chrome browsers as well. (17105)

8. Miscellaneous
a. Right-clicking on parts of a Tag Database page can crash Hyperview  (17258)
b. HTML Vegas Lights and highlights don't update after restarting Hyperview  (17261)
c. Double-clicking on a blank part of a CAD sheet or graphic has the effect of double-

clicking on the currently selected block?  (17462)
d. Digital live data colors are referred to in dialog as “1” and “0” instead of “ON” and “OFF” 

(17561)
e. Go To Source and Go To Use now work correctly on references containing “:” (17560)
f. Small toolbar buttons have been retired.  Only the “large” toolbar buttons are shown. 

(17563)
9. Browser Hyperview:

a. Prototype implementation of Browser Hyperview, with support for navigation, text & title 
search, live data, and bookmarks.

b. Support for Browser Hyperview user accounts and logins.
c. Support for running Hyperview as a service to serve a project file as a Hyperview 

“website”. 
d. Ensure support for Browser Hyperview in desktop browsers in Edge, Chrome, Safari, 

Firefox as of the October 2017 version (earlier in all cases but Edge, where the 1709 
version is the limit).

e. Ensure support for Browser Hyperview on touch screens in in Edge, Chrome, Safari, 
Firefox as of the October 2017 version (earlier in all cases but Edge, where the 1709 
version is the limit).

f. Logging support for Hyperview Server.
g. Admin interface for creating, deleting and managing user accounts.

10. Hyperview Service Controller
a. New application Hyperview Service Controller, for configuring and managing Hyperview 

services.
b. Logging support for Hyperview Service Controller.
c. Support for resetting the Admin password.

BuildPlus:
1. "Automagically" detect and build the most recent version of time/date stamped data for
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2. SPO SPlus Operations Databases (time-stamped .XLSX files) and SPE 2.x Backups 

(time-stamped folder name).  Previously, we asked clients to rename and copy these files 
to a known name system to make builds without having to rerun their projects from the 
System File Specification stage.  With this feature, you can now just point at the folder 
with the time-stamped data and BuildPlus will automatically choose the newest version 
available.  When new back-ups are generated, on subsequent rebuilds of the project, the
newest versions will be picked up without the user having to copy or rename 
files/folders.  (17146)

3. With the creation of the PGExtractor tool that will make a quick partial backup of the 
SPE 2.x database (any PostgreSQL backup), we can utilize this database in DBDOC to 
make automatic builds possible.  The dbdoc.sql file will be placed in a DBDOC folder 
which will be sibling to the SPE 2.x project folder.  In order to use this database in your 
project, point BuildPlus at the SPE 2.x project folder in the System File Specification 
stage and it will automatically check for the presence of the dbdoc.sql database in the  
sibling DBDOC folder.  If it is found, it will be presented for inclusion in your project.  
(17386)

4. At the start of the build, BuildPlus will now check the source databases to see if they are 
more than one month old.  If any are found to be "old" they will be presented to the user 
to see if they want to continue with the build with the files as is or stop and 
re-extract/update the files before trying to build again.  These old databases will be noted 
in the project log for later reference.  (17372)

5. System File Specification presentation has been reworked to separate out the filename 
into its own separate column (where applicable) to allow for another sort option for the 
user to find and select their databases.  (17349)

6. Minor quirks fixed in the generation of the DBDOC license file .C2V when not running 
as administrator or when specifying the root drive as a save location.  (16736,16940)

7. When running a buildall without a dongle present, the BuildPlus window no longer stays 
open but closes automatically and logs the failure in the buildall log.  (16771)

8. Messages which contain unicode characters are now displayed correctly in the 
subprocess message window.  (16892)

9. You can specify a new buildroot by just entering a folder name - BuildPlus will select the 
disk with the most space and create a folder with the specified name.  (17022)

10. Corrected handling for SPE 2.x PostgreSQL backup directories in the "Revise Source 
Locations..." tool which was previously missed.  (17147)

11. Some of our build process has been re-ordered:
a. User is asked about excluded files at the start of the build before any processing 

begins.  (17175)
b. File_statistics.csv is generated at the earliest opportunity and is now a multi-stage 

process, where data is added as it is found during various stages in the build.  (17361)
12. BuildPlus will not permit duplicate Assyst files to be built; the newest version will be the 

one included in the project.  A listing of any duplicates is generated and written to 
Duplicate_Assyst_Files.txt found in the main project directory.  (17240,17323)

13. Some changes to Management of Change processing:
a. At some point, tag entries went missing from the management of change base files. 

This has been corrected.  (17282)
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b. Tag records with blank tagnames will no longer be listed in the base file and 

any .map file will not be included in the MOC comparison.  (17254)
c. We have made the processing of database records optional.  By default, it will be 

turned off; if you wish to switch it on, the option will be found on the "Management 
of Change Processing" tab found in "Project Options".  (17283)

14. Corrected an issue with extraneous and increasing GPI/HPG/HGS chapters being inserted 
on each build.  These extra chapters may have been causing issues with the Hyperlink 
run. Projects with corrupted .RAW/.CFG files will be automatically corrected the next 
time it is rebuilt.  (17299,17424)

15. Strange behaviour was discovered where a newly built .dbdoc file would inherit the file 
creation date of snapshot.dbdoc if that file existed in the project directory.  This causes 
issues with our live loop settings insertion.  This issue has been addressed and corrected 
so the true creation date is reflected in any newly generated .dbdoc files.  (17375)

16. With the command line /build switch, Hyperview is no longer launched at the completion 
of the build.  (17413)

17. Logging changes/corrections:
a. "Project opened" line from buildall was incorrectly being logged in the previous 

project's log.  (17374)
b. With a command line /build, BuildPlus will now generate a buildall log entry for the 

single project build.  (17391)
18. Non-optional checkbox state for SP images in Wizard was not being retained on a project 

rerun. (17414)

CIUMon:
1. Corrected an issue where DCS CIUMon would not update its connection status when running 

as a collector source and it loses connection to the CIU.  (16425)
2. Some changes to the CIUMon logging:

a. "Messages not shown" placeholder with an accurate message count should appear when 
needed in all instances now.  (16596,16974)

b. Added CIUMon installation directory to header information.  (17040)
c. Improve log messages when upstream relay CIUMon is disconnected and the log is full. 

(16990)
3. Correctly report configurations have a conflict when their specified loop and PCU are the 

same.  (16667)
4. Sometimes nonsense data sent to CIUMon's UDP port can cause it to crash; changes have 

been made to handle this more gracefully.  (16952)
5. Fix handle leak in CIUMonController.  (16962)
6. When an attempted block fetch with HOPC returns with the error of an undetermined output 

type, CIUMon will a form a response which will Hyperview understand to mean that live data 
monitoring should be turned off for that block for its current session.  (17248)

Database Utilities:
1. Database utilities now correctly handle unicode characters.  (16890)
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DataFiles:
1. Changes to basestyle.css to support hotspots becoming highlighted on a mouse hover. (16963)
2. Specified aditional HAOPC tag types.  (17263)

Decomposer:
1. Support added to report information for non-current CFG file revisions in decomposer.err.  

Also, the report for the current CFG file revisions now has a different time format, the 
comments for the revisions, and a code indicating whether we successfully parsed the CFG
file ("S":succeeded, "E":empty, "F":failed).  (17171)

Hyperlink:
1. General improvement to hotspot sizes and creation on SPlus graphics.  (16681)
2. Assyst/PG2 improvements:

a. Vector links:
i. Determined translation between vector nickname and the more well-defined graphic 

filename in order to resolve vector targets.  (12167,17195)
ii. Made some general changes to fix some vector links that were not being previously 

made.  (17379)
iii. If there are multiple targets for a vector link, rather than resolving to the firstlink in 

the list, no link will be made at all.  (17396)
b. Hotspots:

i. Improved size and placements.  (16675)
ii. Some live data variants and support for HALARM and LALRAM were added which 

will result in some new hotspots.  PV/SIG and OUT/SIG get some new hotspots and 
NOFFLINE/SIG get suppressed.  (17335,17406,17407)

iii. Changes made to create a split Auto/Manual and Cascade/Ratio hotspots. 
(17358,17383)

iv. Parent level visibility is now checked for unprocessed submodels, resulting in more 
live data hotspots.  (17381)

c. Removed support for pg2_live_data_alignment directive.  (17092)
d. More multi-state submodels are now being recognized (better hotspot sizes, less error 

messages).  (17158)
e. Create links to <tagname>@TS for the element "BSL RMSC Track Permissive Lamp." 

(17234)
f. Logic strings from the CAS, MAN and CAS or Auto Permissive Lamps should now be 

correctly identified to yield pseudotags.  (17235)
g. Right-click text on Heading Bars has been corrected.  (17329)
h. Corrected some lookup issues (e.g. ip::Value#QualityDetail).  Some memory leaks were 

fixed.  (17335)
3. m_Link vectoring should work now.  (17407,17433)
4. Correct handling of S7 in FC 48 as engineering units, rather than as a percentage.  (16149)
5. Unicode text issues:

a. Correct handling of MicroStation files with unicode names so they get built.  (16830)
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b. Unicode text files remain as unicode, rather than being converted to ANSI during, 

processing to ensure that no information is lost.  (16992)
c. Disambiguation pages should display Unicode correctly.  (16995)

6. Improve the dimensions provided for ladder diagrams so that hotspots no longer show as 
being "out of bounds".  (16920)

7. We previously supported a feature on AutoCAD drawings where the current time and date 
would be displayed.  We have changed this handling to show the file modification date 
instead.  (17002)

8. Supply block id in adapted spec hotspots for live data to appear.  (17026)
9. MicroStation graphics now support and show different line weights.  (17038)
10. Repaired an issue in thumbnail generation where sometimes an image would show as 

"Unsupported Image Type"; adding a second alias fixes the problem.  (Make sure to clear the 
thumbnail cache in order to see this fix if you encountered this issue.) (17153)

11. Handle unexpected spaces in .RTU file specification of block numbers.  (17476)
12. Clean up memory leaks.  (17420,17444)
13. Search tokenizer change – need 11.3 Hyperview to search 11.3 dbdoc file. (17538)

MDB_Extractor:
1. MDB_Extractor support added to handle the new SPE 2.x database that can now be extracted 

with the new PGExtractor tool.  (16921) 
2. Changes made to work with the new report for non-current CFG file revisions being generated 

by Decomposer now.  (17171)

PGExtractor:
1. The PGExtractor tool is a batch file which will extract the necessary data for a DBDOC 

project from the S+ Engineering PostgreSQL database.  It will generate a file named dbdoc.sql 
in DBDOC sibling folder to the SPE project.  (16921)

General Support Changes:
1. Update ODA support to use version 21.11 (released November 2020).  (16863)
2. Support added to handling unicode characters in messages generated by various programs. 

(16890)
3. Implemented support for the output and specifications of FC 249 and FC 254.  (16926)
4. Remove spurious comma at the end of CSV header lines. (16928)
5. Remove support for pg2_live_data_alignment directive.  (17092)
6. Added support for report of non-current CFG revisions.  (17171)
7. Fixed a memory leak in format_spec.  (17418)
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Version 11.2 Feature Update – February, 2021

Overall:
1. General improvements to SPlus and Assyst graphics handling.
2. Support for live specs on ladder diagrams has been implemented.
3. Corrected live update behaviour when CIUMon is connected via Harmony OPC Server.

BuildPlus:
1. Miscellaneous tidying up of files that are included in the compressed error .7z file and 

archived error folder, plus a clean up of the ComposerDir.txt file on a project rerun with 
system file changes. Also, a tweak to the SPE 2.x file search handling to exclude any .ebp file 
found in the same project directory structure. (16794)

2. The sort order of how Assyst files appear in the project files has been corrected. (16825)
3. Corrected issue with file handle race condition preventing Wizard from launching on 

a new project.  (15979)
4. Various tweaks and fixes to the build process:

a. When a database referenced in a user defined console is missing during a buildall, 
rather than automatically associating to another available database, the build will stop 
and the error logged.  (16988)

b. A failure to rerun Decomposer after a MDB_Extractor run has been fixed.  (17045)
c. Some handling for SPE 2.X projects has been modified to rerun the correct database 

utilities when necessary and to separate internal data to different lists for clarity. 
(17109)

d. Corrected a crash encountered by client when trying to open a project.  (17298)
e. Corrected the switchover to new header format in project .RAW and .CFG files on 

older 10.7 projects as well as fixing the sort of chapters where the PCU/Node is 100 or 
greater so they appear in the correct numerical order.  (17318)

5. Correct timestamp information listed int file_statistics.csv to reference the last modified date 
rather than the creation date.  (17123)

6. Mapped computer drive information is now reported in the system settings summary 
(17016,17156)
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CIUMon:
1. The live update interval specified in Hyperview and CIULink is now being honored when by 

CIUMon when it is connected via Harmony OPC Server. Previous behaviour limited fetches 
to at most once every 10 seconds even if a shorter update interval had been specified. (16859)

2. The global options (e.g. number of deferred keys used, blocked users/user weights, etc.) are 
now correctly synchronized across all open instances of CIUMon and/or CIUMon_Relay 
(whether they are being run manually or as a service), and all CIUMon Service Controllers 
when an option change is made in any instance. (16625,16725)

3. Two crashes which were triggered under very specific circumstances in the "Manage 
Configurations" dialog have been fixed. (16680,16743)

Database Utilities:
1. Corrected issue with handling PI XLSX databases with different field names than what was 

formerly specified.  "NAME" and "DESCRIPTION" should now be accepted and the database 
will be processed with the correct links in the .dbdoc file.  (16740)

DataFiles:
1. Allow hyperlink parsing to handle tagatoms prefixed with "." rather than specifying in our 

datafile, tagatoms.csv. (13788)
2. Handling implemented to display basic data about CFC inputs and outputs. (16595)
3. Fix Conductor NT .M2 submodel search to include .M1 files found in the same folder. 

(16766)
4. Correct FC 227 so that outputs on blocks N through N+5 show communication quality. 

(16857)
5. Added new CLIF tagtypes to handling. (16873)
6. S+ hotspot location and sizing improvements.  (17028)
7. Live data handling improved for invSTNMode02.  (17215)
8. Improved hotspot creation for PG2 tagnames and descriptions.  (17238)

Decomposer:
1. Decomposer will now generate CFC internal wiring data that will be available in a format for 

Hyperlink to use. (16108,16707,16815,16821)
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2. Corrected calculation of CFC max block by looking at highest-offset output instead and 

corrected real unused input values to default to 5 rather than 0.  
(16879,16831)

3. Decomposer will identify the input and output descriptions on CFC macros for use in the 
Hyperlink run.  (17013)

4. Added handling for new versions of the CAD records found in SPE 2.3.  (17162,17306)

Hyperlink:
1. SPlus improvements:

a. Added support to recognize and handle W64 3.1 and 3.2 versions of SPO. (16712,16816)
b. Improved tagatom managemnent for @MA, @PV, and @SP. (14434)
c. Hotspot fixes/improvements:

i. Clean up split hotspot issues so they are displayed correctly with the value right 
justified on the left and EU description left-justified on the left. (15780)

ii. Some general hotspot placement, default value and creation issues have been 
corrected (15780,16709,16832,16841,16846,16861,16889,16908)

iii. Added block IDs to hotspots table for FC hotspots. (15377)
d. Improved appearance of text (size) in graphics when displayed on its own or when 

displayed in combination with another graphic. (16545)
e. Implement correction to show lost 0.0 values. (16697,16717)
f. Suppress live data hotspot creation on invalid "Tag Value" strings. (16719)
g. A count of the total number of hotspots created is now listed in 

DBDOC_SUMMARY.ERR. (16764)
h. Text color corrected on some graphics. (16782)
i. Improved error generation/checking:

i. Fixed a warning message in TagReference rendering. (14958)
ii. Ignore HMI type code DB_INFO_CTRLINH when generating error messages. 

(16901)
iii. Suppress extraneous unconfigured display errors when processing as a banner. 

(16902)
j. Fixed a crash that was introduced with some processing of a graphic as a banner. (16907)
k. Tags without tag atoms which are also touchpoints should have the touchpoint identifier 

added to their descriptor text.  (16913)
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l. Correct links to graphics with more than one period in their names.  (17137)
m. Checks for null pointers and negative values to prevent crash in processing.  (17332)
n. Check that text color and canvas background color are not the same so that text appears 

and is visible.  (16961)
3. Assyst improvements:

a. Improved searchability of hotspot text on graphics. (16496)
b. Use the PV/LOW and PV/HIGH for the span on dynamic bars (rather than VAL0 and 

SPAN) for all instances now. As well, the direction of the fill is now being respected. 
(16574,16691)

c. Support for vertical text has been added when font substition is required. (16657)
d. Hotspot improvements:

i. Improvements to live data hotspots text size and position have been made, taking 
into account whether EU should be shown or not.  You may use the custom edit 
"pg2_global" with the variable followed by its state to turn the EU on or off. 
(16658,16662)

ii. Vertical text slignment spec MiddleWithDescender handling has been improved. 
(16662)

iii. New hotspots generated for @MA and dynamic bars positioning for @PV and @SP 
improved.  (16133)

iv. Allow for non-orthogonal rotations on hotspots.  Also, supply the rotation value 
during hotspot creation so that Hyperview can rotate the hotspot correctly. 
(16624,17086,17096,17101,17103)

v. Generate new pseudo-tags with PG2_FACEPLATE where they were previously 
missed. (13223)

vi. Removed support for "pg2_build_aspect" custom edit.  (13223)
vii. Live data handling improved for invSTNMode02.  (17215)
viii. General hotspot positioning, sizing, and generation improved.  (16412,16493,

16670,16672,16780,16893,16911,16938,17033,17036,17098,17099,17100,17124, 
17129,17238,17244,17295,17300)

e. More elements added for lookup to suppress "unprocessed" messages. (16728)
f. Fixed the parsing problem where record entries contain multiple periods. (16729)
g. Correct the sorting of Assyst files (e.g. group numbers) so that they appear in the proper 

numerical order. (16826)
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h. Fixed right mouse click on text hotspot so that "Search for" option is correctly 

autopopulated with the given text.  There is now also text for search/right-click for tag 
names and tag descriptions.  (15244,16415,17278)

i. Improved link generation to graphics.  (16965)
j. Fixed broken links on Escape, Previous, and Next buttons, plus extended graphic 

shortcuts, on menu graphic.  (17070)
k. Corrected missing links on @PV and @SP values.  (17209,17210)
l. Process submodels previously reported as unidentified type - they are now classified

and suppressed.  We also now ignore AQS submodels to reduce the number of live data 
hotspots on a drawing.  (17093,17097,17102)

m. Use "Item" to identify pseudotags, tagnames, descriptions, EU, etc. when submodel logic 
interpretation fails.  (17272)

n. Some general code clean up and improvements.  (16722,17056,17183,17184,17195)
3. CFCs improvements:

a. Handling implemented to display basic data about CFC inputs and outputs. (16595)
b. CFC internal wiring data is now available in a format that Hyperlink can use. This data 

will be used to generate dmpcfg files but not for wiring information that is displayed by 
Hyperview. (16707,16821)

c. Fix to suppress the incorrectly reported "failed to handle function hotspot" error for CFC 
function code hotspots. (16844)

d. Output offsets have been corrected. Outputs are still listed in the order in which they are 
defined in the CFC. (16875)

e. Correct browse sequence in the Function Code index in Hyperview.  (16871)
f. Added CFC input and output descriptions to Help Documentation.  (16872,16876)

4. Ensure that a link is made for <filename> if <filename>.G is built into the project. The 
Resolution Page will be presented if both a .G and .DIS of the same name are being built in. 
(16227,16885)

5. AutoCAD and MicroStation filenames that contain unicode characters are now handled 
correctly so that they now built and appear in the .dbdoc file. (16454)

6. Tweaks to error messages being generated:
a. The incorrect LPM was being reported in the chained block loop error. (16688)
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b. The error message FC 66 [097] (does not have wired output) should only be valid if it is a 

SODG graphic (but not PCView) and a trend database is being built. Otherwise, the error 
should now be suppressed. (16809)

c. Do not round off values when reporting non-orthogonal angles in error reporting. (16854)
d. Suppress reporting non-orthogonal rotation error when it is 360 degrees. (16822)
e. Show error 326 (CUnhandledCalculation) for hotspots requiring "Format" processing. 

(16906)
f. Suppress reportig error 291 (Graphic link target is null) where the graphics 

vectoring boxes are blank.  (16970)
g. Fixed truncated error message "skipping border text".  (17177)

7. Support has been removed in the following areas:
a. .TAG file support (16651)
b. Conductor NT graphcfg, trendcfg, histcfg and ataglance files no longer built. (16652)
c. Old Foxboro database support has been removed. (16659)

8. Tagmap appearance and handling has been improved. There is not a limit on the number of 
databases shown in tagmap any more; the database names are no longer truncated and there is 
no issue with overlapping columns. (16663)

9. Spec desc header appearance have been improved. (16881)
10. Fixed a crash when building AutoCAD files but with no dxf-color statements specified in the 

custom edits. Instead a minimal AutoCAD color table will be shown in the project .dbdoc file. 
(16852)

11. Correct the disambiguation handling when building in multiple cloned SODG consoles in one 
project. (16878)

12. Fixed a corruption resulting in bad drawing extents from bad .DGN files.  (14152)
13. Switch to use TrueType fonts from OpenType fonts to avoid what appears to be missing fonts 

on the initial opening of a .dbdoc file.  (15668)
14. PDF improvements/fixes:

a. Ensure that text on a PDF links first to the tag if one exists.  Otherwise, link to a 
document with the given name; if multiples exist then a resolution will appear for user 
selection.  (16724)

b. Fixed missing live data hotspots on PDF page due to tag::variable assignment being 
overwritten accidentally.  (16958)

15. Added aliases to handle different field names for PI XLSX databases.  (16740)
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16. Fixed issue where some SODG graphic descriptions had disappeared.  (16932)
17. Modified handling of Table of Contents presentation so that Composer .dis graphics are listed 

by description then filename, whereas other SODG graphics are still listed by filename.  
(16933,16983)

18. GPI/HPG/HGS improvements:
a. New links created for block numbers in HGS files.  (16971)
b. GPI/HPG/HGS files will now show the Loop, PCU and Module in title in the table of 

contents.  (17268,17275)
19. Reimplement code to allow for SODG graphics to call .DY files (popups) as if they were 

graphics.  (17077,17090)
20. Extra pseudotags now created that were not before.  Also, pseudotags have been removed for 

block numbers less than 10.  (17207)
21. Live data removed for DD (FC123) and MSDD (FC129).  (17225)
22. Fixed disappearance of Tag Index from table of contents.  (17242)
23. As per client request, graphics that are not in the .xdc file will now be suppressed. (17314)
24. General memory leak clean up.  (17113,17346)

Hyperview:
1. Layered and new-format live specs are now supported on ladder diagrams. (16909)
2. Hyperview no longer crashes on startup with Mongolian regional settings. (16805)
3. Topics marked for print from the table of contents now include attributes (tagnames) in the 

the print. (16848)
4. Fixed GDI leak which was sometimes preventing thumbnails from being generated. 

(17019)

MDB_Extractor:
1. Fixed formatting of some SPlus 2X strings to correctly handle the percent (%) sign. (16795)
2.  Fixed failure when processing CONSOLE.CFG and DISPLAYNAMES.TXT when the 

console directory name is NULL or empty.  In these situations, the directories will be created 
in the Deomposer directory with the names Console1, Console2, etc.  (17088)

3. Correct missing tags in 800xA MDB file, with better handling of logic state descriptors and 
whitespace.  (17159)
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General Support Changes:
1. Consolidated legacy message functions across all programs. (16431)
2. Tweak to general buffer handling for spec formatting to prevent overflows. (16637)
3. Better handling of obsolete build errors in all programs. (16679)
4. Added enhanced file sorting routine for correct presentation order of file and folder names 

containing numbers. (16824)
5. Added CFC input and output descriptions to Help Documentation.  (16872,16876)
6. Improvements to S+ hotspot location and size.  (17028)
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Version 11.2 – October, 2020

System:
1. Thumbnail images in the table of contents of .dbdoc files.
2. Software License keys now supported.
3. New CIUMonController indicators to show whether data can be provided.
4. Improvements to Assyst and S+ Graphics rendering. 
5. Custom Function Code Support(Composer 6.5 S+ Engineering 1.3) has been added.

Hyperview:
1. Browser

o. Hyperview application icon updated.
p. Hotspot info in browser status field no longer taken from wrong pane sometimes.

2. Thumbnail images 
a. Thumbnail images can now be displayed in the index pane for chapters containing 

graphics, AutoCAD/MicroStation drawings, and PDF files.  
b. Thumbnails can be turned on and off in the View tab of the Options dialog as well as via 

the context menu on a table of contents.
c. Thumbnails can be rotated for document types that support rotation.

3. Line Highlighting
a. Signal lines now highlight in yellow when moused over.
b. Signal lines “sticky-highlight” in orange when clicked on.
c. Signal line tooltips display the block number and quality presence and type.

4. Input & Output Trees
a. Source signal trees and output signal trees can be constructed for any block on a 

CAD/CLD, and are visually highlighted.
b. Trees can be followed onto other CAD/CLD sheets.

5. Treeview Table of Contents 
a. Treeview table of contents is no longer available by default as an option (and will no 

longer be updated for new features).
b. The treeview table of contents will be enabled automatically on systems where the 

HTML-based table of contents scrolls badly due to insufficient Internet Explorer versions 
(XP and Server 2003). 

c. Treeview toc can be re-enabled on any platform by means of the /treeview command line 
option, and should work as well as it ever did.

6. Watch Window
a. Clicking on a timestamp will now bring it to the top of other timestamps.
b. FC80 N+1 blocks are now shown as @SP not @RI in the Watch Window.
c. Automatic naming of WW groups from function block add no longer includes function 

code name.
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d. A bug causing unwanted plot refreshes when data being collected was generally 

increasing (or decreasing) such that a new max/min was encountered has been fixed.
7. Embedded PDF documents

a. Unicode document names are now fully supported.
b. Thumbnails for embedded PDF documents are shown in indexes.
c. PDF chapters show thumbnails for the first page of each document in the chapter.

8. Annotations
a. The fullscreen option has been removed.
b. Bug causing labeled digital values to display wrong value has been fixed.

9. Audit Window
a. New tree icons are displayed.
b. Title has been shortened to just been the name of the audited graphic.

10. Live Specs – Bug fixed preventing proper discrepancy detection for negative spec values.
11. Quality – information about the quality type and status of a signal line has been added to the 

tooltip for the line.
12. Error Browser & Error Markers

a. Wording on Error Tree root updated to be more explanatory.
b. Error Marker display changed so that all markers are always displayed, regardless of 

Error Browser filter settings.
13. Graphics – Unicode characters in PNG filenames now handled properly.
14. Dynamic Bars

a. Dynamic bars on graphics now go purple for bad quality data.
b. Dynamic bar tooltips are no longer truncated when live data is turned on.
c. Dynamic bar stale data now preserves last value in display.
d. EXTERNAL and NO SRC are now properly displayed on live dynamic bars.

15. Live Data
a. Blocks with no source will not be fetched, and are displayed as NO SRC
b. Blocks configured External will be fetched, and are displayed as EXTERNAL
c. Module 0 Blocks 1-25 will be fetched now, even if they have no source and the checkbox 

is not checked. 
16. Goto Use/Source – Goto Block Map no longer fails when block < 100.
17. Printing – Printing of text panes now mostly respects formatting, and includes thumbnail 

images.
18. Startup & Command Line – Command line arguments before the project file specification are 

now handled properly when automatically launching an older version of Hyperview to display 
an M14 file.

BuildPlus:
1. There's a new look to the BuildPlus buttons and icons!  The buttons have been updated and 

they and some of the options have been rearranged for clarity.  There have also been some 
cosmetic changes to the Project Options pages to help make them clearer.  
(16351,16397,16402,16406)
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2. Hyperview support has been added in order to facilitate the new feature of navigation 

thumbnails for PDF and graphics indexes.  BuildPlus will run Hyperview in a special mode 
during the build process to generate the thumbnails; this may take some time the first time 
thumbnails are generated but will be faster on subsequent builds.  BuildPlus will also perform 
some housekeeping on the resulting .dbdoc file to optimize it for network access.  This build 
feature is present in the full build and the option "Short Build From Cfg".  
(16261,16303,16370,16551,16601)

3. License Management has been implemented in BuildPlus.  Looking at "DBDOC License..." 
under the "Tools" menu, in addition to presenting your current license level, the tools are now 
available for you to manage your license whether it is changing your dongle licensing or 
adding/modifying a sofware key.  Contact GMCL for more information and assistance if you 
need to change your license level.  (16200,`16250)

4. Support for PG2 XLS (800xA Display Documentation) files has been removed.  Existing 
projects that contain this file type will be automatically cleaned up when they are opened for 
the first time in BuildPlus.  It is recommended that clients move to ASSYST files if they want 
to see the updated documentation.  (14215)
As well, the "_backup" suffix that appears in the extraction of taglists in SPE 2.X projects (due 
to the processing from the <project>.backup folder) will be removed from all taglist names.  
The suffix will be stripped from all appropriate places when the project is first opened and 
"backup" will no longer appear in any of the SPE 2.x projects going forward.  (16248)

5. Some speed improvements have been implemented:
a. The generation of the file_statistics.csv during the build process has been tweaked to 

lessen the processing time.  (16299)
b. The tool to import a buildroot has been streamlined so that files are not handled multiple 

times resulting in a faster import.  (16046)
6. To support our new approach to handling Function Code Documentation, BuildPlus will no 

longer create a specific Function Code Documentation chapter in the project files.  Existing 
projects will be handled when they are first opened to remove the now obsolete chapter from 
the files so that there is no conflict with the new processing when the user next builds.  
(16218)

7. The "Pause" button feature, which is enabled when a buildall is underway, has been reworked 
for greater flexibility with the option.  You will be presented with various choices of how you 
want the buildall paused or whether you want to exit the buildall right away.  Any user 
initiated pauses or stops during a buildall are now noted in the buildall log located in the 
appropriate buildroot.  (16117,T742)
The "Stop" button has also been reworked to offer the option of stopping the build 
immediately or waiting until the build has completed and exiting.  You can save a default 
choice so that you do not need to specify each time you press "Stop"; this can be reset in the 
"Global Options".  (16183,16214)

8. The "Project Options" pages have been resized to allow for all options to appear on smaller 
displays and for the OK/Cancel/Apply buttons to be always accessible.  The larger property 
pages now have scrollbars to accomodate some of the longer options being presented without 
making the dialogs too large.  (16275,16347,16371)

9. A new report, dbtype_processing.txt, is now generated during the "System File Specification" 
stage if the Generic database type is included in the project.  It will list the file that was 
checked and the type of database it was detereming to be.  (16153)
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10. Fixed a crash which may occur when ladder files are included in the project.  (16489)
11. There was a failure to trigger a run of Decomposer when one was required under certain 

circumstances.  The check for Composer files being present in the project has been adjusted to 
fix this bug.  (16176)

12. When S+ graphics are present in a project, if a .UCBG and .G version of a file exist, BuildPlus 
will correctly choose to include only the .G version in the build.  (16360)

13. General fixes, additions and cleanup:
a. BuildPlus now reports additional information in our various files:

i. The version of hyperlink is now reported in the build log at the point it is run to 
allow for ease of version tracking should a crash occur.  (16006)

ii. Additional files have been added to the ERROR.7z file to aid in our troubleshooting. 
(16146)

b. Initial Wizard setup on a project should now have WinTools graphics automatically 
selected if the primary database is a .PTT file.  (15993)

c. Added handling for Function Code Documentation in the "System File Specifications" 
stage to not allow the selection of a specific file; the user must always select a folder that 
contains the documentation files instead.  (16048)

d. The Function Code Documentation paths were not being correctly updated in the "Revise 
Source Locations..." tool.  (16089)

e. A buildall will no longer proceed if the command line is ill-formed (for example, by 
specifying an invalid start project).  This error will be recorded in the buildall log.  
(16407)

CIULink:
1. Duplicate "Live Loop Setup" entries would appear if a .dbdoc file was loaded with multiple 

CIUMon settings lists containing the same CIUMon entry.  This has been resolved so that 
each live loop entry displayed should now be unique.  (15694)

CIUMon and CIUMon_Relay:
1. A new feature has been added to CIUMonController to indicate whether an instance of 

CIUMon is able to provide data.  A color indicator now appears beside the listed service to 
indicate if the instance is running (manually or via a service) and whether it can successfully 
fetch data (green: success, red: failure, yellow: running but disabled by CIUWatcher, white: 
not running).  A new line has been added to each node, "Data Availability", as well as a tooltip 
that appears when the mouse hovers over it to give a more verbose explanation of the 
connection status.  (14502,15929)

2. After receiving error 100 (0x64) on a block spec fetch, CIUMon incorrectly tries to dequeue 
the key.  The handling has been modified so that the request is discarded and is not asked for 
again until requested by Hyperview on a subsequent fetch.  (13610)

3. A fix was added for a situation encountered by a client where CIUMon was not recovering 
when RoviSys OPC90 would temporarily hang; when OPC90 recovered, CIUMon would not 
fetch data again until it was restarted.  Our recovery code has been tweaked to try to re-
establish a connection in this situation so that live data fetches can continue without any user 
intervention.  (15603)
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4. The messages generated when running in Collector mode and failing to connect have been 

changed to make it clearer to the user the reason for failure.  Some of the handling to the 
timing and socket connections has been tweaked to allow for a better sequence on connection 
as well.  (13634)

5. The handling when a CIUMon service crashes on startup has been improved to allow for a 
limited number of retries to attempt to get the service up and running.  If not successful, 
CIUMonController will be refreshed to show the correct service status and the service 
stopped.  (15556)

6. Minor fixes:
a. Logging options changes that were being made in an interactive service were not 

appearing in CIUMonController after being applied.  This has been fixed.  (14105)
b. The user can no longer delete or mark as inactive the currently loaded configuration in 

"Manage Configurations" if it is connected.  (16263)

Database Utilities:
1. A fix has been added to MDBType.exe so that when a file is run through it to be 

checked for type, the date modified does not get changed.  (15499)

DataFiles:
1. Support for PG2 XLS files has been removed from our parameter files.  (14215)
2. Error filtering changes for the following errors:

a. Failure to embed PDF file due to PDF security settings.  (15235)
b. Error [256] Tag not an exception report promoted from cosmetic to severe.  (16020)

3. Style sheet changes:
a. Refactor and use CSS preprocessor Sass on our BaseStyle.css.  (15996)
b. Cosmetic issues fixed in the the table of contents displayed in Hyperview.  (15731)
c. PDF document topic titles have been improved, along with page and section header 

formatting changes.  (15917,15946)
d. Multi-format thumbnail index html and stylesheet.  (16131)
e. Fix so that newlines in CSV database fields are displayed correctly in Hyperview.  

(16301)

Decomposer:
1. Support has been added to handle Custom Function Codes (CFC) and their symbols.  We will 

also generate an error message if a function code that cannot be used in a CFC is actually 
specfied for use in a CFC.  (14001,16027,16106,16331)

Hyperlink:
1. Assyst file handling improvements:

a. Create tag and vector links that were previously missed and unaccounted for on graphics, 
as well as revising some of the handling for the existing links. 
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(13292,14295,15764,15938,15945,15952,16067,16116,16216,16219,16245)

b. Add more elements to be treated as text so that they are available to be searched for or 
copied.  (13495,16220,16345,16366)

c. Generation, positioning, sizing, and appearance of various hotspots, live data, and 
dynamic bars has been improved (13991,14016,14018,14022,14310,14343, 
14344,14362,14507,14508,14615,14813,14818,14837,14846,15043,15302,15615,15925,1
5958,15961,15963,15980,16000,16073,16076,16134,16179,16224,16272, 
16288,16326,16334,16344,16348,16365,16379,16418,16419,16451,16564,16617,1662

d. More pseudotag work has been done to ensure that they all appear as expected. 
(14003,14748,15422,15999)

e. Check that all tags are correctly identified.  (14362)
f. Conditional logic is now being processed for graphic rendering.  (15829)
g. General improvements to graphic processing, appearance, and reporting. 

(15837,16077,16088,16194,16409,16579,16583,16610)
h. Additional error messages:

1. Added error message for elements that are non-orthogonal and are not currently 
handled by DBDOC.  If you see this error message, please send examples of these to 
GMCL with an explanation of how you use this feature.  (15975)

2. A new error reporting when a display is not found/configured.  (16426)
2. SPlus file handling improvements:

a. Suppress creating a live data hotspot on tags where it is not valid.  (14857)
b. General improvements to graphic processing, appearance, linking, and reporting. 

(14860,15162,15809,15911,15912,16085,16105,16115,16213,16241,16328,16443,16445,
16447,16466,16470,16473,16492,16512,16542,16602,16616,16630)

c. S+ graphics processing has been sped up with some adjustments made to the exception 
handling code.  (14924)

d. Changes made to handle tag atoms correctly.  (15541)
e. Generation, positioning, sizing, and appearance of various hotspots, live data, and 

dynamic bars has been improved (15809,15994,16080,16085,16124,16125,16329, 
16394,16448,16550,16566,16585,16612)

f. Handle extreme coordinate sets in the drawing instructions to prevent out of memory 
crashes.  (16057)

g. Employ two passes per part on S+ graphics to improve processing and to fix text 
centering.

h. Additional handling of if/elseif/else scripting when it is present but not formatted as 
expected so that text font, colours, etc. are processed properly.  Improvements were also 
made in general to script processing to handle new functions. 
(16243,16390,16391,16511,16513)

i. Support added for SPO U60 2.1 graphics.  (16311,16312)
j. Improved handling for previously undefined tags.  (16319,16341)

3. Improvements/fixes/features were implemented in our PDF file handling: 
a. Work was done to ensure all links that should be present on a PDF document are present 

and correct:
1. Correct/create links for strings to a named file, a document of the same type, a tag (or 

any alias), or any document (if no extension specified in the string).  If there are 
multiple like-named documents of different types, the Resolution Page will be 
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presented to the user to choose the document to navigate to. 
(14933,16012,16023,16623)

2. Corrected links to PDF files referenced in .XLS files.  (15045)
b. Report an error for PDF files that do not have the necessary permissions in order for it to 

be embedded in the build.  (15235)
c. The PDF document topic and page titles presented in the Hyperview table of contents 

have been improved in content, order, formatting, and hierarchy. 
(15917,15946,16175,16494)

d. Preliminary pass at opening PDF files with Unicode filenames.  (16195)
e. Suppress individual PDF pages from showing up in the topic title search results  (16258)
f. The first page of a PDF document will be used as the thumbnail.  (16465)

4. Some support for custom function codes and their symbols and specs has been added.  These 
configurable function codes appear in the block map, block index, and the Numeric Index of 
Function Codes.  (16027,16096,16289,16330,16586,16587)

5. New support for Sentinel software keys for license management.  (T802,T835)
6. All signal lines have been added to the database so that when they are displayed in Hyperview, 

they can highlighted, detect clicks to go to source or display endpoints, etc.  
(11960,15974,16072,16420)

7. Support for PG2 XLS files has been removed from Hyperlink.  (14215)
8. Corrections and additions to link generation:

a. Issues with missing or malformed links on AutoCAD and PDF files have been resolved. 
(14482)

b. Lost links on the tag definition pages to CADs have been restored.  (15254)
c. Corrected links in generic databases records to tags and documents.  (15984)
d. PDF or text files that contain graphic links are not counted as graphics references, thus 

allowing for the correct number of unreferenced graphics errors to be reported.  (16039)
e. Fix logic to create document links so they work correctly for filenames, with and without 

file extensions.    (16135)
9. Specs are ignored for blocks with negative block numbers.  As well, the error for invalid spec 

length will also be suppressed for negative blocks.  (15964,16422)
10. Missing units and other display issues on Process Portal B graphics have been fixed.  

(15011,15021)
11. The disambiguating keywords stage in the Hyperlink processing has been tweaked to greatly 

reduce the amount of time spent in this phase, in some cases from tens of minutes to a few 
seconds, speeding up our build process.  The user can now see some of that timing 
information logged in the dbdoc.err file.  (15924,16050)

12. Loop, PCU, and Module data is now displayed in search results for module table of contents 
and GPI/HGS/HPG topics.  (15653)

13. Corrected handling of european comma decimal point issues in both .dbf, .mdb and .dmpcfg 
files.  (15982,15986) 

14. Permit JPGs in AutoCAD drawings.  (16031)
15. Alarm inhibit reporting has been improved to show the same in both the index and content 

panes.  (16045)
16. Changes to thumbnail index html and stylesheets to support swtiching between index formats 

in Hyperview.  (16131)
17. In our document count for licensing purposes, when the number of graphics exceeds the 
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number of CADs, the number of configuration documents will be used for the number of 
graphics.  Since a graphic represents multiple configuration sheets, the number of 
configurations documents should far exceed the number of graphics.  However, on those rare 
occasions when this is not the case (for example, building multiple chapters of the same 
console because there are archives), this will allow for the build to complete.  (16417)

18. Respect reference name capitalization in all the places so that goto source, etc works.  (16433)
19. Filenames with unicode characters are now displayed correctly in the indexes, titles and audit 

window.  (16455)
20. Tagusage.tsv glitches have been fixed: quoting text in the description field if it only contains 

numbers and replacing newlines in a description with a space.  Hyperlink will also generate an 
error message "Unexpected control character" when the tag description contains a non-
printable character.  (16580)

21. Group names have been reworked so that they are more useful and meaningful when they 
show up in the search results.
a. The Block Indices have been split into Block Use Indices and Module Block Indices.
b. Tag Indices has been renamed Module Tag Indices.
c. Tag Map Pages will now be named Tag Index.  

There are now more search results and they are easier to read and interpret.  
(15374,15526)

22. Improved display of Index of Non-Block Points, fixing overlap of columns and clarifying 
which database the point/tag is found in.  (15731)

23. Some tweaks to our error reports:
a. New error for too-high block numbers.  (16199)
b. Specious TSTALM (310) error being reported when it should not have been   (16237)
c. Fixed wrong parameter referenced in Error 317 (linked block already linked)  (16603)
d. Code has been refactored to consolidate most the information about what links are valid 

and/or expected for each function code, and to consolidate the checks for each error type 
in one place.  This may affect errors 316, 317, 318, and 319.  Error 325 has been added to 
check for loops in function block chains.  (15539,16607)

e. Incorrectly reported error on Function Code 89 Last Block when it was located after the 
legal block numbers 9998 or 31998.  This error should no longer be generated.  (16631)

24. Fix for handling newlines in CSV database fields, as well as leading and trailing whitespace.  
(16301)

25. .G file uses matching .UCBG file's var and diag files to render the graphic correctly.  (16377)
26. Handle the data written to the gmf file hash so that it does not record an invalid change that 

will trigger the unnecessary regeneration of a thumbnail file (used for the new Hyperview 
thumbnail feature). (16536)

MDB_Extractor:
1. A fix has been added to prevent MDB_Extractor.exe from modifying the timestamps on .EBP 

files when they are included in a project.  (13675)
2. Support has been added to handle Custom Function Codes (CFC).  (14001,14708)
3. Added or corrected handling for display of the following fields from 800xA PG2 databases:  

AREA, EQUIPMENT, UNIT, SECGROUP, and Logic States 0 thru 3.  (16144)
4. Fixed a client discovered crash on handling long descriptors containing large numbers.  
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(16280)

5. Fix for handling newlines in CSV database fields, as well as leading and trailing whitespace.  
(16301)

6. The following glitches found in the tagusage.tsv file have been fixed:
a. newlines replaced with spaces in tag descriptions
b. added quotes around numeric-looking tag descriptions
c. added an error for control characters in tag descriptions.  (16580)

Wizard:
1. Support for PG2 XLS files has been removed from Wizard.  (14215)
2. Fix the path displayed in the dialog launched by the "Browse" button so that the full directory 

tree appears, not just the user path, if the edit control is blank.  (16192)

General Support Changes:
1. Boost libraries updated.  (15256)
2. SQLite upgraded.  Also, some of the optimization code was reworked to work in place.

 (15564,16178,16242).
3. Zstd upgraded.  (14321)
4. Pugixml upgraded.  (15606)
5. Refactor version of Hyperview that runs on XP SP2.  (15932)
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Version 11.1 – September, 2019

System:
• Much faster dbdoc file loading and browsing, especially for larger systems and for dbdoc files 

accessed over a network.  
• Support for new form of 800xA MDB files (800xA Version 6.0 and above) replacing 

Harmony Tag Exporter support that ABB removed.
• GPI, HGS and HPG MDB support added.

• Support for Symphony Plus Engineering (SPE) 2.1 and 2.2 using PostgreSQL backups.
• Major rework of Table of Contents appearance, handling and performance.

Hyperview:
1. Hierarchical “classic mode” table of contents introduced.  Document chapters are now a new 

level in the index rather than having all files listed inline in the main table of contents.
2. Comprehensive rework of index listings and formats, document titles etc. to increase 

readability and reduce clutter.
3. General support across the user interface for running on a “comma decimal” system.
4. Support for rotation in the browser of PDF and AutoCAD documents (useful if they were 

scanned in “sideways”).
5. Support for rearranging blocks in the Watch Window.
6. Live data

a) Live specs no longer supported as a kind of Live Loop Annotations.  Instead, layered 
specs have a “live mode”.

b) Timed out blocks are no longer repeatedly fetched.
c) Display and fetching of External and No Source blocks regularized.

7. Home page 
a) Home Page tab removed from Options dialog in View menu.  
b) Menu home page setting simplified.

8. Errors
a) Performance of error export greatly improved.
b) Listing numbers added to errors in the error browser.

9. Bookmarks
a) Bookmark processing speeded up.
b) Bookmarks are now single pane.

10. Search
a) Number of search hits as well as number of topics with search results reported.
b) The pane of search result topics is noted in the search results listing.  When a result is 

inaccessible (because it is in the index pane when the browser is in single pane mode), this 
is flagged.

c) Ability to go to coordinates removed from Search All Titles.
11. Printing

a) Print settings regularized.
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b) Improved support for batch printing to pdf.

BuildPlus:
1. Support has been added for several new file and database types:

a) Modern GPI Interface along with HGS and HPG MDB files: To add these new file types 
in your project, browse for them in the System File Specifications dialog of BuildPlus in 
the Access Database field. (15203,15350,15382,15707,15755)

b) 800xA - New form - MDB databases: Browse for them in the Access Database field in the 
System File Specifications dialog. (15265,15339)

c) S+ Engineering 2.1 with PostgreSQL: Browse for this new version of the Composer 
database and files in renamed SPE 2.x/Composer field in the System File Specifications 
dialog. (15435,15591,15598,15614,15658)

2. A major reworking of how the Table of Contents is displayed in the .dbdoc file has been 
undertaken. BuildPlus will make the changes to a project when it is opened for the first time 
with this new version of BuildPlus so the user does not need to do anything special to see 
these changes propagated to their .dbdoc file on their next build. Some of the changes that you 
will see are:

a) The various files have been rearranged so that Graphics, Configuratioin and Other file 
types are grouped together. (15344,15533,15652,15713,15816)

b) There will be improved shortened, meaningful chapter titles. (15410,15888)

c) The "DBDOC Indices" chapter has been renamed to "System Information". (15637)

d) A separate header will be created for file types in the Other Documentation section when 
there are greater than N number of chapters of a given type. By default, N is 6; however, 
this value is configurable and can be changed by the user in the Global Options of 
BuildPlus. (15723)

3. The detection of the latest versions of the function code PDF files has been reworked as well. 
When the files are copied over to the project directory, the original filenames are now being 
used while any old copies of contained within the FC directory are not deleted; the correct 
version will be passed along to Hyperlink for processing. (15365,15517,15601,15631)

4. 4. A new BuildRoot option has been added to give the user the option of copying project 
import (.bpi)files to a different location as back-ups. This will allow for the projects to be 
easily rebuilt in case of computer failure. (14851)

5. 5. Modifications were made to Custom Edit dialog:

a) The presentation of the entries has been reworked to show the selections in a treeview so 
that it gives the user a more compact overview of the current edits. (14969)

b) Two new custom edits are available to be added to a project in the Custom Edit 
Selections, though, by default, they are not added to the current project and it is left to the 
discretion of the user to add. The spo_tag_ref entry should be added to the project if the 
user sees live data on hotspots labelled "CAD Tag Ref:" but wants to suppress the live 
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data on this particular type. The splus_dynamic_colors_disabled entry can be added to the 
project if the S+ graphic appears to be missing some elements in our rendering. 
(15669,15835)

6. Corrections were made to handle various crashes:

a) Corrected an issue when trying to iterate on a build after a crash in Hyperlink where the 
diagnostic lines in DBDOC.ERR were very long and not close to the end of the file. We 
have sped up the processing and corrected a buffer overrun to allow for the iteration to 
proceed. (15497)

b) A BuildPlus crash was occurring when trying to display very long output lines from 
Hyperlink. This has been fixed.(15821)

c) We have also fixed an unrelated crash that occurs in BuildPlus due to a different buffer 
size issue related to have many search paths specified in Wizard. (15992)

7. The System File Specifications dialog has been modified as follows:

a) An extra column has been added on the file selection pages for the Access databases/files 
to indicate the type of MDB file that was found (Conductor NT, Harmony Tag Export, 
800xA - New Form, GPI, HGS, HPG or Unknown). (15423)

b) Dialog box has been resized larger for easier reading. (15663,15724)

8. You are now able to modify an existing .dbdoc file to hide the error markers. This option is 
found in the Advanced Options of the Project Options. Turn the error markers off on the 
desired .dbdoc file and apply the change; once the file has been successfully modified you can 
copy this file to another location where other users can access it without seeing the errors. You 
can then turn the markers back on for your own use and review. By default, the error markers 
will always be turned on in a new build. (15532)

9. Hyperview now, by default, never fetches no source static data unless the blocks are explicitly 
marked external. There is an option to turn on this data fetch in the Advanced Options of the 
Project Options. Turn on this feature in a selected .dbdoc file, copy the file elsewhere and then 
turn off the feature in the .dbdoc file again for normal use. (15719)

10. We have added an interface to allow the user to export the databases from the latest .dbdoc 
file. On the new Hyperview/.Dbdoc Options page in the Project Options, the user can enter a 
location for where the exported files should be placed and trigger an export the latest .dbdoc 
file with a push of the Export Now buttont. The user can also have it set up in the project so 
that the export occurs automatically at the completion of a build on the newly 
generated .dbdoc file. (15608)

11. General fixes, additions and cleanup:

a) BuildPlus now reports additional information in our various files, UserSelections.txt and 
the DBDOC.ERR files. 

i. The build computer's name is logged now so it is easy to find which computer the 
build was performed on. (15291)
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ii. Sibling projects are now listed so it is easy to spot when sibling are added and/or 

removed between builds.(15347)

iii. The correct version of the latest Windows platforms (10 / 2016 / 2019 and beyond) 
should now be reported in the various files. (T774)

b) If a symbols-to-graphics association cannot be automatically made by BuildPlus and the 
user does not make it during the build process, BuildPlus will launch the dialog on the 
next inline build to remind the user until one is made. (15301)

c) Corrected handling of leaving blank ending block number in the Define Blocks With 
External Sources option. With the ending block field blank, only the specified starting 
block number will be marked as external, rather than the range covered from the starting 
block number to 65535. This will be corrected in existing projects without user 
intervention. (15406)

d) Fix handling of (Null) character in LAD File Name which was causing a crash in 
Hyperlink. (15411)

e) BuildPlus now also displays the completion code of the various programs in hex so that, 
should an error code occur, it will be easier to look up. (15554)

f) The file processing.txt is now deleted on a successful build; its existence is a useful flag to 
indicate that a build failure has occurred. The name of the newly generated .dbdoc file is 
now contained in the new file named newfile.txt. (15596)

g) We allow for the character 0x96 to pass as ASCII so that text files containing this will be 
categorized as app, rather than a binary app, and thus will be parsed correctly by 
Hyperlink for tags. (15735)

h) Copying the entire main or sub-process message text was missing the last line in the 
window on the paste. This has now been corrected along with a crash which occurs when 
the client uses the copy option multiple times in a row. (15760,15761)

Cfg_Parser:
1. Modified to support only UTF-16 so code that used narrow string functions has been updated. 

(15073)

2. Dmpcfg files are now being generated even when they are smaller than 2KB. Cfg_Parser will 
add a suffix to the LPMB filename to avoid duplicates. (15283)

3. Fixed a crash occurring when processing specific SPE 2.1 .cfg files. The exception message 
was updated to indicate function code number out of range. (15749)

CIULink:
1. Corrected issue where CIULink was not able to get live data when multiple CIUMon entries 

existed for the same loop and the first entry was not valid/connected. CIULink will now detect 
the correct successful connection to use. (14774)
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2. Fixed the handling of routing preferences where multiple CIUMons are on the same computer 

and the settings are being read in from a .dbdoc file. (15276)

CIUMon:
1. Minor fix to the button enabling/disabling in CIUMon Service Controller when a service 

crashes. (15314)

2. Corrected the display of the user weight in CIUMon Service Controller when an entry is 
modified in CIUMon or another instance of the CIUMon Service Controller. (15315)

Database Utilities:
1. DBDBF.exe cleans up the trailing whitespace (including CR) in the header lines of the .csv 

files.It also adds the byte order marker to avoid confusion in various text editors. (14821)

2. MDBType.exe was modified to add support for detecting GPI, HPG, HGS and 800xA types of 
MDB files. (2970,15202,15335,15381)

3. Fix so that N90STA tags will now have Block 0 in the tag record. (15874)

DataFiles:
1. Improved support of scripting for S+ (Tagatoms.csv). (13596)

2. New support for GPI, HGS and HPG files (BaseStyle.css, Filetypes.txt). (15203,15335,15382)

3. Support for the major reworking of the Table of Contents in the .dbdoc file (BaseStyle.css, 
Filetypes.txt). (15322,15344,15483,15533,15637,15638,15659,15816,15825)

4. Block indexes have been reworked to reduce redundancies. (15486)

5. Report Error [255] as a severe error (Errfilter.cfg). (15489)

6. We have added testing of quality on UDF function blocks (FC 191,192,198 and 199). As well, 
we have made a change so that FC 80 block N+5 does not show as FAILED. 
(FCConstraints.txt) (15490,15529)

7. Changes to support SPE 2.1 file handling (Param.txt) (15598)

8. Correct for missing live data for value and eudscp on certain S+ graphics (TagAtoms.csv). 
(15746) 

Decomposer:
1. Modified to support only UTF-16 so code that used narrow string functions has been updated. 

(15073)

2. Changes made to handle the CLD files extracted from the SPE 2.1 system now supported by 
DBDOC. (15587) 
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Hyperlink:
1. Hyperlink support has been added for the following file and database types:

a. GPI, HPG, HGS MDB files (2970,15204,15328,15335,15508,15512)
b. New Form 800xA MDB files (15208)
c. New S+ Engineering with PostgreSQL (14002)

2. Numerous improvements to S+ file handling, including the following: (13596)

a) S+ processing speed has been improved. (15471)

b) TAG_IDX links in S+ which link to a station block should not be linked to @PV 
psuedotag. (15666)

c) Handling for spo_tag_ref custom edit to enable/disable live data on S+ graphics 'CAD Tag 
Ref:' hotspots. (15671)

d) Fixed missing text in header of charts/tables on some S+ graphics. (13744,15701)

e) Support added for 64 character tag descriptions and improved line wrapping on CAD 
sheets. (14826)

f) Suppress showing live data for "Alarm Status", "Point Reference", and the generic "Tag 
Value". (14842,15444,15463,15465,15466,15475)

g) Analog value/eudesc hotspots have been split into two separate hotspots rather than 
creating one full-sized hotspot. (14852)

h) Incorrectly rendered "rainbow" graphics corrected with the custom edit 
 splus_dynamic_colors_disabled. (14984)

i) Check added for hotspots with a height over 470 pixels and are not digital; the live data 
will be removed in this instance. (15459)

j) Correct for missing live data for value and eudscp on certain S+ graphics. (15746)

k) Increase the threshold value allowed for tall live data hotspots before they are suppressed. 
(15812)

l) Handle variable/tag types associated with Dynamic Bars so that they do not show live 
data. Also corrected handling where Dynamic Bars were being suppressed when they 
should not have been. (15813,15822,15858)

3. Major reworking and improvement of the presentation of the Table of Contents in the .dbdoc 
file.

a) Added hierarch to the main table of contents (15322)

b) Reduce redundancy in databases & indices sections of main table of contents (15482)

c) Updated display of content chapters in the main table of contents (15483)

d) Improvements to the chapter indexes (15485)

e) Reduced redundancy in block index (15486)

f) Improve main table of contents generation (15545)
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g) Improved topic titles (15618)

h) Fixed treeview table of contents target for new sub-indexes (15625)

i) Cosmetic table of contents adjustments such as line spacing, margins, font size, etc. 
(15638)

4. Implemented improved/modified error checking:

a) Links to the next block are being checked for duplicates. (5562)

b) Have made a source value of real compatible with the expected value of integer to 
suppress reporting Adapt type mismatch errors. (10621)

c) Correct check for reporting a flat function. (11367)

d) Eliminate reporting an error for an insufficient number of inputs only if there are more 
than 0 inputs (error [133]). (12213)

e) Check has been added to ignore block number 31999 for FC 205 and 206. As well, will 
report an error if block 31999 (spare block) is used for FC 205 or 206. (13362)

f) Suppress reporting an error on FC 2 where S1 is equal to 0 and the block doesn't exist. 
(13230)

g) Correct error reporting for function code block chains of CLIF Blocks (or a function codes 
defined by custom_fc). Also eliminated errors if the function code is 191 or 192 and the 
linked function code block is 198 or 199.(15356)

h) Redundant statements of the same error [317] have been eliminated. (15357)

i) Ensure that the unreferenced graphic report includes the internal graphic name along with 
the filename to allow the user to easily see the important graphics that are missing. Some 
messages were streamlined (e.g. dropping extensions, dropping filename if it is the same 
as the graphic) to tighten up the presentation. (15802,15880)

5. Build instruction changes to support the new ODA Platform Update (2019 Update 1) which is 
used in our rendering of AutoCAD and MicroStation drawings. (15279)

6. Modified to support only UTF-16 so code that used narrow string functions has been updated. 
(15073)

7. Minor enhancements were made to SQLiteSupport, specifically some UTF8 support for the 
PostgreSQL backups now being processed for SPE 2.x and various other tweaks. (15333)

8. Changes to page size plus other handling allows for faster opening of .dbdoc files over a slow 
network. (15555,15561)

9. Modified handling to use new sort key to determine preferred FC PDF version for use. Also 
added handling for un-renamed PDF files as they are no longer renamed by BuildPlus when 
copied over to the local project directory. (15518,15576)

10. Hyperlink will ensure that the dbdoc URLs in the project are stable and unique. (15767)

11. Improved display of significant figures. (12681)
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12. TNBJ specific fixes:

a) References that were incorrectly identified as tag references are now implemented as 
graphic links. (13604)

b) White boxes that were being incorrectly displayed are now suppressed. (15217)

13. To correct a crash in Hyperview, Hyperlink will now create anchors so that a title attribute is 
always present, though it may be an empty string. (14678)

14. Properly handle quotation marks in tags in Tagusage.tsv. (15175)

15. Increase the size limit allowed for binary files to 16 MB. (15440)

16. Live data/hotspot issues:

a) Index on hotspots(block_id) needed (15456)

b) Add the blockid of the block a hotspot is an input for to hotspots table; this is contained in 
the new table block_input_hotspots. (15458)

17. TextTopic memory handling has been improved. (15543)

18. Fixed minor memory leaks and a very rare crash which occurred with an empty project and a 
broken Management of Change file. (15636)

19. Updated file version supported from U2.0 to include 2.* and higher for PGP files to get the 
intergraphic links to work. (15991)

20. Fixed an intermittent Hyperlink crash when building more than one project at the same time. 
(15686)

21. Correct data handling when custom borders are used in Composer files. (3289)

22. Corrected full text search in .ab, .rtu files. (15891)

MDB_Extractor:
1. Added support for GPI, HPG, HGS, and New form 800xA MDB files, as well as for the S+ 

Engineering 2.1 with PostgreSQL systems.(2970, 13829, 14002, 15328, 15335, 15692, 15889) 

Wizard:
1. Minor changes to reference SPE 2.1 configurations now supported in DBDOC. (15598)
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Version 11.0 – August, 2018

System:

• M14 project files have been replaced by dbdoc files, which are generally 30-40% smaller.
• Builds are up to 30% faster than in 10.7.
• There is no longer a 2G size limitation on project files.
• All dependencies on the MediaView libraries has been eliminated.
• All programs have been updated to be built in Visual Studio 2015.

• CrypKey has been removed from BuildPlus, Hyperlink and CIUMon and replaced with new 
dongle protection. 

Hyperview:
1. Hyperview has been converted to read dbdoc project files instead of M14 files.
2. All MediaView dependence has been removed from Hyperview and reimplemented.
3. Hyperview executable is now called “hyperview.exe” by default (not 

hyperview_winsock.exe).  A version of the old hyperview_winsock.exe is distributed with 
11.0 and can be used to open M14 files.  This should happen transparently if both 
hyperview.exe and hyperview_winsock.exe are installed in the same folder.

4. Hyperview toolbar icons have been updated.
5. Help About dialog now shows the command line that was used to run Hyperview.
6. Searching

a) All searching has been fully reimplemented to removed the dependence on the 
MediaView search engine.

b) Default search highlight color is now yellow.
c) Nicer search result summary.

7. Text documents
a) All text documents are now internally represented as HTML (not RTF as previously)
b) Database pages are reformatted.
c) RTF documents can no longer be built into a DBDOC project.

8. Watch Window
a) Watch Window group setup (i.e. the set of blocks in a group, and their display 

configurations) can now be exported and imported from the Watch Window.
b) Text annotations can be added to Watch Window timestamps.
c) Watch Window data can be exported in TSV format (as well as CSV) which works much 

better with comma-decimal values.
d) Tag name is shown in Watch Window data labels.
e) Text size in Watch Window is now configurable.
f) Ability to set a plot start display time to a group has been added.
g) Plot deselects when you switch out of Select Mode.
h) Data deletion no longer hangs sometimes.
i) Bad quality data value shown in Watch Window.
j) Watch Window is no longer allowed to fetch data for external blocks.
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9. Errors & Error Markers
a) Error marker position has been scooted to the right so it no longer obscures block 

numbers.
b) Clicking on non-displayed error markers no longer opens error browser.

10. Inaccessible files in the File→Recent Project Files menu are no longer removed, but merely 
disabled.  They are re-enabled if they become accessible again.

11. Audit Window
a) Audit Window contents have been regularized and cleaned up.  The contents of the Misc 

section have been moved into other more appropriate sections.  Graphics and CADs have 
different branch titles.

b) Audit Window can no longer be shown for Block Map and Color Table.
c) Print/Save has been reimplemented.

12. Database export – It is now possible to export an SQLite database representation of the project 
file from Hyperview.  This database is in standard format, and contains much of the system 
representation information generated by Hyperlink and used by Hyperview to present the 
system in the browser.  In particular, it contains spec and connection information, which can 
be used in a variety of ways.  Graphics, CAD/CLDs and text document contents are not 
included in this exported database.

13. Print Marked Topics
a) Useless groups have been removed.
b) Multiple documents can now be printed to pdf without user intervention (as long as they 

are not text documents).
14. Select/Copy – Text generated from Edit->Copy Topic Text on CADs & Graphics is no longer 

silly.
15. Printing – Text printing at the moment uses default system HTML printing, which leads to a 

few (hopefully temporary) awkwardnesses.
16. Live Data – Demo data labels are now orange, so as not to be mistaken for real data.
17. Misc Display

a) Chapter titles in the Table of Contents are now generally much shorter (paths have 
generally been removed).

b) Function code labels (e.g. [FC80]) have been shifted up so as to not conflict with live data 
placement.

c) Overly wide spec boxes for string specs fixed.
18. Misc Bug Fixes & Minor Updates

a)  Moving pane divider can now be cancelled.
b) Option to view function code documentation pdfs is no longer available when no paths to 

such have been specified in the build.
c) Annotations now handle “&” character.
d) What's This help has been removed.

BuildPlus:
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1. The feature to revise the source file locations of existing projects was added to BuildPlus.  

This helps cover the situation when a new build and/or source computer is introduced and the 
drives and/or paths are changed.  This allows the existing projects to be modified to point at 
the new paths without having all files flagged as being new or modified thus suppressing any 
unnecessary reprocessing.  BulidPlus will edit all necessary project files to point at the new 
locations so that the project can be built from the "Build" stage.  This will also allow the 
Management of Change tool to recognize that the files are the same as those referenced before 
the location change so that they are not all reported as being deleted and new and can be 
correctly reported if they are modified from the previous build. 
(5729,13874,14090,14093,14094,14110,14538,13212)

2. Any references or use of Mediaview and its related files have been removed from BuildPlus 
and support added for the newly generated .dbdoc files. (14211,14320)

a) Update live loop settings in .dbdoc files from Project Options if not already automatically 
built in. (14282)

b) An option to archive an incomplete snapshot.dbdoc for debugging purposes has been 
added to the buildroot options. (14733)

3. Two new buttons have been added to the toolbar for ease of access: Launch Windows 
Explorer (which will open to the folder of the currently opened project) and Launch Windows 
Explorer In Exports (which will open to the Exports folder of the current project). (13667)

4. .CSV files are now only processed as databases, not as documentation files.  If .csv files were 
previously included in a project as documentation, BuildPlus will automatically convert those 
entries to be processed as databases the first time the project is opened. (13910)

5. RTF files are no longer supported by DBDOC.  When a project is opened for the first time, 
BuildPlus will automatically remove any RTF documentation files from the project.  A 
message will appear informing the user that this removal as occurred. (14339)

6. Various fixes have been put in to safeguard projects when multiple BuildPlus windows are 
open at the same time:

a) Prevent a project from being deleted in one instance of BuildPlus while it is open in 
another.    Also, do not allow the deletion of a buildroot if any of its projects are open in 
another instance of BuildPlus. (13715)

b) Multiple instances of BuildPlus cannot specify the same name for a new project. (13728)

c) On a single project command line build, do not allow build to continue if the project is 
already open in another instance of BuildPlus. (14052)

d) Do not allow a buildroot to be deleted if a new project is in the midst of being specified in 
the "System File Specification" stage but has not yet been completed. (14207)

e) The operation of deleting a project or buildroot no longer blocks other instances of 
BuildPlus from responding. (14254)

7. A new Wizard Configuration Tool has been added so the user can change the Wizard settings 
without doing the file processing; this can be found under the "Tool" menu.  Any files and/or 
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settings affected by the Wizard changes will be propagated through by BuildPlus so that they 
are present for the next time the build is done. (14184)

8. Dynamic allocation of memory for search path loading implemented to prevent crash when 
many paths are entered database specification. (13756)

9. Modifications were made and fixes added to the Database-Graphics Associations handling.

a) Previous behaviour when an extracted taglist is purposely removed from a build by the 
user and that database has been specified in a graphics association was to reinclude the 
database automatically.  This behaviour has been changed so that the database is now 
removed and a warning message put up to warn the user that it was being used in a 
console association so he can take the appropriate steps to fix it.   (13843)

b) More automated database selection handling added to simply associations. (13849)

c) Some inconsistent behaviour (duplicate entries for the same graphics path, cleared paths 
on "Apply", etc) was fixed to prevent a crash. (14080)

10. For easier viewing, the Database Selections for DBDOC, Database-Graphics Associations and 
Database Selections in the System File Specification dialogs have been made resizable, 
allowing for long paths to appear fully. (14425)

11. Improvements have been made to chapter and cross-reference index titles to make them more 
informative and concise.

a) Graphics will have titles formed from a combination of console description and folder 
name. (14516)

b) Improved short chapter titles for all documentation types. (14596)

c) CAD chapter names will now include the name of the module found in the .hdr file. 
(14602)

12. Features and modifications added for a command line buildall:

a) Buildall behaviour has been modified as follows:  if a Hyperlink crash occurs during a 
buildall, the build will not iterate even if there is a file mentioned in the processing.txt file 
but will continue on to the next project without adding the file to the crash list. (14755)

b) A new Pause button has been added to the toolbar which will allow the user to pause the 
buildall after the currrent project has finished building.  This allows the user to analyze 
how the projects are building and update executables mid-buildall.  (14756)

13. Fixed bug where dbopccsv.exe was not getting triggered for a rerun on generic .CSV 
databases when a newer version was being detected. (14836)

14. Corrected a bug in Management of Change processing for filenames containing periods 
generating false change statements. (14869)

15. Buildroots are now automatically exported by BuildPlus for emergency back-up purposes. 
(14092)

16. The Global Option to not automatically include sibling projects is now by default checked. 
(14895)
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CIULink:
1. Various bugs in CIULink have been fixed: (13859)

a) Live loop settings can disappear when CIULink is restarted.

b) Sockets error when restarting on Windows 2012.

c) Sort order in Tag Name Lookup (Tag Translation) dialog to be numerical rather than 
alphabetical when sorting on blocks.

d) Incorrect menu enabling when "Synchronized Start" time set.

e) Status bar updates not always correct when reporting log size.

f) Keyboard focus not given on initial start-up and tab order on various dialogs.

2. Changes made to load live data settings from a .dbdoc file provided on the command line 
rather than using the settings saved in CIULink. (14545)

CIUMon:
1. Added a feature requested by a client to have a process monitor to keep track of whether 

CIUMon is able to provide data.  CIUMonWorking.exe is a new process that appears in the 
Task Manager when CIUMon is able to fetch data; it will disappear if CIUMon is unable to 
get data, freezes or crashes. (12900)

2. Fixed an intermittent freeze when RoviSys OPC90 restarts under certain conditions. (13898)

3. Fixed a bug in CIUMon_Relay where it may not be able to provide data when acting as a 
collector source in a chain. (13964)

DataFiles:
1. New data files to control the appearance of text html inside the new .dbdoc files being 

generated in the 11.0 release. (13919,13973)

2. Appropriate data files modified to remove RTF file support so option is no longer presented in 
Wizard. (14339)

3. Errfilter.cfg changes for 11.0 release to cover new, modified and deleted error messages. 
(14657)

Hyperlink:

1. Usage and references to Mediaview have been removed for the 11.0 release switchover to 
HTML and our generation of the .dbdoc file:

a) Stop generating dbdoc.mvp for 11.0 (14264)

b) Quit generating RTF files (14513)
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2. HTML support for new .dbdoc file generation for 11.0 release:

a) Add CSS Support for HTML (13914)

b) HTML Versions of Unconverted File Types (13919)

c) HTML Appearance in Hyperview (13973)

d) Improve the appearance of the tag database pages (13980)

e) Improve the long title situation (13981)

f) Improve search indexing (14030)

g) Reduce project file size (14037)

h) Information stored in citations now stored in database (14107)

i) As size is no longer a limitation, each block will get its own page (14265)

j) Group limitations are not longer an issue so nogroup support has been removed (14500)

k) HTML and GMF files are no longer written to disk.  Topics are created in memory and 
added directly to the database, thus making for faster processing.(14520,14521)

l) Custom search tokenizer renamed to support older and future versions. (14776)

3. Block numbers have been removed as keywords for tag definition pages so that they do not 
appear in the "Search All Titles" results. (11546)

4. Improvements, fixes and changes to built-in PDF documentation:

a) Increased accuracy for hotspot positions in built-in PDFs (13658,13913)

b) PDF file count in "File Processing Times" section has been corrected (13851)

c) Large PDF drawings now display properly. (14014)

d) Fix crash when building PDF files and error code 8 encountered. (14112)

e) Correct document path displayed in Hyperview to be the actual path to the source 
document. (14164)

f) Correct links in PDF to get an actual document match rather than bringing up the 
"Ambiguous Documents Index". (14817)

g) Each PDF file is now counted as 1/3 of a document. (14912)

5. Improvements and fixes 800xA/Assyst handling:

a) NavGroup Top etc in EPG (12585)

b) Fix the display of some dynamic bars which were not working (14040)

c) EPG menu bar offsets (14220)

d) Some scaling and hotspot locations have been corrected. (14253,14293)

e) Previously missing links on buttons to intended target graphics have been added. (14664)

f) CFI Control Station Tagatoms (14665)
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g) Element rotation values used to improve hotspot positions. (14812)

h) The position of vector links have been improved. (14814)

i) Correct text displayed on right click of vector link buttons in Assyst. (14815)

j) Suppress custom submodels from being explicitly built.  These submodels will now be 
listed in pg2_unidentified_record_types.txt. (14850,14856)

6. Error message modifications:

a) Obsolete messages to be suppressed in release. (14100,14670)

b) Warn of any case where the block number pointed to by S1 of FC 69 is not block N of the 

target function code.(14102)

c) Welcome_Dall error message corrected to look for minimum 3 arguments rather than 4.  
Other messages were checked and corrected for minimum number of arguments. (14186)

d) Generate message when FC 225 S5 is not equal to 1 when part of a chain controlled by FC 
228 FDD block. (14503)

e) AOLDB and REDAI error [175] (14877)

7. Tag Atom AUTO is now being treated as a digital value and will display live data values. 
(14433)

8. Log times for Hyperlink database processes have been added in DBDOC.ERR for debug 
purposes. (14489,14707,14873)

9. Teigha libraries have been updated for AutoCAD and MicroStation rendering. (14492)

10. Update XpdfDeconsturctionWin (14564)

11. Handling of chapter titles improved. (14717)

12. Module 0 Block 0 does exist, representing the status of the PCU and will now be processed 
correctly. (14719)

13. @RI and @CO have been removed. (14749,14754)

14. S+ graphics improvements:

a) Corrected dynamic bars that were being displayed vertically but should have been 
horizontal is S+ graphics. (14859)

b) Button links to appropriate S+ graphics are now being made. (14887)

c) Wrong link to graphic created due to overly long name. (14973)

15. Links are now made on pseudotags in AutoCAD, Microstation, PDF and text files. (14878)

16. SC700 Module type has been added to the table of known types. (14886)

17. Increased precision in DMPCFG files. (14941)
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Wizard:
1. Since DBDOC no longer supports RTF and CSV files as documentation, changes have been 

added to Wizard to no longer present those as options.  Also, users can no longer enter the .csv 
or .rtf extension in the "Other files" option or in any of the custom extension edit boxes. 
(14339,14353)
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Version 10.7  October, 2016
Major Features and Enhancements:

 PDF files can now be compiled so that they are in the M14, can be searched and have links to 
tag names and documents

 S+ and 800xA PG2 graphics have significant enhancements regarding display of live data, 
data fields including tag descriptions and engineering units, borders and included images

 Support for AutoCAD 2016 has been implemented

Hyperview:

1. PDF documents are now supported directly (previously only links to external PDFs could be 
built into a project file).   PDF documents can be displayed directly in Hyperview, and their 
contents searched.  Links to external PDF documentation are also supported. 

2. Display of S+ graphics has been improved.  Specifically, some borders that were previously 
missing now appear, some lines that were previously drawn "too wide" are now correct, 
hatching is partially implemented, and included images on console graphics now display with 
the proper colors and resolutions.  

3. The group selection list presented when you add a block to the Watch Window now has the 
most recently added group at the top where it is most convenient.

4. The optional display of tagnames on SODG graphics has been removed.  Attributes can still 
be displayed on configuration.

5. A variety of HTML improvements and bug-fixes have been made.  Hyperview only displays 
HTML when viewing an M14 built with the International Version of Hyperlink, which 
currently remains at 10.6.1 (i.e. there is no 10.7 International Version of Hyperlink).

6. Miscellaneous bug fixes:

a. Bug preventing Go To Source/Use from working on all Input and Output References 
fixed. Go To Source on Empty OREF no longer crashes. 

b. Bug sometimes preventing arrow-based browsing through error browser errors fixed. 

c. Hyperview no longer crashes if you exit while the error browser is initializing. 

d. Stepping through search hits on graphics and PDFs now explicily follows a "row then 
column" ordering. 

e. Highlighted search hits no longer print as black boxes under certain circumstances. 

f. Live data on documents no longer vanishes if the system is configured for "comma" 
decimal point.   Other issues remain, however, and using this setting is not 
recommended.  Comma decimal points are not supported in the build system.
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BuildPlus:

1. Modifications have been made to support the new feature to have built-in PDF files in the project 
M14. 

2. Log messages improved to document missing dongle to aid with remote build support. 

3. A feature to recover "lost" projects has been added to BuildPlus.  There may be times when the 
UAC level on a machine or a user's privilege level changes, whether accidentally or on purpose, 
which then affects where BuildPlus looks for and store its files that track a user's projects and 
particular build options.  If either UAC or privilege level changes and a user does not see his 
projects when BuildPlus is opened, he can try the new "Recover Projects..." option located under 
the "Tools" menu to see if his projects can be found. 

CIULink:
1. Support has been added for CSV type tag databases for tag lookups. 

CIUMon:
1. Support has been added to report bad quality status plus various other alarms when connected via 

Harmony OPC. 

2. Fixed crash which occurred on certain platforms when connected via RoviSys Turbo and the 
computer clock was adjusted to an earlier time. 

3. CIUMon now returns the function code number with a block spec fetch to aid in troubleshooting.

DataFiles:
1. Cleaned up messages and improved wording on errors (errfilter.cfg). 

2. Support for the new built-in PDF documentation has been added.

3. FCConstraints.txt modified to force a block to be added to watch window (will mainly only 
affect function code 80). 

4. Symphony Plus/PGP support for image paths. 

Hyperlink:
1. Symphony Plus graphics rendering has been greatly improved.  Splines, background colors, 

lines, etc. which previously were not drawn, now appear, and previously handled elements are 
now drawn more accurately. User can now also specify the path to their Symphony Plus image 
files in Wizard so that Hyperlink can find and use the correct image specified in a graphic.

2. Handling has been added to support embedding PDF documents into the project M14 and to 
make the documents searchable within.  Hotspots will be generated on the PDF documents for 
tags and module references. 
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3. Improved error handling for various function codes:

a.  Processing has been extended to check more blocks for continuous exception reports.  These 
     blocks (FC 48, FC 158, FC 177, FC 222 and FC 223) are reported if the span is zero, too.      
b.  PID gain/span check should only be performed on the A input on a station block.  This is the 
     only one where a PID or APID output can be used in automatic mode, which is where the 
     gain*span should be 100 to be normalized.
c.  Adjust range allowed for S3 on segment control block to include up to 255. 
d.  Non-alarming digital messages added back at client request. 

4. Conductor graphic rendering improved to show more accurate colors, visible states and display 
tag data. 

5. Improvements to Microstation drawings to improve text display, rendering and remove duplicate 
search hits. 

6. Support added to force a block to be added to watch window. 

7. Sentinel dongle support updated for international clients. 

MDB_Extractor:
1. Increased size of fields to accommodate longer strings. 

Wizard:
1. Support added for user to specify path to Symphony Plus/PGP image files.
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Version 10.6.1  January 29, 2016

Hyperview:

1. Watch Window

a. Major performance improvements to load time and responsiveness in Watch Window 
and Navigation Plot for groups containing large numbers of blocks (e.g. >  10). 

b. Added the ability to hide and unhide Watch Window groups, so groups can be 
defined, and temporarily removed from the Watch Window.

c. Fixed situation where same block in multiple groups caused runaway live data 
fetching.

2. International Version (HTML Support)

a. Comprehensive rendering improvements, eliminating many situations involving delay, 
blank pages, and incorrect or incomplete refreshes.  Basically, HTML works much 
better now.

b. Various improvements to HTML scrolling involving arrow keys, selection scroll, drag 
scroll etc.

c. Context menu navigation (e.g. Go To Source) is now functional.

3. Miscellaneous

a. New command line switch to specify date format (MMDD vs DDMM).

b. Unwanted live data labels removed from rung blocks (bug fix).

c. New command line switch to specify default live data font size.

d. M14 file name now included in printed document header.

BuildPlus:

1. Corrected handling to prevent decomposer reextraction on Composer projects when restarting 
build from GO stage when no project changes have occcurred.(12896)

2. Modifications made to display chinese characters and unicode file paths correctly in sub-
process message window.(13102)

3. Fixed hang during build process when the buildroot specified is UNC, references the local 
computer and references a shared folder without mention of the drive.(13162)

4. BuildPlus will now trigger a run of the new tool, cfg_parser, during a build to generate a 
report of the contents of the .CFG file. These reports can be found in the EXPORTS\CFG 
folder of the project directory.(13171,13175,13180,13299)
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5. Corrected how the automated databasegraphics associations are determined for Assyst 

graphics so user intervention is not required.(13242)

CIUMon:
1. String specs are now supported for function codes 221 through 229 with the latest version of 

RoviSys Turbo.(13327)

Database Utilities:
1. The various database utilities have been modified to support chinese characters in the 

messages. (13207)

DataFiles:
1. Cleaned up messages and improved wording on errors (errfilter.cfg). (various cases)

2. Dynamic bar handling has been improved on Assyst graphics (pg2_types.txt).(13191)

3. New files for TTG type database handling.(13214)

4. Support for the new specification positions for function codes 205 through 207 has been 
added. (13285)

5. Additions to both attributes.txt and tagatoms.txt to improve handling.(13214,13281)

Decomposer:
1. Support for the new specification positions for function codes 205 through 207 has been 

added. (13285)

Hyperlink:
1. Improved handling to speed up processing during the "build statistics" stage.(5171)

2. Various improvements have been made to AutoCAD drawings:

a. Corrections made to allow for both AutoCAD and TIF overlays to appear on 
drawings.(11758)

b. Size of overly large hotspots have been fixed.(11883)

c. Teigha libraries have been updated to revision 4.01.0.0, this includes support for 
AutoCAD 2016. (12054)

3. Current database handling has been redesigned to allow for increased stability and allow for 
clean exits when errors are encountered.(12824)
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4. Modifications made to display chinese characters and unicode file paths correctly in messages. 

(13102)

5. Document links from CAD sheets to PDF files that was previously broken has now been 
fixed. (13111)

6. SPlus navigation has been improved for the Welcome_dall graphic base.(13119)

7. Message created to report duplicate local OREFs.(13170)

8. Corrected handling of S30 and S31 for function code 247 to show the corrected degree value. 
(13178)

9. Improvements to Assyst graphics handling.

a. Proportional sizing has been added to the Assyst dynamic bar handlig to ensure proper 
positioning and orientation.(13192)

b. Including missing encoded text files fixes crash.(13264)

10. Sibling project source blocks are now marked to ensure proper handling.(13209)

11. A "Symbol Reference" entry has been added to the Audit Window MISC tab to show symbol 
location on Conductor NT graphics. This is limited to top level symbols.(13250,13259)

12. Added support for hotspots for function codes 205 and 206.(13306)

13. Fix added to correct the situation where user has spec.mdb open during a compile. Duplicate 
records will no longer be generated.(13326)

14. A major new feature involves the creation of .dmpcfg files, text dumps of CFG files from the 
project and the same information from the DBDOC compile. They allows comparison of 
current and historical module load images.

15. Some implementations of SetFont function are now supported in SPlus graphics.

16. Support for the 2015 singlevolume function code manual and other two volume versions has 
been added.

MDB_Extractor:
1. Handle corrupted and invalid index values in TAGDATA.MDB to prevent crashes.(13173)

Cfg_Parser:
1. Cfg_parser has been modified to run on WinCAD systems along with Composer systems. 

(13173)
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Version 10.6  August 17, 2015

Hyperview:

1. Error Management
a. Error markers added to the main browser to indicate error locations.
b. Support for text file error export from the error browser.
c. Better coordinate marker to flag coordinate-based errors.

2. Watch Window
a. Navigation timestrip added, to allow convenient navigation of large data plots.
b. Selection begin/end labels added to aid in export selection.
c. Beginnings and ends of data runs are automatically flagged, and "jump gap" 

navigation buttons let you jump from data run to data run.
d. The user is now alerted on startup about the presence of Watch Window blocks 

that are not scheduled to pause automatically.
e. Configurable Watch Window date format.

3. Function Block hotspots
a. New hotspot type added -- function blocks on CADs/CLDs.
b. Context menu allows addition of all inputs and outputs at once to Watch Window.
c. Extensive reworking of function code related indexes, titles, and tooltips,  to 

make them easier to understand and use.
d. Introduction of function block usage index.

4. Text copying & searching on graphics
a. Text under the cursor is now copiable on graphics and CADs.
b. Text under the cursor can now be searched for automatically on graphics and 

CADs.
5. Graphics

a. Longstanding bug causing "missing lines" on remote desktop environments fixed 
by providing GDIPlus graphics implementation.

b. Add ESC to halt drawing of anomalously complex graphics files.
6. Miscellaneous

a. Highlighted hotspots are no longer printed, as on certain printers they print as 
solid black or white rectangles.

b. Bookmarks can now be shared among multiple users.

BuildPlus:

1. Modifications made to display chinese characters and unicode file paths correctly in project 
files and messages. (10775,12449)

2. A new tool has been added to allow for the easier movement of BuildRoots from one 
computer to another computer, allowing you to set up your projects on a new computer 
without having to start from scratch. Check the new help file for instructions or contact us for 
assistance when using this option. (12060,12605)
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3. Handling added for nonadministrator users to allow for BuildRoot and project creation on 

computers where permissions have been restricted. (12234)
4. Configuring of multiple PPA projects in a single DBDOC project is now allowed. (12251)
5. Database handling has been modified to accommodate the database utility changes that now 

output  files in .CSV format rather than .DBF. BuildPlus will also handle any associations 
(databasegraphics, Conductor consoles, etc.) that reference the old .DBF format, quietly 
changing any references to the new .CSVs without any user intervention required. 
(12410,12713)

6. The XLSX file format is now handled in the database processing. One can now specify a path 
in which to search for them in the Database Specification dialog. (12619,12739)

7. External blocks specification has been improved. A mandatory description is now required for 
any range entered. As well, a new feature to edit existing ranges has been added. 
(12483,12718)

8. Corrections plus additions to the logging of the build system have been made. 
(12502,12506,12507,12508)

9. Support for the new sibling project feature has been added. This allows users to specify a 
project in the same buildroot as a "sibling" to the current project so that when the current 
project is built, DBDOC will look at the sibling projects for additional sources for tags. The 
dialog will appear inline during the build or one can access it on the "Define Blocks With 
External Sources" page in the "Project Options". (12628,12687,12749)

10. Handling added for the new international dongle. (12694)
11. Automatic rebuild on updated Composer project (12778)

CIUMon:

1. A new tool has been added to CIUMon to manage configurations. One can view all saved 
configurations and sort them wth the different available filters to see what the configurations 
have in common. Users will be able to mark configurations as inactive or delete 
configurations within this tool. (10981,12432,12433)

2. The services dialog has been reworked in CIUMon. (12154,12444)
3. The ability to add or modify services has been added to CIUMonController. Other minor 

fixes have been done in CIUMonController for the new interface introduced last release. 
(12202,12055,12270,12314)

4. The ability to create a chain of CIUMon collectors (with CIUMon_Relay) has been added. 
(10706)

5. CrypKey startup delay quirks fixed. (12152,12457,12753)
6. RoviSys OPC90 timing and missing data issues have been investigated and improved upon. 

(12344)
7. Various platform specific service crash fixes have been implemented. (12540,12556,12609)

Database Utilities:

1. Support has been added for foreign languages. Database will now be outputted in .CSV 
format rather than our previous .DBF format to accomodate larger and more fields. (12454)

2. New XLSX2CSV database utility added (replaces now obsolete XLS2DBF). We now support 
both XLS and XLSX as databases. (12537,12670)
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3. We now allow CSV files to be built in as databases. (12725)

DataFiles:

1. Cleaned up messages and improved wording on errors (errfilter.cfg). (various cases)
2. FCConstraints.txt modified for group add to watch window. (12244)
3. PG2_types.txt changes to aid in processing of ASSYST PG2 graphics.

(12627,12641,12655.12662,12742,12744,12761).

Decomposer:

1. Foreign language support added for international clients. (12454)
2. SRI crash on loop 345 (12591)
3. A problem generating the CLIF Composer SHAPE.LBR has been resolved. (12643)
4. Position of specifications for CLIF blocks has been corrected. (12644)

Hyperlink:

1. Create Function Block hotspots (8933)
2. SP bar graphs should work now on graphics. (9915)
3. Tag descriptions added to tags in the Tag Inhibit Report. (11711)
4. Error 197 links for Assyst graphics (12261)
5. Function code improvements:

a. All uses of function code names should be improved by adding the block label. (12349)
b. Changes to main function code TOC index  entries listed alphabetically in new function 

code
c. Change FC format on CAD sheets  changing (N) to [FCN]. (12352)
d. New FC format in block index and block tooltips. (12373)
e. Improve and combine function code/block indexes. (12549)
f. CLIF function codes  labels and names (12551)
g. Crossindex links for CLIF function codes (12788)

6. Insert new custom edit commands in BuildPlus for custom inclusion of 800xA Graphics. 
(12356)

7. Improvements to placement of live data:
a. in 800xA PG2 support. (12416)
b. when displaying live data and specs at the same time on CAD sheets. (12512)

8. Foreign language support has been added for international clients. A new dongle is required 
in order to build projects with data codes set to something other than 1252. 
(12454,12579,12624,12630,12727)

9. SRI crash on Loop 345 (12591)
10. S+ hotspot tag sizes fixed. (12625)
11. Support for new sibling_projects directive added. (12627,12762)
12. Segment control block checks improved. (12629)
13. Issue with CLIF Composer SHAPE.LBR has been resolved. (12643)
14. Searchable text added for submodels and vector link text. (12654)
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15. Small gaps in lines prevent correct connections being shown. Those that fall within our 

tolerance range will be gapjumped and be shown in a different colour to differentiate them. 
(12696)

16. Support to build in CSV files as databases added. (12725)
17. Label format. (12351)
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Version 10.5.1  June 30, 2014

System:
1. Support for PG2 graphics extracted by Assyst tools.
2. Further system support for SPlus/PGP graphics.
3. User data sharing framework to allow collaborative error management.

Hyperview:
1. Error Management -- Error Sharing: New system for sharing error management (stars & 

checks) among multiple Hyperview users.  Use Options->Sharing to start sharing error 
information.  A shared data folder can be specified, and user data files are copied to this 
central location where their contents are available to other users. 

2. User Data Importing: Bookmarks, text and live loop annotations can now be easily 
imported from other users.  Imported items are added to your own items.  Use the Import 
function in the Annotation Manager and Bookmark Manager.

3. PG2: Improved support for PG2 graphics, including full text search.

4. SPlus/PGP: Improved support for SPlus/PGP graphics.

5. Watch Window: Timestamps can now have their data labels hidden for a less cluttered view 
-- click on the button in the date box, or use a Group menu.

6. Display: Configurable digital live data color added.  Use Options->Colors to specify. Gray 
box specs are no longer "cut off" when expected fonts are missing.  

7. Navigation: Go To Use now puts "non-system" uses below the line -- uses on graphics, 
configuration etc are listed first, uses in DBDOC generated reports etc listed last.

8. Live Data: Minimum update interval reduced to 100ms (from 250ms).  Data fetch interval 
precision greatly increased.

BuildPlus:

1. Support for graphics generated by the ASSYST tool for 800xA VB and PG2 has been added. 
To include the ASSYST 800xA .png/.txt files in your build, specify the location of the files in 
the "Database Specification" panel; look for the "800xA (ASSYST Files)" option to include 
them in the "Wizard" stage. You will be able to specify which databases are to be associated 
with each folder of graphics selected. On subsequent rebuilds, any changes (new, deleted or 
modified files) in the chosen graphics folder(s) will be automatically picked up for processing 
for the new M14. (11844,11896,11952)

2. Specify a shared data folder location for use with Hyperview's bookmarks, annotations, error 
status, etc. This location is specified on a project level and can be found on the "Processing 
Options" tab in the "Project Options". (11897)
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3. There is a new feature to automatically open the next or previous project in a buildroot and 

have either the singular DBDOC_Summary.err file or the full set of error files from the 
previous and current builds compared automatically, launched in the WinMerge Tool. You 
can set which comparison will be performed on the open, either the file or folder, in the 
"Global Options". (11904)

4. You can choose to suppress the display of the progress bar on Hyperlink and Decomposer 
runs (introduced in the 10.5 Release) with the new option in the "Global Options". Note: The 
progress bar is now automatically disabled on pre-Vista platforms where it was causing an 
unnecessary pause in the build. (11497,11690)

5. Various fixes have been implemented for newer computers/platforms that no longer 
support/allow 8.3 naming convention. Some of the database processing and handling for the 
Mediaview compiler stage have been modified to allow for successful builds. (11683,11826)

6. Command line support to allow for importing of single projects or batch importing of multiple 
projects. This is extremely useful when moving existing builds to a new computer. (11685)

7. Interface for moving/copying/renaming project has been improved to show the progress of the 
selected operation so that it is clear that the BuildPlus is still active when processing large files 
and not hung. (5423)

8. Automated console associations have been improved for OpIT, PPB and 800xA graphics. 
(11884)

CIUMon:
1. The CIUMonController interface has been reworked for better presentation. New options have 

been added for user control plus there is the option to add a caption to the log of a CIUMon 
service via the controller now. (8666,8667)

2. Logging quirks, such as creation of zero size files, incorrect number of rolling files being 
retained and generating duplicate log headers, have been fixed. (11530,11607,11967,11968)

3. When logging in error-activated mode and either an error is encountered or forced log 
message is recorded, CIUMon will now indicate the number of messages not shown (logged) 
to give the user a more accurate view of CIUMon activities. (11539,11687-9)

4. All changes to configuration and other options will always now be logged. (11541,11745)

5. Connection handling to RoviSys OPC90 has been modified to account for the situation when 
it may appear that the =connection has been lost or RoviSys OPC90 has not responded in a 
timely fashion. When this occurs, CIUMon appears to sit idle even though Hyperview 
requests are coming in until it is restarted. We have put in some handling to help recover in 
this situation without any manual intervention. (11696)

6. Changed the default log location from the Program Files folder to ProgramData (if user has 
not already specified a custom location already). (11760)

7. Account for different tag name format for Harmony OPC so that CIUMon can correctly detect 
whether the specialized DBDOC tags required for monitoring are present. (11801)
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8. Fix the launching of CIUMonSelfCheck as it appears to no longer start automatically on 

CIUMon start-up. (11862)

Database Utilities:
1. Missing fields in databases now appear (DBSynth). (11869)

2. Various changes to the XLS2DBF utility for improved handling:
a. Differentiating between BIFF7 and BIFF8 headers. (11435)
b. Corrected span that appears in M14 to be the same as that which appears in the XLS data 
file. (11817)
c. Span and zero corrected for when scientific notation is used to present the values. (11832)

DataFiles:
1. New messages and improved wording on errors (errfilter.cfg). (11778,11829,11935,11992)

2. Attributes.txt updated to include new attributes found in client data. (11766)

3. Wizard files modified to:
a. implement XRef support for PG2 graphics. (11725)
b. include .UCBG files in the search for PGP graphics. (11813)
c. present ASSYST 800xA VB and PG2 graphics option. (11844)

4. New datafile pg2_types.txt included in file set to aide in processing of ASSYST PG2 graphics.

Decomposer:
1. Removed appending the revision information to the sheet name. (11741)

2. Decomposer will retain the current CAD name found in the CADNames file in order to 
maintain consistency in the URLs used for annotations, bookmarks, etc. between builds. It 
will support sheet renaming, sheet deletion and CLD upgrage (CLD rename) when one action 
is done at a time. (11742)

3. Multi-line text handling and other general improvements in graphics rendering on Composer 
graphics have been implemented. (11837)

Hyperlink:
1. MakeconnectionsifindicatedbyComposerwiring(10438)

2. AutoCADfonttypes(11393)

3. AutoCADfileswith.TIFs(11566)

4. Bordersizingindgn(11525)

5. DynamicbarsinPG2(11668),Bargraphissues(11670)

6. ImplementXRefsupportforPG2graphics(11725)

7. TagDescriptioninSignificantChangeReport(11757)
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8. PG2filestatistics(11767),S+/PGPfilestatistics(11768)

9. S+/PGPimprovements:

a. S+Updates(11769)
b. TagtypesinSPlusDBFfiles(11797)
c. S+Symbols&SCMUpdates(11818)
d. TagHyperlinksinGCIBunker.G(11887)
e. PGPGraphicDescriptions(11907)
f. ShowDynamicSymbolsinS+(11985)

10. ASSYSTPG2Support(11798)

a. SupportASSYSTEncryption(11863)
b. ASSYSTvectoringlinks(11872)
c. Applyratiotodrawingdimensions(11940)
d. PG2fulltextsearch(11942)
e. Useinputfiletoclassifyrecordtypes(11951)

11. Swapheightandwidthviacustomedit"pg2_swap_dimensions"(11814)

12. Multilinetextandcomponentscriptparsing(11837)

13. Improvementsto800xAPG2processing:

a. StationPV,SP,COandMAValuesin800xA(11863)

Wizard:

1. Supporthasbeenaddedforthelocatingandselectingof.UCBGfiles(forPGPgraphics)and 
ASSYST800xAVBandPGgraphics.(11813,11844)
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Version 10.5  September 17, 2013

System:
4. DBDOC now supports PG2.
5. DBDOC now supports PGP/S+.
6. Configuration errors detected by the DBDOC build process are now reported in a new Error 

Browser in Hyperview, as well as in the text file reports as before.

Hyperview:
9. Error Browser

a. New Error Browser created that displays all configuration errors detected during 
DBDOC build.

b. Facilities for marking and hiding errors persistently, to help with their management 
and correction.

c. Support for linking directly from error browser into specific locations in the M14 in 
the main Hyperview browser.

10. Watch Window

a. Data value display added to block legend.

b. Crosshairs labeling improved to avoid overlapping text and make mouse-over 
values much easier to read.

c. Freeze scroll moved to toolbar to improve usability.

11. Display

a. A variety of problems related to windows and dialogs on multiple monitor systems 
addressed.  Audit Window, XRef, Watch Window, Error Browser etc all play 
nicely with dual monitor systems.

12. PG2 Support

a. Support for the display of PG2 graphics.

13. Search

a. Increased relevancy of database search results, better search result count accuracy.

b. Improved wildcarding behavior with * and ? and other text search fixes.

BuildPlus:

1. PG2 XLS and PGP/S+ file support has been added. To include PG2 XLS files in your build, 
specify the location of the files in the "Database Specification" panel; for PGP/S+ files, look 
for the option to include them in the "Wizard" stage. You will be able to specify which 
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databases are to be associated with each folder of graphics selected. On subsequent rebuilds, 
any changes (new, deleted or modified files) in the chosen graphics folder(s) will be 
automatically picked up for processing for the new M14. (10870,11289)

2. Display the command line syntax for the currently open project with the new "Command Line 
Help..." option under the "Help" menu. Select the desired build options to see how the 
command line should be formed and use this to help set up scheduled builds. (10787)

3. The issue of retaining the trend database assigned in a Database-Graphics association has been 
fixed. (10930)

4. Support has been added to handle the new database processing utility xls2dbf to extract data 
from PI and generic databases. (11101)

5. Tweaks to the displaying of BuildPlus on multiple monitors have been made to take into 
account when the monitor on which the BuildPlus window was previously displayed has been 
removed. (11178)

CIUMon:
1. Communication and usage statistics are now saved between runs of CIUMon until you choose 

to purge them. This is applicable to saved configurations; if running with a default (unsaved) 
configuration, the statistics will be discarded when that instance of CIUMon is closed. Note 
that as with previous versions of CIUMon, when the statistics option is turned off, the 
statistics are also cleared at that point. CIUMonController has also been modified to allow you 
to view the statistics of any running CIUMon service. (7669)

2. The relay communciation mode has been removed from CIUMon and put into a stand-alone 
version named CIUMon_Relay. This version of CIUMon works only in relay mode and is 
CrypKey license free. However, it does still require that the user have Administrator 
privileges in order to install and run it. For users who previously had relay mode 
configurations, the switchover should be seamless - after upgrading to the current version, 
CIUMon will automatically do the conversion on its initial run and launch the appropriate 
version of CIUMon - either the DCS CIUMon or the Relay CIUMon. When manually run, 
both configuration types will be displayed in the "Load Configuration" dialog for ease of 
selection - the correct CIUMon will be run upon the user's choice so you do not have to be 
particular about which version of CIUMon to launch. (9801,10708)

3. A new feature to connect to a Harmony OPC Server for data fetching has been added. On the 
"Communication Modes" page, specify the computer on which the server is running and the 
instance that you wish to connect to. Please contact us in order to get the correct tags setup to 
get this feature to work for your system. NOTE: You must have version HAOPC 6.0 or higher 
in order to get this functionality with CIUMon. (10501)

4. The new Collector mode feature has been added to both CIUMon and CIUMon_Relay. This 
mode is for clients who want to enforce the rule that no data flow can be iniitiated from 

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 55 of 156



 DBDOC Release Notes  
outside of the DCS network. Running in Collector mode will satisfy this rule. The setup would 
be as follows:

a. CIUMon_Relay will be put on a computer outside of the firewall. It will be set to run 
in Collector Mode, i.e. it will collect requests from any instances of Hyperview or 
CIULink connected to it but it will not speak until it is spoken to.

b. DCS CIUMon is setup inside the firewall and is set to run in Collector Mode as well, 
i.e. it is told that there a CIUMon_Relay runnning on a computer somewhere, 
collecting requests, and that it (the DCS CIUMon) needs to ask this CIUMon_Relay 
instance if it has requests queued up.

The data flow would then be:
a. Business LAN Hyperview requests block, spec and/or status values from 

CIUMon_Relay.
b. DCS CIUMon asks CIUMon_Relay if any data is wanted. CIUMon_Relay will then 

send its queued up requests upline to the DCS CIUMon.
c. CIUMon sends the requests to the CIU and gets the appropriate responses. These are 

then sent back to CIUMon_Relay who then sends them on to the Business LAN 
Hyperview that requested them. (10627)

5. When manually running CIUMon, the last loaded configuration will no longer be 
automatically loaded if there are mutliple configurations saved. You will presented with the 
"Load Configuration" dialog on start-up for configuration selection. (10980)

6. The option to run CIUWatcher without specifying a conditional file with a CIUMon service is 
no longer allowed. Preexisting services that had the CIUWatcher specified this way will 
automatically have the CIUWatcher service removed after CIUMon has been upgraded and 
run for the first time. (10982)

7. Fetching the specs of a DAANG block has been improved. (11029)
8. The Process ID of each CIUMon instance is now displayed in CIUMonController. If there is 

an issue with stopping a service you can now see which instance belongs to the which service 
and kill the correct process in Task Manager. (11195)

9. The "Send" command option has been removed; it has been replaced with the singular option 
to send a CIU Restart. (11269)

10. Logging has been reworked so that logging is essentially always on. You can choose between:
a. Error-activated logging which now includes all startup/shutdown and 

connect/disconnect messages. This will give us a tool for troubleshooting should there 
be any issues on startup and connecting.

b. Full logging.

For users who did not have logging on previously, they will be automatically set up for error-
activated logging, the minimal logging feature. (11273)
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11. Recovery on timeouts on the 0x50 read output command has been implemented to revert to 

the 0x14 command instead. This was fix was put in when it was discovered that some PCUs 
would respond correctly to the 0x50 command while others would time-out. This recovery 
will occur automatically without any user intervention. However, if the user wishes to force 
CIUMon to always use the 0x14 command regardless of the 0x50 response, there is an option 
on the "Configuration" page to specify this. (11372,11373)

12. On rare occasions, when a CIUMon service starts after reboot, it is not able to correctly obtain 
its CrypKey license status due to the license service not being fully started and running at that 
time. As a result, CIUMon will not be enabled to run due to its lack of licensing. We have 
added a configurable delay (in seconds) on CIUMon service start-up which will allow the 
CrypKey license service to finish its startup sequence before CIUMon attempts to obtain its 
license status. This option is available on the "Configuration" page of the CIUMon options 
and applies globally, i.e. it is not configuration specific.

13. The CIUMonService logs will now be written to the location specified for the CIUMon logs 
rather than in the Programs directory. (7872)

Decomposer:
1. Support has been added for FC 205, 206, 207. (10464,10575)
2. Progress meter is now displayed during Decomposer run. (11076)
3. Age test on CFG files restricted to configured modules (11002, 11383)

Hyperlink:
1. Error messages have been converted to database entries for new Error Browser feature.
2. AutoCAD support to AutoCAD 2013 has been implemented. (10665)
3. 800xA PG2 support by way of ABB Display Documentation has been released.
4. SPlus and PGP support has been released.
5. Support for long text fields has been implemented in XLS file support. (10665)
6. Composer Version 6.0 including FC 205, 206, 207 is supported. (10464)
7. Progress meter is now displayed during Hyperlink run. (11069)

Wizard:

1. Support has been added for the locating and selecting of PG2 XLS (.png and .csv) and 
PGP/S+ files. (10892,11289,11506)

CIULink:
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1. Archived line storage has been reworked to use dynamically allocated memory to 

minimize the amount of memory utilized. Some memory leaks were found and fixed. 
(11302)
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Version 10.4.2  September 15, 2012
General

The development environment for all applications has been converted to Visual Studio 2008.  
This has necessitated various underlying library updates that should not be noticed by the user. 
Minor user interface formatting issues have been observed (and corrected).

Hyperview:
1. System

a. Hyperview no longer depends on zlib1.dll at runtime. This dll is no longer needed in 
the Hyperview executable folder.

2. Live Data Display & Performance
a. Digital data on drawings and graphics is now a medium blue color (for 1), instead of 

green.  The change was requested by clients who had conflicting significance for the 
color green in existing graphics.

b. In Slow Mode (aka Snapshot Mode) when a drawing or graphic is displayed fully 
zoomed out, there is a delay of five seconds before live data is fetched.  This preempts 
unnecessary data fetches in many common cases, such as immediately zooming in on 
a certain part of the drawing, or immediately switching to another document.

c. Live data is no longer displayed for imported blocks (avoiding gratuitous off-module 
fetches that systemically prevent turbo fetching from working optimally)

3. Cross Reference Data
a. Cross reference data for all blocks in the M14 can be exported into a single csv file for 

offline analysis.  Previously, only one document at a time could have its cross-
reference data displayed in the XRef Window.

4. Audit Window
a. A longstanding bug in the display of function codes in the Audit Window was 

corrected.
5. Live Data Setup

a. Computer host names containing underscores are now accepted.
6. Help

a. Installation changed to avoid a potential "blocked" help file situation.
b. 2011 and 2012 versions of ABB's function code help are supported.
c. New pdf viewers are always opened when the user requests pdf function code help.
d. Standard ABB 2-volume pdf documentation is supported.

BuildPlus:

1. Support has been added to locate and use the two volume Function Code PDF manuals. 
(9812)

2. The project export file (.bpi) is now automatically generated at the completion of a build and 
archived in the respective folder in the ERROR_FILES directory. This allows the user to 
easily revert their project to an earlier state. (10144)
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3. BuildPlus will now give unique names to extracted PI databases from Excel workbooks.

(10199, 10384)
4. Path selection in our browse dialogs have been improved to allow the user to type in the 

desired computer name rather than having to scroll through the full network list. (10225)
5. A problem with missing databases when the option "Process databases in order of 

descending number of tags" is checked in the "Advanced Options" dialog has been fixed. 
(10251)

CIUMon:
1. The deleting of configurations has been reworked. The user can now delete multiple 

configurations at once. Any configurations that may be currently open in other instances of 
CIUMon or are specified for use with services will be flagged and presented to the user for 
deletion confirmation. (9366)

2. Some CIUMon related information can now be easily accessed:
a. The computer name and IP address of the computer that CIUMon is running can now 

be found via the new "Help - Computer Name and IP Address..." menu option. This 
is useful for new clients trying to setup Hyperview-CIUMon communications. 
(9814)

b. If RoviSys OPC90Server is installed on the same computer that is running CIUMon, 
its version and installation location is reported in the CIUMon log header. (10329)

3. Improvements to handling when connected to RoviSys Turbo have been implemented.
a. Better evaluation to determine if strings are supported in the turbo fetch used by 

RoviSys. If not, CIUMon recovery is faster and will return a valid string response a 
cycle earlier than before. (10082)

b. Valid blank strings do not cause CIUMon to revert to single block fetches when bulk 
fetches are valid. (10083)

c. A crash in CIUMon with an older version of RoviSys Turbo (7.4.3) when it was 
stopped and  restarted while fetching string data has been fixed. (10242)

d. Error 103 is now being correctly handled so additional unnecessary dequeues are not 
sent. (10248)

e. Single fetches will be used for blocks with the Module is defined as 0 or 1 instead of 
as part of a bulk fetch. (10391)

4. Receipt of error 37 when CIUMon using the 0x50 command to fetch block output will cause 
it to revert to using the 0x14 read block output command instead so that valid data can be 
fetched. (10351)

5. A hang in CIUMon after upgrading the 10.4.1 version has been fixed. (10352)
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Decomposer:

1. We now generate a report listing the .CFG files referenced in Composer by name 
(EBYxxxx.CFG), showing loop, pcu, module and date. (10341)

Hyperlink:

1. New messages are being generated for the following situations:
a. If the type of the input block to an adapt block does not match the required 

type of the spec that is being adapted. (4854)
b. Spare blocks that are imported and then used in downstream wiring. (8277)
c. REDDAI blocks have quality tested. They are checked to be wired directly to 

a TSTQ or wired to AO/L or DAANG block and imported in another module 
and wired to a TSTQ. (9741)

d. We report a difference in Composer between drawn lines and logical (actual) 
wiring. (9752)

e. PID type blocks should not have zero gain.
i. Function Code 18 and 19: S5 nor all of S6, S7 and S8 should be zero.

ii. Function Code 156: S11 nor all of S12, S13 and S14 should be zero. 
(9838, 10153)

f. CLIF FC 239 and 240 Quality (10060)
g. Deliberate spare usage will no longer generate an error message. (10141)
h. Check for the product of PID gain and Station span to be near 100.0. (10364, 

10420)
2. AutoCAD rendering has been sped up. (8435)
3. Some systems systematically interpose logic blocks on slave sheets between the slave 

output and the output reference. We will now trace the ouput of the slave to the output of 
blocks it feeds until an OREF is found. (9037)

4. Creation of links has been improved. Links are now made on 'relevant' first parts of a 
document title. As well, one can now specify a document prefix which will allow for a 
link to be made to the same text without it. (9335, 9961)

5. The Module Header page now reports the number of Function Blocks (for ease of 
calculating loading when verifying or downloading) and Exception Reports (to give an 
indication of how much traffic the module can generate). (9836)

6. We now generate a report listing the .CFG files referenced in Composer by name 
(EBYxxxx.CFG), showing loop, pcu, module and date. (10341)

7. We support all two volume function code PDF files we have encountered (9996).
8. New versions of AutoCAD and MicroStation drawings are now supported (8150, 9164).
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9. Live data from other modules is no longer displayed on CAD / CLD sheets (10369)

DataFiles:

1. New messages and improved wording on some others. (10138, 10288, 10335, 10385, 
10419,10452)

Wizard:

2. The specification of different AutoCAD types has been made easier. (9932)
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Version 10.4.1  March 15, 2012
Hyperview:

1. Platform:
a. Hyperview for Windows 2000 will be frozen at 10.4.1.  There are now two versions 

on Hyperview, one (frozen at 10.4.1) for Windows 2000, and one for other platforms.  
The correct version should be installed on your system automatically.

2. Watch Window improvements:
a. Support for scheduled paused was added to the Watch Window.  Blocks and groups 

can now be configured to automatically stop collecting live data at a certain time, or 
after a certain collection period. 

b. Data exported from the Watch Window now has a set number of significant digits 
rather that a set number of decimal places.

3. Live Data support:
a. Continued improvements to the ability to fetch and display live data via RoviSys 

Turbo.
b. Standardized live data significant figure display on CAD sheets.
c. Corrected problems in the significant digits formatting of live data for data fetched via 

RoviSys Turbo.
d. A memory leak that could be encountered when an unavailable CIUMon was present 

in a server settings list was corrected.
e. Various issues concerning socket-port over-consumption in certain circumstances 

were addressed.
f. Live data is no longer fetched for blocks without a source that are not explicitly 

marked as external in BuildPlus.  Live data fetching can be forced for any block by 
making a live loop annotation or adding it to the Watch Window.

g. “Camera/Snapshot” live data collection mode has been changed to “Slow” mode.  
Previously, data was refreshed in this mode only when a document was loaded, or 
zoomed, scrolled etc.  Now, the data is refreshed in these circumstances, and also 
every ten seconds.

4. Display improvements:
a. Vegas Lights were made to hug their hotspots more closely in order to avoid 

obscuring nearby text.
b. Hotspots specified on the command line (e.g. with /tag) are centered on the display 

when Hyperview starts.
5. Printing support:

a. Fixed F(x) plots printing on black background bug.
b. Loop/PCU/Module/Block search results no longer print garbage when blank.
c. Fixed AutoCAD printing “cut off” under certain circumstances.

6. Command Line support
a. Comprehensive rework of command line specification of documents.   Document 

types are more consistently specified now, and documents of different types with the 
same names are correctly distinguished.  Name matching on partially specified names 
is handled more sensibly.
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BuildPlus: 

1. Batch file processing has been improved:
a. Batch files have been reorganized to appear in LPM chapters for ease of use. (5505)
b. As well, some reworking has been done to suppress batch files from the configuration 

when named in an #INCLUDE statement. 
c. Batch titles have been improved.  BuildPlus will now use either the #descriptor field, 

the #title field or the filename. 
2. BuildPlus now creates a .CSV file which contains information about all the files being built 

into a particular project.  It will contain the filename, time and date the file was last modified 
and the file size.  This file, named <project_name>_file_statistics.csv, will be located in the 
ERROR_FILES directory. 

3. General memory and resource leaks have been cleaned up. 
4. The DBDOC build system has been frozen at the 10.4 release for Windows 2000. 
5. User defined scripts have been reworked to allow the user to specify a script to be executed 

before, during (before the hyperlink run) or after the build.  Only one of each type of script is 
allowed.  These can be defined on the "Processing Options" page in the "Project Options". 

CIUMon: 
1. Handling has been added to CIUMon when running in relay mode to improve confirmation of 

successful communication to upstream CIUMons.  This will help to prevent loops and to 
prevent unnecessary traffic when responses are known to be not available. 

2. A CIUMonController crash has been fixed when saving summary statistics .csv on certain 
platforms. 

3. Detection of open configurations has been improved.  Configurations opened under different 
logins or running as a service not interacting with a desktop will now be correctly detected 
under all conditions so that they cannot be opened in another instance of CIUMon. 

4. Changes have been made to increase the efficiency of working with the RoviSys turbo fetches:
a. Like type data points are now grouped together in single bulk fetches to allow for 

quicker response from RoviSys for the known blocks. 
b. Unknown blocks (those that have not been fetched before) will be sent in a bulk fetch 

rather than as individual "read output" requests.  This prevents receiving possible 
failures for an unsupported 0x50 read output command and thus delaying the response 
by having to fall back to the older 0x14 read output command. 

c. Any data that has been marked as stale by RoviSys Turbo will also be in turned 
marked stale in the response returned to Hyperview / CIULink.

d. CIUMon will now retain block information (block data types) between runs so that it 
does not have to re-establish the type each time it is restarted.  This will allow for 
efficient bulk fetches right from start-up. 

e. The number of non-turbo fetchable blocks for each bulk fetch has been lowered to 4 to 
allow for quicker response. 

f. CIUMon now uses the Module Status command for its connection status check so as 
to not confuse the block timing in RoviSys Turbo by requesting the output of an 
actual block at intermittent intervals. 
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VirtualPortSetup: 

1. The first VSP that can be created is now the first available port.  Lower port numbers are no 
longer being reserved. 

2. A problem with not being able to completely delete or uninstall virtual serial ports has been 
resolved. 

Hyperlink: 
1. Digital tags that might be intended to alarm are reported.  The test is for the DO/L block 

having S2 =2, but alarm group is not 0 or 99.  They cannot alarm but it might be the case that 
they are intended to alarm.

2. Inputs to TSTQ block have additional testing involving the chain of quality.  We detect 
importing blocks that have no quality from their source.  We also flag the situation where only 
the quality of the communications is being tested.

3. Redundant Analog Input and Redundant Digital Input blocks need specific input and 
specification settings to function validly.  New messages have been added to alert the user to 
possible invalid usage.

4. Additionally, some situations that were previously being reported as errors have been 
downgraded or removed.

a. Tag not used on primary display message removed 
b. Tags will with only Primary Display or Alarm Vector  are no longer reported as 

having no source.  
5. The rendering of AutoCAD drawings has been speeded up. 
6. Symbols are now listed on the Cross-Reference page if used on the graphic even if they are 

not displayed by DBDOC. 
7. HPG800 module type support has been added.  
8. Support for CLIF blocks has been improved.  
9. Links on tags and slave "pseudotags" on AutoCAD sheets have been improved with changes 

made to the partial tag matching code. 

DataFiles: 
1. Re-ordering of the error messages allow for the negative block messages to be grouped 

together rather than dispersed among other messages.  
2. Elevated priority of some generated error messages and improved wording on some others. 

Wizard: 
1. Various memory and resource leaks have been cleaned up.  
2. .Tiff files have been added to the Wizard file selection handling.  
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Version 10.4  June 30, 2011
Hyperview:

7. A number of Watch Window improvements have been made: 
a. Watch Window data is no longer loaded into memory, but instead is loaded from file 

as needed for displaying.  The practical size of trend plot datasets is thus no longer 
limited by available memory, but instead by system file size limits and disk space 
available. In other words, you can have as many 2 gigabyte datafiles as you have disk 
space for.  Display of plot data on startup is now instantaneous – no load time is 
required. 

b. Tag names and block descriptions are exported as part of the block value title when 
data is exported from the Watch Window.

8. The live loop setup , where CIUMon server locations are specified, has been substantially 
improved.   New features include the following:

a. M14 files can now contain multiple lists of CIUMon servers in different network 
contexts (typically one for the DCS LAN and one for the business LAN).  Hyperview 
will attempt to select the list automatically, though it can also be selected by the user.

b. Local custom live loop settings are now persistent, and can be selected instead of the 
setting built into the M14.

c. More complete and consistent connection status information is displayed in the 
browser status bar, the tooltip of the statusbar connection icon, and in the live loop 
setup dialog. 

d. Information about which loop (and pcu) the CIU (or serial port module) a CIUMon is 
connected to is located on is now fetched from the CIUMon itself. 

e. The CIUMon actually used for data fetch requests from a particular loop is indicated 
in the live loop setup dialog.

f. Where more than one CIUMon option exists, Hyperview attempts to route data 
requests in the most efficient manner depending on the loop of the desired data.  The 
chosen routing is shown in the live loop setup dialog.

g. This automatic routing can be overridden by the use of “routing preferences”
h. CIUMons can be marked as “ignored” which causes them to not be used, but without 

needing to be deleted. 

9. Links to external PDF and TIFF documents can now be built into the M14 file and displayed 
from Hyperview.   The file path is included in the M14, but alternate paths can be specified 
from within Hyperview.   When links to external function code documentation is built into the 
M14, Hyperview displays it automatically when function code help is requested. 

10. Live input and output values are now plotted on function code 1 F(x) graphs, along with the 
previously plotted live spec values.   The live plot is now updated in the same mode as the 
underlying CAD/CLD diagram (i.e. snapshot mode or continuous), although it can also be 
refreshed on demand.
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11. The presence of signal quality is now shown statically on CAD/CLD diagrams with “blue 

lines”.  When live data is turned on, the lines can become purple if the signal has bad quality.

12. The Audit Window now shows a count of child branches. 

13. Live data colors have been reworked to improve consistency among data on documents, live 
loop annotations, F(x) graphs and watch window data.   The following conventions are now 
applied:

a. Green:  live data with good status.  Previously it was sometimes dark blue, sometimes, 
green, sometimes light blue.

b. Gray: stale data .  The stale color is now gray, not red.  This shows up most obviously 
in live data on documents, snapshot mode and in the watch window where red clocks 
are now gray.  A general pattern of "graying" out other live data colors has been 
implemented to indicate staleness.

c. Orange: blocked data.  Can be seen in the status bar, in the live loop setup connection 
display, and for data on documents.

d. Red: error.   Red is error or can't get data due to no connection.
e. Light blue: no route to data.  Can't get data due to no connection to the specific data 

location (e.g wrong serial port module)
f. Dark blue: quality and good quality.   
g. Purple:  bad quality.

14. Various fixes and improvements to live data displays have been made including the following:
a. If logic state labels have been misconfigured so that both 0 and 1 values have the 

same label, the label is suppressed, and the actual value is shown.
b. Display of significant figures for live data has been made more consistent.  In general 

five significant figures are displayed.
 

15. A number of printing bugs were addressed, including printing of AutoCAD files, which was 
failing to print the entire sheet under some circumstances.

16. Hyperlink now preserves upper and lower case in document names built into the M14.  This 
means that Hyperview bookmarks and annotations that were created on affected documents in 
M14s before this change may be “lost” or “disabled”.  They are easily recoverable. Contact 
GMCL.

BuildPlus: 
1. BuildRoot and project settings are now stored in hash tables which are dumped to files in a 

known location.  The settings were previously stored in the registry which limited which users 
(those with Administrator privileges) could perform builds.  With this new scheme, any user 
with access to BuildPlus should be able to perform builds.

2. The Live Loop / CIUMon Settings options have been revamped.
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3. BuildPlus will now use the WinMerge program for its file/folder comparison tool.

4. Builds can now be performed on 64-bit platforms.

5. AutoCAD file processing has been sped up during the configurator stage of the build.

6. Handling has been changed to improve the paths and titles displayed in the Table of Contents 
of the .M14 in Hyperview.

7. MDB_Extractor has been reworked so that it utilitzes ADO rather than DAOSDK.  BuildPlus 
has been modified to support these changes and to remove any DAOSDK support.

8. If multiple copies of BuildPlus are running at the same time, you will now be prevented from 
building the same project in more than one instance of BuildPlus.

9. A new feature has been implemented to allow you to revert a project to its previous settings.  
This will only work if you have the "Archive Project Error Files" option turned on in the 
BuildRoot Options so that the necessary files are generated and stored for the reversion.  
Under the "Tools" menu, choose "Revert to a Previous Build..." and choose the project .nod 
file from the date that you want to revert to from your archived error file location.

10. Various memory and resource leaks have been cleaned up.

11. You can now choose to build in your Function Code .PDF files into your .M14 file so that you 
can easily access the information.  The option can be seen on the "Database Specification" 
panel (start a project from the GO button) or you will be queried if you wish to include these 
files the first time you do a rebuild of an existing project. 

CIUMon: 
1. New versions of the virtual serial port files have been released.

2. The user can now specify the location where CIUMon will write and store its logs.

3. There is a new logging option - error activated logging.  Logging will not start in CIUMon 
until it encounters an error in one of the responses from the CIU.  CIUMon keeps a buffer of 
the past responses so you can specify the number of minutes of information that CIUMon 
should write to the log when it sees an error.  You can also specify the number of minutes 
after the error that CIUMon should continue logging before it stops.

4. The RoviSys OPC90Server program has a few new features to note:

a. There is now the option to connect via a virtual port connection in the MUXCIU 
block.  This will allow CIUMon to connect to it without the need of an actual port.  
Choose this option on CIUMon's "Communication Modes" page in the CIUMon 
settings.

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 68 of 156



 DBDOC Release Notes  

b. RoviSys has implemented a new MUXCIU Read Block Output List command which 
allows for the fetch of multiple block values in a single request.  This greatly 
improves the data collection throughput by taking advantage of the OPC90 turbo 
polling provided.

5. CIUMon uses fewer deferred keys thus improving response times.  The default is set at 4 but 
can be modified in the CIUMon settings.

6. CIUMon will now attempt to use the 0x50 command in place of the 0x14 for the read output 
requests.  The 0x50 command will return 4 byte reals for a response rather than 3 bytes ones, 
allowing for greater precision.  If the command is not supported by a given CIU then CIUMon 
will revert back to using the 0x14 command.

7. Text data support for function code 194 has been added.

8. CIUMon will work now if UAC (User Account Control) is turned on.

Hyperlink:
1. Blue Line for Quality, Purple for Bad Quality — In CLD and CAD sheets, all signals that 

have the quality attribute are shown in blue.  If the signal is bad, live data shows the line in 
purple. 

2. Live Data on References  — The value of signals is shown on input and output references.  
This is a major enhancement when logic is done using pre-programmed macros. 

3. Link to Function Code PDF files — Links on Help and Function Code blocks are built to the 
Composer and WinCAD PDF function code documentation. 

4. Support of Formatting in SODG Graphics — The formatting in SODG graphics that defines 
the number of digits to display is implemented. 

5. AutoCAD Attributes, Linking and Printing Improvements
1. Improvements have been made to make generation of links to tags and slave references on 

AutoCAD sheets much more effective by editing a simple text file. 
2. Links to generic XLS files have been made possible. 
3. Printing of AutoCAD sheets always is done with a white background. 

6. Support of MTLink in 800xA Graphics — A common linking technique in 800xA VB 
graphics has been implemented. 

7. Corrected Nordic Character Support — Support for Nordic (and other codepage) characters 
has been corrected.

8. Support for FC 194 (text string output) implemented.
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9. File names are no longer converted to upper case when compiled into the M14.  This change 
may bookmarks and annotations that were made in Hyperview on earlier builds (on 
documents with lower case letters in the names) to be “lost” or “disabled”.   Any affected  
bookmarks and annotations can be readily retrieved – contact GMCL.  

10. Composer version 5.1 is supported.

11. Improvements in Error Checking and Compiling 

a. Report Logic States if Same
b. RESTOR Block Order Test
c. Tag Found in Other Database Resolved
d. Composer and Access Wildcard Chars
e. More Similar Tags
f. Tag addded on multilevel alarm message
g. List nested inhibits.
h. Alarm Inhibits in Composer
i. Spec Extraction - Large Values
j. Links on Blocks in B90 Files
k. FCConstraints quirks
l. Block map and Segment Control Blocks
m. Tagname in Significant change report
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Version 10.3.1  October 12, 2009                                                              

BuildPlus:
1. Corrected handling when building multiple Access .MDB type databases into a single build.  

(7839)

2. Fixed a hang in processing during the Management of Change stage when an empty or 
misconstructed datbase file is encountered.  (7682)

3. BuildPlus will now check to see if the user has the necessary administrator privileges in order 
to use the program.  On Windows Vista it will perform the additional check of seeing if User 
Account Control is turned off before proceeding.  If either of these conditions is not met then a 
message box warning the user will appear and BuildPlus will exit.  (7925)

4. For PPA projects, BuildPlus will now parse the file ppa_graphics.txt to guide the user in 
selecting which folders are graphics or submodels. (8001)

5. Automatic generation of Conductor NT consoles in BuildPlus has been improved.  BuildPlus 
can now do the correct associations for the  XDC and DAT files if they are placed in a logical 
location in the Conductor NT file structure.  (8011)

6. Currently you can only include one 800xA project in any one particular build.  In the future, 
we hope to support the ability to inlcude multiple 800xA projects in one build.  (8078)

7. Handling has been added so that 800xA graphics and submodels will be tracked and reported 
in Management of Change.  (8102)

8. Memory and resource leaks have been fixed.  (8110)

CIUMon:
1. All of the CIUMon service options have been incorporated into one dialog for ease of use.  

(7026)

2. A bug in the TRAX simulation handling where CIUMon was unable to fetch the output values 
for blocks numbered above 4095 when the  tag indexing scheme was employed has been 
fixed.  (7565)

3. A new option to create hourly logs has been added.  (7582)

4. Fixed internal setting of CIU type for an ICI03 so that the correct request and response 
handling would be triggered.  (7727)

5. Corrected CIUMon retries on initial connect - if it fails to get a response to its environment 
request then it continues to retry every five seconds until a good response is received.  
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Although the messages in the window reported the request was being re-sent, it actually was 
not; this has been fixed.  (7913)

6. CIUMon will now check to see if the user has the necessary administrator privileges in order 
to use the program.  On Windows Vista it will perform the additional check of seeing if User 
Account Control is turned off before proceeding.  If either of these conditions is not met then a 
message box warning the user will appear and CIUMon will exit.  (7925)

7. CIUMon services interacting the desktop when stopped and restarted will now retain their 
previous connection setting.  That is, if a service was connected before, it will be connected 
after the restart and vice-versa.  (7730)

DataFiles:
1. Errfilter.cfg updated for new and existing error messages.
2. Tagatoms.txt has been updated with new entries.
3. Corrections made to output.txt.
4. New and updated TTG text and database files have been included.

Decomposer:
1. Decomposer now exits cleanly (i.e. does not crash) when a corrupted or unsupported file is 

encountered.  (8021)

Hyperlink:
1. Additional links are now being created on trend submodels.  (4453)

2. A crash in the batch file handling dealing with the continuation line character has been fixed.  
(7680)

3. EGU text display on 800xA graphics has been corrected.  (7738)

4. Links to tags that were previously lost have been reinstated.  (7745)

5. The ADVBPOEXTENDEDPRIMITIVESLibCtl.AdvantBarLimits type dynamic bar is now 
properly displayed on graphics.  (7753)

6. Text positioning and wrapping on 800xA graphics have been corrected. (7754, 7765)

7. HIGH and LOW limits now appear on 800xA graphics.  (7899)

8. For station tags, PV references get the @PV tag and SP references get to the @SP block.  
(7958)

9. For 800xA systems, hyperlink will now use the full functional structure view on graphics.  
(8035)
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10. The handling of long filenames and/or paths in AutoCAD which caused Hyperlink to crash 

has now been fixed.  (8141)

Hyperview:
1. Hyperview will now automatically close and restart when the GDI or User object threshold 

has been reached to avoid hanging/crashing. (8176)

2. Memory leaks in 800xA graphics handling have been fixed.  (8177)

Node:
1. Memory leaks have been cleaned up.  (8177)

Wizard:
1. Speed when searching through large data sets, selecting/deselecting files/folders from long 

lists and performing duplicate file comparisons has been vastly improved.  (5226, 7481, 8009)
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Version 10.3  March 24, 2009
** Note - DBDOC now supports 800xA graphics.  To include them in your project, 
          please see the folder "800xA Instructions" on the CD.

Hyperview:
1. Additional Watch Window features have been implemented:

a. The update interval for a block is now displayed and can be updated directly in the 
block list.

b. You can now set the update interval for an entire group of blocks at once via the group 
menu.

c. Plot line colors can now be specified for blocks in the Watch Window.
d. Plot description text is now displayed right on the plot itself.
e. Improved handling of "out of memory" situation if too much data is collected for the 

resources available.  Data collection stops.

2. 800xA graphics can now be displayed in Hyperview.  To display 800xA graphics, you need to 
register certain DLLs. To do this, run  .../Program Files/GMCL/DBDOC/PROGRAMS/PPA-
DLLs/PPA-DLLs.exe – this will extract a mini-installer that will register the 800xA DLLs 
appropriately.  If your system does not have 800xA graphics, it is not necessary to do this. 

3. The Go To Use feature for blocks has been extended -- the source of a value is now shown as 
one of the uses, and Go To Use can be called from a use (previously you could only Go To 
Use from a block source). 

4. Projects (M14 files) that have been "moved" (renamed) in BuildPlus are now handled 
correctly.  Previously, renaming a project in BuildPlus led to the loss of some or all of the user 
data files (representing  annotations, live loop annotations, watch window data, bookmarks, 
history etc).  Renaming the user data files to match the new project name was not sufficient to 
retain the user data because many of these  files contain internal references to the project 
name.  As of 10.3,  if you load a project that looks new (has no user data files), Hyperview  
will ask if it is a renamed project.  If it is, you will be prompted to identify the project's former 
name.  All the user data files associated with the former project name will be copied, renamed, 
and converted to work with the new project.  

5. Searching & search results have been updated in several ways:
a. The text search dialog has been reorganized and clarified.
b. The Loop-PCU-Module-Block is now displayed in the search results list when 

appropriate.
c. For text searches, when the search result is a block, Go To that search result causes 

the relevant part of the configuration (where the block is used as a source or input) to 
be displayed in the content pane.  The block index is displayed in the index pane as 
before.

d. For database searches, Go To search result causes the block source (not the database 
listing) to be displayed in the content pane.
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e. For topic title searches, Go To search result causes the block source in the 

configuration to be displayed in the content pane whenever the search result is a block 
index.

6. The Loop Setup list in the Live Loop Setup tab of the Options Dialog now indicates 
connection status by color: black=connected, gray=not connected, red=blocked.  The 
checkboxes that used to indicated connection status have been removed. 

7. Updated support for "blocked" live loop connections:
a. A new "blocked" icon has been added to the Hyperview status bar to indicate that this 

Hyperview is not allowed to fetch data from any  specified CIUMon.
b. Avoid initiating data requests on known blocked connections.

8. External blocks are now shown in the Audit Window.

9. Open Document feature (removed in 10.2.1) has been put back.

10. If any PCU specific connection is available, live loop data which is  inaccessible is displayed 
in blue (as opposed to red).

11. Hyperview now has a reasonable minimum window size.

12. The old live loop logging feature has been removed.  Use the Watch Window to log live data 
of interest.

CIUMon:
1. Improvements to CIUMon's data throughput capabilities. Data rate increase will vary by 

system.

2. Improvements to CIUMon's ability to be run for long periods of time without manual restart:
a. CIUMon is restarted by a watchdog application if it is detected using "too much" CPU 

time (generally meaning that it is "hung").
b. CIUMon is restarted if it is unresponsive to status requests from  the watchdog.
c. CIUMon is restarted periodically if it is not busy fetching data.  This is to 

preemptively prevent situations where it becomes unresponsive. 

3. Improvements to CIUMon logging:
a. Users can choose either "Rolling" or "Daily" logs.
b. In Rolling Log mode, users can specify how many logs (up to 10) of  what size to 

maintain.  The oldest log is deleted whenever the limits are reached.  A new file is 
always started at midnight regardless of whether the limits have been reached. This 
mode uses bounded disk space.

c. In Daily Log mode, users can specify the maximum size (or unlimited size) for a log 
to be created at midnight each day.  
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d. CIUMon logging details (e.g. file size) can now be modified on the fly via 

CIUMonController.

4. Upgraded to use CrypKey version 7.1.

BuildPlus:
1. New file types supported in builds:

a. 800xA graphics
b. 800xA MDB files
c. CLT files for Composer

2. BuildPlus will now allow the build to continue if a database previously included in the project 
is found to be "missing".

3. Support for copying (Cloning) and renaming (Moving) projects. 

4. Upgrade to CrypKey version 7.1.

Wizard:
1. Supports 800xA graphics.

Hyperlink:
1. There is now beta-level support for 800xA graphics in DBDOC projects.

a. General support for linking 800xA graphics into the M14 project
b. Support for MDB Configserver database files

2. There is support for newer AutoCAD versions and more accurate presentation of some 
AutoCAD content. Unicode text is supported on AutoCAD files, and may yield tag links.

3. Unicode paths and filenames are fully supported.

2. New checks for errors and misconfigurations:
a. Check that TSTQ Test Quality blocks are actually checking valid quality attributes.
b. Tags that inhibit alarms on other values are now reported.  Nested and circular inhibits 

are also reported.
c. TSTALM blocks that reference a different page are reported.
d. Orphaned ADAPT blocks are now flagged.
e. "Not a valid M1 file" error now reports name of problematic file.

5. A new Significant Change Report is generated. This report helps catch misconfigurations 
(including in Ladder files) that can lead to exception reports erroneously not being generated 
immediately despite significant  changes in values.  

6. Updated document display details (visible in Hyperview):
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a. Import blocks now show "External Source" in the bubble if the source does not exist 

in the M14 file.
b. A ">" now indicates the presence of links between test alarm blocks (TSTALM) and 

their inputs.
c. Composer titles for modules, PCUs and loops are shown in classic TOC.
d. Display of vertical text has been significantly improved.

7. Very large systems are built to show more than one block on block index  pages (two per page 
is sufficient for the few systems that will encounter this).   Previously these systems could not 
be built in a single M14.

8. Update support for Loop-PCU-Module-Block links
a. Now correctly generated for PI sourced points.
b. Now supported for generic database files.

9. Slave tags are generated for FC 137 BASROQ and FC 138 BASBOQ blocks.

10. More information (database name, path to graphic file) is shown in the "Tags in Graphics.dbf" 
file.
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Version 10.2.1  August 7, 2008

Critical Improvements:
 Watch Window loading of data has been sped up drastically
 Hyperview stop CIUMon from fetching new data when it changes pages
 CIUMon stops getting data that Hyperview says is no longer needed
 CIUMon handles many timing and error conditions better
 Go To Use feature has been created to make full screen navigation easy

Hyperview:
1. Many Watch Window improvements and features have been implemented:

a. Data files for the Watch Window are now loaded in the background  when Hyperview 
is opened so as to not stall other operations.  For large datasets, you will see a 
progress bar on the block list to indicate that a load is underway; it will disappear once 
the  load is completed.

b. The ability to delete data for a block in the Watch Window is now supported.  Select 
the range of data you wish to delete and click  on the "Delete Data" button on the 
toolbar.

c. You can now quickly navigate to any timestamps that you may have created on the 
Watch Window.  You can use the buttons located at the bottom of the Watch Window 
to go to the first, previous, next or last timestamp and it will automatically center it in 
the window.   As well, if you scroll away from the currently selected timestamp  you 
can press the "Jump to selected timestamp" button to get you back.

d. The option to invert the axis has been added to the Watch Window.
e. The option to "Go To Source" and "Go To Block Map" has been added to Watch 

Window.  Right click on a block to bring up the context menu and select the option.

2. With the implementation of the Watch Window, plots have been removed from live loop 
annotations.  Pre-existing live loop annotations with plots will be automatically converted into 
Watch Window plots on the initial start up of the new Hyperview.

3. Support has been added to ask for the Module status and to display the data appropriately.  
You can ask for this data by launching the "Define Live Loop Annotation" dialog, selecting 
the "Module Status" radio button and specifying the Loop, PCU and Module that you want the 
status of.

4. Data points for live loop annotations and continuous monitoring are fetched at the start of their 
timer cycles so that a fresh value will be displayed if the user chooses to modify the update 
interval.

5. Retrace Extension has implemented a "Go to Use" capability.

6. The "/block" command line qualifier has been added.  The format for the switch is as follows:  
/block="Module L,PP,MM Block BBBB".  Hyperview will call up the specified source block.
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7. Hyperview will now send a terminate_request command to CIUMon when live loop 
monitoring is on and it moves on to a different document.  This will allow CIUMon to discard 
any outstanding requests that it may have queued up and lessen the load to the CIU by not 
sending requests that are no longer valid.

8. You can now use the 'M' key to turn on snapshot monitoring; 'Shift-M' will turn it off.  
Pressing F5 in snapshot mode will refresh the data.

9. Choose what document Hyperview will open to when it starts up by setting it in "Options | 
View".  You can choose to have it open up to the last viewed page or the Home Page that you 
set by clicking on the appropriate radio button.

CIUMon:
1. Demand Module Status command handling has been added.

2. Better error recovery has been implemented for the following error codes:
a. 31 - Checksum Compare Error
b. 32 - Destination node offline
c. 39 - Destination ring offline
d. 40 - Destination node busy
e. 41 - Destination ring busy
f. 110 - Module not responding

3. Error recovery in general has been improved.

4. CIUMon has been modified to discard outstanding requests when it receives a 
"terminate_request" command from Hyperview.  It will not send obsolete requests to the CIU 
nor will it send any outstanding responses that it has back to Hyperview.

5. A general cleanup of memory and resource leaks was done.

6. When CIUMon is configured to run as a service and is not interacting with the desktop then it 
will autoconnect regardless of whether or not the user has this set up in the configuration.

7. A bug where the OPC90Server was not getting launched when configured to in the options 
has been fixed.

8. The timing of sending and receiving data has been improved.

9. The display handling has been reworked and improved.
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Version 10.2  February 11, 2008
Hyperview:

1. Many improvements and additions have been made to the Watch Window.
a. Autoscaling - the Watch Window will automatically scale the plot to fit the minimum 

and maximum values of the point/group.
b. Checkbox added to the block list  - if checked, the line associated to the block is 

shown; otherwise it is hidden
c. Clock icon added at both block and group level shows the current live data gathering 

status.
i. Green - Actively collecting data and is not stale

ii. Red - Stale data
iii. White - Data collection is paused.

d. The state of the clock icon at group level can one color or a combination of colors to 
reflect the state of all the points in the given group.

e. Export data for points to a .CSV file.  You can also choose to check the "Excel" 
checkbox to have the .CSV file opened up in Excel automatically after the export has 
been completed.

f. Timestamps can now be deleted from the plot.  Click the [x] on the time label to 
delete it.

g. You can copy a block from one group to another.  Choose "Copy Block to Group" 
from the context menu that appears on a right click.

h. View each block in its own separate plot in the Watch Window.  You can toggle 
between a split or overlapped view of multiple plot plines.

i. A legend appears in the lower right-hand corner of the Watch Window listing the 
block icons (show, pause, autoscale) and what they do.

2. Stale data is now displayed correctly on ladder diagrams on rung function codes.  A red 
background rectangle is now drawn behind the point to indicate that it has gone stale while it 
shows the last known state in the box.

3. Tooltips now appear on the block map to help explain the different types of blocks that 
appear.

4. Fixed Y-coordinate display on graphics and CADs.

5. The "Print Full Sheet" option now latches correctly so that the state is retained between runs.

6. The following changes have been made to the shortcut keys:
a. The "S" key now works the same as the "C" key for turning on/off Specs.
b. The keyboard shortcut for next and previous search hit has been removed.
c. The "Z" key now works as zoom toggle.
d. The "+" and "=" keys zoom in while the "-" and "_" keys zoom out on the current 

document.
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7. General performance improvements and fixed memory leaks.

CIUMon:
1. You can now limit the usage of CIUMon to get live data by username (previously limited by 

IP Address only).  Enter in the usernames the CIUMon options and specify whether or not the 
user is allowed to fetch live data.  If a user not allowed live data gathering then he will see the 
USER_BLOCKED message in Hyperview or CIULink.

2. New usage statistics are now being collected in CIUMon.  CIUMon will track the username 
and IP Address of all requestors and the first time that they tried connecting to CIUMon.  You 
can see how many users have been monitoring with the current instance of CIUMon and who 
is currently active.

3. CIUMon can be run in "Relay Mode" where it relays requests between two other instances of 
CIUMon.  This mode is used in situations where TCP/IP traffic is prohibited across more than 
one LAN.

4. Incoming requests are now dequeued based on the weight of the user so that no one user can 
monopolize all of the bandwidth.  CIUMon will cycle through all of users and dequeue the 
requests allocated to a particular user before moving on to the next.  This allows for the usage 
to be spread out among all requestors.

5. CIUMon has been converted to Unicode to be compatable with foreign language platforms.

6. INICT13A support has been added.

7. The newest version CIUMon now runs at high priority.  If you wish to change the priority 
level of CIUMon then you can access the "Set CIUMon Priority..." option from the "Options" 
menu.

8. A new feature has been added for those users who have TRAX simulation software. You can 
now configure CIUMon to talk to the TRAX software to get emulated data for your system.

9. You can now specify the interval at which CIUMon checks for a valid connection with the 
CIU.  This option can be found on the "Configuration" page of the CIUMon options.  If you 
wish to turn the automatic connection check off simply enter in an interval of zero.

CIULink:
1.  The sequence of data logging dialogs have been revamped for ease of use.
    You will now be able to specify the type of logging (past, present
    or both), the name of the file to log to and what type of data to
    log from one location.

2.  Live loop entries are no longer allowed after the demo setting has been added.
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3.  Some scrolling and display problems have been fixed.

Hyperlink:
1. Positioning of vertical text on Conductor NT and PPB graphics has been fixed.

2. The reference index now has links to off-module references.

3. Hyperlink now generates a zero-length wire where input/output are overlaid to make a 
connection on WinCAD sheets.

4. A group is now being made for all batch files so that files will be searchable.

5. More data being read from the MHD file is now being displayed on the CAD sheet.

6. Function code 229 support has been added.

7. Spare inputs are now marked when the PCU, Module and Block are all equal to zero.

8. Support for Displaynames.txt which was previously broken has been fixed.

9. Hyperlink now generates an error message for inappropriate tagatoms that are found for 
Conductor NT or PPB.

10. Additional coordinate information has been added to our live wire message  to aid in 
troubleshooting.

11. DADIG has been added to the alarm tag function code list.

12. Flat function discrepancies (function code 1) have been fixed.

13. Non-exception report tags used on graphics are now reported.

14. Two new lists are now generated by hyperlink:  TREND_ARCHIVE.TXT and 
TREND_UNUSED.TXT.  Trend tags that are not used on any graphic but have the 
TRUSAGE field set to ARCHIVE are listed in the first list.  Trend tags not used on any 
graphic and have the TRUSAGE field not set to ARCHIVE are listed in the second file; 
hyperlink generates a warning message as well for this condition.

15. An error message is no longer generated for Function code 179 when S15 is set to zero.

16. General hyperlink performance improvements should result in decreased runtime.

Decomposer:
1. Links on CAD sheets by document name have been corrected for Composer projects.
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2. Function code 247 I2 spec handling has been corrected. 

3. Function code is now mentioned in errror messasges.

DataFiles:
1. Errfilter.cfg updated for new and existing error messages (trend errors, TSTALM block 

handling, QOR with 0 inputs).

2. Tagatoms.txt has been updated with new entries.

3. Corrections made to output.txt.
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Version 10.1  September 13, 2007
Hyperview:

1. The new Watch Window feature allows you to plot multiple points on the same graph. The 
Watch Window is resizeable, rescaleable and printable. Points may be edited, added and/or 
deleted within the Watch Window. You may create multiple Watch Window groups to 
monitor different sets of points.  Data is plotted in real time with leading edge values.  Plots 
feature a timescale, crosshairs and timestamps. Timestamps persist across Hyperview runs. 
Import CIULink lists into a Watch Window group from an exported CIULink tag list or from 
a local registry.  Right click a hotspot or an existing Live Loop Annotation to add it to a watch 
window group. Data is collected and logged in .csv files by default and persits across 
Hyperview runs. Data can later be analyzed in Micosoft Excel. You may choose to not log 
data to a file. Collected data can be selectively deleted.

2. The Snapshot operation has been modified.  Each time the camera button is pressed, new data 
will be fetched and displayed.  To turn off the snapshot feature, the button now needs to be 
double-clicked.  Also, if you zoom or change drawings while Snapshot mode is on then data 
will be refetched.

3. Configurable data persistence and background collection for live loop monitoring has been 
implemented.

4. You can now show Live Loop Annotation data graphically. These graphs are resizeable,  
rescaleable, scrollable, and you can add timestamps to the graphs. Data persists across 
hyperview runs by default. You may choose to log collected data to a file or not. Collected 
data can be selectively deleted.

5. A button has been added to the toolbar for the creation of Live Loop Annotations. Continuous 
update live loop annotations are now flagged in the Annotation Manager.

6. You now have the option to select full sheet printouts where the title, date, caption and 
zoombox are suppressed.  This option can be found in the "Advanced Print" options.

7. For digital states, the symbol has been moved to appear after the logic state descriptor.  As 
well, you can now choose to suppress the logic state labels - the "Display Logic States" option 
is available under the "View" menu.  (5294, 5301)

8. Various memory and resource leaks have been fixed.

CIUMon:
1. Handling for the NCIU01 type of CIU has been corrected.

2. CIUMon now correctly handles error 105 - Undefined block number. The response CIUMon 
sends back to Hyperview and CIULink will correctly identify the point as being in error.
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3. CIUMon has been updated to use CrypKey version 6.120.

CIULink:
1. Customizable logging options are now available for export view logging.  You can choose 

what data will be written to the log.

2. A comma-separate variables (.CSV) file allows importation of CIULink data into other 
applications including MicroSoft Excel easily.

3. CIULink has now been equipped with a new synchronized start/stop feature which allows for 
monitoring and logging to be turned on and off at a specified time.

4. Logging now takes place to either the user specifed filename or to a default location - the 
"DBDOC LOGS" folder in your personal folder which, in most cases, is "My Documents".  In 
the default logging location, the log filename will have the date appended to it so that a new 
file will be generated each day.

5. The CIULink saved settings have been moved from the HKEY_LOCAL_MACHINE registry 
key to HKEY_CURRENT_USER.

6. This is the first release of the full unicode version of CIULink.

7. When adding a point that is not found in a database, you can now enter a short description to 
describe it.  This description will be displayed in the "Tag" field in Export view.

BuildPlus:
1. Final version of DBDOC that supports 98/ME is released.

2. Former "BuildPlus Options" are now applied at the buildroot level and have been so renamed.  
This allows you to set the options just for the projects in a  specific root rather than to all 
existing projects.  There are a few options that will still apply to all projects and they can be 
found in the new "Global Options".

3. You now have the ability to specify the code page value that DBDOC will use to interpret 
your data.

4. BuildPlus has been updated to use CrypKey version 6.120.

Wizard:
1. Module 1,00,00 chapters are now sorted alphabetically.

2. Batch file processing speed has been greatly improved.
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Hyperlink:

1. Conductor NT tag atoms handling has been improved with the implementation of 
tagatoms.txt.

2. Logical operator support in Conductor NT and Process Portal B has been added.

3. A new error message now reports TSTALM blocks that test the same attribute of the same 
block.

4. Tags with spaces in them are now handled properly in Process Portal B Graphics.

5. Correction has been made to re-implement the display of SODG graphic titles in the M14.

6. Hyperlink now generates a report of all CLD and CAD files with layer 5 used. The files 
Layer_5.txt and CADLAYER.DBF can be found in the Exports folder of the project directory.

7. CLIF Block Spec handling has been corrected.

Decomposer:
1. Handling for function code 247, specs 30 and 31 has been added.

Database Utilities:
1. Database records with blank tagnames are now omitted.

2. Text string support has been added for Conductor NT.  We now get the strings for logic states, 
alarm comments, engineering units descriptor and text selection text.

Data Files:
1. Errfilter.cfg updated for new and existing error messages.

2. Output.txt modified for function codes 227, 228 and 229.

3. New file tagatoms.txt has been added to handle Conductor NT tag atoms.
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Version 10.0  March 6, 2006
Wizard:

1. There is now a special override checkbox specifically just for the module header files if 
you have chosen to build in CAD sheets.  If you choose only one MHD to build into your 
project, you must check the  "Single MHD" checkbox before the "Next" button is enabled.

2. If you choose to build in your error files into the final M14, you can now change where 
the actual chapter of error files appears in  the M14.  Turn on the "Show re-order TOC in 
Wizard" option in the "Advanced Options" and in the Wizard, drag-and-drop the error 
files to where you want them to appear in your M14.

BuildPlus:

1. The printing in the "Management of Change - Print Changes" dialog has been fixed.

2. The "Graphics-to-Symbols Associations" have been moved into the "Project Options".

3. The database searching in the "Database Specification" dialog has been improved to provide 
for faster searching when looking for multiple database types.

4. The "F5" key now refreshes the BuildPlus state (the same as the "Refresh" button on the 
toolbar).

5. Support to make multiple database-graphics associations for global symbols has been added.

6. You now have the option to copy the final M14 to multiple locations, instead of just a single 
location, upon the completion of a successful build.  This can be found on the "Processing 
Options” tab in the "Project Options".

7. You can now specify different types of return code checks other than just "equal to" for the 
pre- and post-script processing runs.

8. Handling has been added to support the new DBOPCCSV database utility.

9. If you encounter the "Sort failure due to error 1" during your MediaView compile and you are 
building large database files, we may be able complete the compile with the databases 
processing re-ordered. In the "Processing Options | Advanced Options" check the "Process 
databases in order of descending number of tags" and try building again - it may make the 
problem go away.

10. If error folder archiving is turned on, the name of the folder will now be the same as the M14 
file.  When the "Rename .M14 Document" option under the "Tools" menu is used, the 
associated archived error folder, if one exists, will also be renamed to follow that of the M14 
file.
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11. Microstation drawings (.DGN) are now supported in our Management of  Change processing.

12. At startup, BuildPlus will check to see if the dongle and its necessary drivers are present.  If 
they are not, BuildPlus will bring up a warning and give you a chance to install the drivers at 
that time.  If you want to check driver versions or intall/uninstall drivers, look under the 
"Tools" menu and click on the "Check Dongle Driver..." option.

13. The log created during a buildall has been moved to the actual buildroot in which the buildall 
is occurring (the old location was the Log subfolder of the installation directory).

Hyperlink:

1. Hyperlink now requires that the DBDOC dongle be present before a build can proceed.  If you 
require a dongle, please contact GMCL to get onevsent to you.

2. Output Reference Destinations now are displayed for Composer system localvoutput 
references (references within the same module). An index of unlinked graphics is now created 
to show all graphics that cannot be called by a built-in function from any other graphic.  It 
shows graphics that are orphaned, as well as ones that have been abandoned or never 
implemented.

3. The adapt block target spec value is reported in the case of adapt blocks that are out of 
sequence.  This allows the user to inspect the messages looking for values that have not been 
initialized, a possible problem on switching modules. 

4. External output reference does not exist for IREF "xxxx" now lists the loop, PCU, module and 
block to help you understand where the output reference is  needed.

5. The FC source is now reported for tagged but not exception-reported message to make them 
easier to understand.

6. PV/SIG:S now gets live loop data.

7. Conductor NT has problems with trailing space in file name, so we now report all graphics 
files with spaces in the name.  

8. Lifecycle status is now used in our Conductor NT, Process Portal B and Composer processing.

9. User fonts are now preserved so diagrams are readable.

10. Logical OR operator support has been implemented.

11. Initial support for Conductor 5.0 has been added.

12. PPB and OPC tags are now supported in DBDOC.
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13. We have corrected handling of Spec 4 for Function Code 242.

14. The capability to view the following function codes as a dynamic bar has been added:  21, 22, 
23, 27, 28, 30, 47, 70, 79, 80, 132, 158, 182, 216 and 222.

15. If building graphics, the "Unused on Primary Display" error message now actually cites the 
primary display name.

16. When building Conductor NT and/or PPB graphics, if you forget to specify a colordef.dat 
and/or a fontdef.dat file, we will now use some default color and font data so that your 
graphics will at least appear in your M14.

17. FDF file formats are now supported.

18. Blocks imported from external sources that we report as "No Source Config" are now tagged 
with the phrase "Unconfigured source".  Search for this phrase in your M14 in Hyperview and 
you will be presented with list of all of your unconfigured blocks.

19. In Composer systems, if an OREF does not exist, we will now tag the source with the phrase 
"No OREF". Searching for the phrase "No OREF" shows every place in your system where an 
output reference is needed.

Taglist_exporter:

1. DAANG Blocks now have HALRM handled correctly.  This corrects a problem that 
affected people using the DBDOC tag export for PI systems.

Hyperview:

2. The feature "Go To Output" has been implemented.  After you have used the "Go To 
Source" feature, you can then double-click on the source or select "Go To Output" from 
the pop-up menu to return to the block that you just came from.

3. A fix has gone in to correct the printing done by "Management of Change" from the 
BuildPlus window.

4. The size of the text that appears in annotations can now be changed to suit your needs.
5. You may now modify the color of your text and live loop annotations, as well as any 

manual live loop boxes that you spawn.
6. In the pop-up menu, you now have the option to set the zoom percentage that you want 

the drawing to be zoomed to.  Minimum and maximum zoom factors are taken into 
consideration so that you cannot zoom outside of  bounds.

7. If you have a mouse that has a scroll wheel, you can now use it in conjunction with the 
"CTRL" key on your keyboard to scroll pages left and right.

8. In a multi-IP Address and/or multi-loop live monitoring setup, Hyperview will now do 
some checking to automatically detect which connections are active.  The Hyperview user 
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will not have to know which live loop setups work as Hyperview will automatically detect 
it for him.

9. Specs are now displayed in their own stand-alone windows which can be moved to 
different locations on your sheets if they are obscuring other information that you want to 
see.   The windows are rubberbanded to their original spots so that you can see where they 
originated from.

10. There is a new interface to manage both text and live loop annotations.  Previously, live 
loop annotations could not be found unless they were bookmarked; now you can easily 
find them in our "Manage Annotations" tool.

11. Handling has been added for the case where multiple Hyperviews are viewing the same 
M14 file - text and live loop annnotations, bookmarks, etc. can now be added in any copy 
of Hyperview without wiping out additions in the other open copies.

12. When viewing an analog value as a dynamic bar, the actual value will be shown in a 
tooltip if you put your mouse on the bar.

13. The Hyperview "red boxes" problem has been fixed - this is where Hyperview would 
display red boxes even though it appeared the CIUMon communications were good.  The 
only way to fix this previously was to close down Hyperview and restart it.  We have 
added in handling which should take care of this problem and allow for the live data to be 
displayed without closing and restarting.

14. You can now print just the FC 1 graph in Hyperview without the underlying CAD behind 
it.  The graph will be printed at full-page  size.

15. All FC 1 graphs on a sheet can be opened at one time by selecting the "Graph | All 
Functions..." from the pop-up menu.

16. Live loop annotations can be displayed as bar graphs.
17. The "Go to Source" feature has been improved.

Decomposer:

1. Error messages have been improved to provide more information, such as loop, PCU, 
Module and Block, so that it is easier for you to track down potential problems.

2. Chinese characters are now replaced by a "?".
3. Our Composer processing now looks at the Lifecycle status and handles tags appropriately 

based on the data from this field.
4. Source and destination document names have been added to off-module connections.
5. Function codes 22, 23 and 201 are now being handled correctly.

Database Utilities:

1. DBFMT has been modified so that trailing spaces are compressed in our database 
presentation.

2. DBOPCCSV.exe has been created to handle .CSV files that are extracted from OPC-90.  
These files can now be built into your final M14 by looking for and selecting them in your 
"Database Specification" search in BuildPlus.

3. DBXML.exe has been upgraded.  It now relies on the file libexpat.dll.
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CIULink:

1. Create an export file that allows you to import the tags being monitored in CIULink on 
one machine onto a different computer.

2. CIUlink can now automatically generate a file which can be imported into Microsoft 
Excel to set up live data monitoring via DDE.

3. The tagname is now recorded in the log created when monitoring in Export view.
4. Horizontal scrolling has been fixed in the Debug view.

CIUMon:

1. CIUMon keeps track of the incoming requests and compresses them so that  duplicate requests 
are not sent out to the CIU, thus reducing the load.  

2. CIUMon will send out the information to all those who requested the data  when it receives a 
response back from the CIU.

3. The "F1" key now launches the help file.
4. Spec formatting for the Harmony I/O Function codes (FC 221 to 229) has been corrected.
5. Handling for the NCIU01 type of CIU has been added.
6. Changes have gone in to the correct the reporting of IP fragments by some firewalls.  We now 

correctly handle the sending of the UDP packets between CIUMon and Hyperview/CIULink.
7. The viewing of tracked user statistics has been improved.  On both the  detailed and summary 

dialogs there will an "Update" button which will allow you to get the most current statistics 
without having to close down  and reopen the dialog.  As well, you can switch between the 
two views easily with the "Switch to Details (Summary)" button that has been added.

8. The requestor's IP Address is now appended to the end of the response message being sent out 
by CIUMon so that the user knows where each set of data is going.

9. A new program, CIUMonController, has been created to allow the user to change particular 
options (such as turning on logging) in service copies of CIUMon.  This is particulary useful 
when a CIUMon service is not interacting with the desktop.

10. Handling has been added to work with the Hyperview automatic live loop connection 
detection.

11. CIUMon has had a significant "memory leak" fixed.  The effect was to use a lot of virtual 
memory when CIUMon ran for weeks, which only was recovered when CIUMon was stopped 
or the computer rebooted.

Virtual Port Setup:

1. A new version of the VSP files has been implemented to take advantage of the new features 
and fixes.  Upon the initial running of VirtualPortSetup with these new files in place, you will 
be asked to reboot your machine in order for the files and registry to be completely updated.
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2. You will now be allowed to create more than 9 VSPs on your machine and create up to 15 

virtual connections.  The port numbers that will be available range from COM1 through to 
COM128.

3. The "Physical-to-Virtual Connections" option has been disabled until we can do more research 
into how these connections work.    

Data Files:

1. Errfilter.cfg has been modified to handle new error messages generated by hyperlink.
2. Filetypes.txt and Param.txt have been improved.
3. Output.txt has been corrected for its descriptions for Function code 149.
4. Bitmaps are now included in the search for PPB/Operate IT/Conductor NT submodels and 

will be built if any are found.
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Version 9.81  June 2, 2005

Hyperlink:
1. The displaying of dynamic bars with live loop monitoring has been fixed.

CIUMon:
1. CIUMon has been modified to handle the text specs found in function codes 221 through 229.

CIULink:
1. Missing code has been patched in to handle the IP_BLOCKED messages sent back from 

CIUMon.  This is a concern only if a particular IP Address has been marked as blocked in the 
CIUMon options.
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Version 9.80  April 25, 2005

Wizard:
1. When BuildPlus cannot suggest a search path for a particular filetype, the search path in 

Wizard is left blank instead of being filled in with the default "C:\".  This prevents the 
searching of the whole hard drive if the user fails to remove the default when browsing for the 
correct location as the new path will get automatically appended to the existing search path.

2. The option to select DGN files to include in your project has been added. When the "Apply" 
button is pressed to change search directories to match that of the main search path, the 
changes will not be applied to any filetype that refers to the special "Decomposer" directories 
created in  the project directory for Composer projects.  This is to safeguard against the 
accidental override of these preset search paths for particular types of files and to ensure that 
the user will find the correct files to build in to the project.

3. For the xdc files and colordef.dat and fontdef.dat files, the selection has been automated more 
if only a single folder-single file is found for the listed filetype.  The file will be automatically 
chosen to be included in the build so that the user does not have to do any extra "clicking".

BuildPlus:
1. The Database-Graphics Associations have been improved to allow for multiple associations to 

be done for global graphics paths.  This allows the user to build the graphics against multiple 
different consoles.

2. When the user is running with the programs and files from the Overrides directory, this setting 
will be indicated in the error files so that the user knows that he is not building with the 
original build kit.

3. DBSpec.vbs is now triggered to run for all builds.
4. There is now a "Recent Projects" option under the "File" menu.  This allows you to easily 

switch between the current projects that you are working on.
5. A "Refresh" button has been added to the toolbar so that the menus, toolbar button states and 

project settings can be updated with a push of a button. This is particularly useful if you are 
running multiple copies of BuildPlus at the same time.

6. BuildPlus now ensures that the extracted databases all have unique names to avoid conflicts 
with later processing in DBSpec.  As well, any extracted database that contains a '.' in their 
name will have it replaced with an '_'.

7. If Batch files are being included in a build and there are multiple UNT files being associated 
to one B90 file, then BuildPlus will create a clone of these files in the project directory in the 
"BATCH" subfolder.  As the same batch file gets built multiple times into the M14 because of 
the multiple UNT files, this ensures that each instance of the B90 has a unique URL
reference in the M14.

8. The build logs for the project have been moved to the "LOGS" folder located in the project 
directory.  The Management of Change files have also been moved into their own "MOC" 
folder in the project directory.
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9. Ladder modules are now included in the "Duplicate Module Header" resolution as it would 

wrong to build the same module for both Ladder and CAD.  This will force the user to choose 
the correct module to include in their build. Additionally, general improvements to the 
"Duplicate Module Header" dialog have been made to make the module selections easier.

10. When starting a project from the "Build" button, BuildPlus will now check to see if new 
SODG graphics folders have been added to the original search path for graphics (specified in 
Wizard).  If any are found, they will be presented to the user to allow him to choose whether 
or not he wants to include them in the project at build time.  This functions in much the same 
way as the "Auto-Detect New Module Headers" feature.

11. BuldPlus now writes a summary of the types of filtered errors from the hyperlink run and the 
number encountered of each type into the DBDOC.ERR, DBDOC_RESIDUAL.ERR and 
DBDOC_SUMMARY.ERR files for ease of reference.

12. BuildPlus will check to see if an Access database is created by Access 97 before carrying out 
any database processing as our database utilities do not handle Access 2000.  If the database 
does not meet our Access requirement then the user will be informed of this and it will not be 
included in the build.

13. The detection of a different version of MCRSize.dbf will now trigger a full decomposer run 
for all Composer projects.

14. The "Decomposer Directory Source" window is now an independent window that can be kept 
open while you perform other operations in BuildPlus.  This allows you to refer to it without 
having to memorize or print out the information if you need it to make the correct choices in 
some other project option.

Hyperlink:
1. Code has been implemented in order to facilitate the launching of the Graphics Cross-

References in its own separate floating window.  This change is made in conjunction with 
changes made in Hyperview to accomodate this new feature. (See Hyperview #1)

2. Titles are now limited to 128 characters in order for Mediaview Compiler to accept them.
3. Sizing of data for continuous live loop monitoring on Conductor NT graphics has been 

corrected so that it is consistent.
4. Hyperlink will check for incorrectly set spec 20 on FC 177 as this spec means there will not be 

an alarm when there possibly should be.  A message will be outputted to warn the user of this 
condition.  The message is suppressed for multilevel alarming if none of the delta values are 
valid.

5. Overlapping External Block definitions are now handled.  These changes are made in 
conjunction with changes in Hyperview in order to accomodate this feature.  (See Hyperview 
#2)

6. Hyperlink generates three unused tag reports - Unused_tags.txt, Unused-alarm_tags.txt and 
Unused-unconfigured_tags.txt.  The tags are separated into different categories for easier 
analysis by the user.  Note: The Unused-alarm_tags.txt takes into account the alarm limits 
before the tag is reported as an alarm tag; otherwise the tag will just be reported in 
Unused_tags.txt.

7. Various fixes have gone in to handle FC 156 and FC 136.
8. Tags that are not on their primary display are now being reported.
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9. Hyperlink will report tagnames which contain a '/' in them if they are PCView as such tags are 

illegal in PCView.
10. Support has been added to implement the "View As Dynamic Bar" feature in Hyperview. (See 

Hyperview #4)
11. New support has been added to handle the processing of DGN files.
12. Support for AutoCAD 2004 has been added.
13. A new directive to strip off prefixes on tags in Wonderware databases has been added. In the 

"Custom Edits" in BuildPlus, add the directive "wonderware_prefix" followed by the 
prefix(es) that should be stripped off.  This will allow for the Wonderware tags to sort with the 
Bailey tags in the tagmap presented in Hyperview.

14. The orientation of vertical text on Conductor NT graphics has been fixed.  This fix is good on 
Windows NT platforms but will not work on Windows 9X.

15. Trend configuration and historical database tags are now getting linked to correctly in the 
xdcdump file.

16. There are improvements in drawing Conductor NT graphics.
17. Additional support for new tagatoms has been added.
18. The number of rung blocks in ladder files reported in our summary files has been corrected.
19. Conductor NT graphics can now be called up by number.

Hyperview:
1. The Graphics Cross-Reference are now presented in its own separate floating window -  

allowing the user to position the window where he wants and to keep all of the cross-
references in front of him while moving between different graphics in the M14.

2. Overlapping External Block definitions are now handled.  For example, you can have Loop 3 
declared as external and able to fetch live data and then specify Loop 3 PCU 4 Module 2-All 
Blocks as not being accessible (these specifications are declared in BuildPlus).  Hyperview 
will handle the blocks appropriately, sending out data requests or suppressing them, as 
specified by where they are defined  in the range.  These changes are made in conjunction 
with those in Hyperlink in order to accommodate this.

3. You can now search for tags in the "Define Live Loop Annotation" dialog with pseudotags, 
scanned tags or other aliases.

4. Display any data as a dynamic bar graph whether it is binary or analog.  Choose "View As 
Dynamic Bar" from the pop-up menu, where available, to show the value, the LPMB 
information and the span of the data value.

5. The graphing of Function Code 1 has been corrected where the last point was getting missed.
6. Live loop monitoring boxes on ladder files have been fixed so that they are the correct size.
7. The new command line switch MonitorOff allows the user to specify that live loop monitoring 

be turned off after a given interval (in minutes).
8. The "Manage Bookmarks" dialog is now sizable and its settings retained between runs of 

Hyperview.
9. Support for DGN files has been added (in conjunction with Hyperlink).
10. Bitmaps on Conductor NT graphics now get printed when the graphic is printed.
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Decomposer:
1. Work has been put in in order to enable the faciliation of the floating cross-reference in 

Hyperview.  (See Hyperview #???????)
2. Decomposer translates the EBY name into the appropriate user name or CAD name for easier 

reference by the user.
3. A problem where Decomposer "got lost parsing" a client CLD file has been resolved.
4. Corrected macro size for FC 51.
5. The handling of FC 21, 22 and 23 spec position has been corrected.
6. SYMEMPTY.DBF has been modified to handle up to 64 character long names.  This gets rid 

of many of the "Unknown shape" errors being reported previously.

Database Utilities:
1. Our visual basic scripts have been modified to set the locale to "en-us" in order for processing 

to occur correctly when operating on systems with differently set locales.
2. Tags that are specified Module 0,00,00 Block 0000 are not included in our TD_NOLIST when 

it is extracted with our DBSynth program (for FoxPro databases).
3. New database templates have been included for our TTX2DBF processing (for TTG,TTR  

databases).

CIULink:
1. Save the users view preference to the registry so that CIULink opens up to that view on start-

up.
2. There is a new option under "Tag Monitoring" that allows you to specify the number of 

significant digits that get displayed in Export view.  This allows you to display the data in a 
format that makes the most sense to you.

3. A fix has been added to correct the display when monitoring in CIULink and Excel at the 
same time.

4. The interface to set the frequency at which data will be requested has been improved.

CIUMon:
1. A new option - "Modify Service Properties" - has been added for the CIUMon service 

handling.  This provides the user with an interface with which they can modify the settings of 
their CIUMon services without actually having to access the Service Control Manager.

2. There is now an option of adding on a watcher service to your regular CIUMon service. This 
watcher service will continually check to make sure that the CIUMon service is running and if 
it is not, restart it automatically for you.

3. CIUMon gives the user the option of keeping track of user statistics.  With this option turned 
on (located on the "Logging" page of the CIUMon options), CIUMon will keep track of who 
is requesting data, what data is getting requested, the number of requests and the first and last 
time of the requests.  You can then view these statistics by selecting one of the new 
"Communication Statistics" options available under "Options".

4. There is a new option to display the IP Address of the requestor; this will be appended to the 
end of each request.  This gives the DBDOC Administrator a quick check of who is requesting 
data.  This option cab be turned on or off on the "Logging" options page.

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 97 of 156



 DBDOC Release Notes  
5. Contextual help has been added to all dialog boxes.
6. A fix has been added to correct the problem where some clients would see the VSP 

splashscreen appear continuously when CIUMon was started up.  This problem was due to a 
missing dll on the system required to enumerate to running processes; a message box will now 
appear to report this condition and the "flashing" splashscreen should no longer occur.

7. A tool has been created, VSPCleanup.exe, that will wholesale remove all traces of virtual 
serial ports on a computer when there appears to be a problem removing them through the 
regular VirtualPortSetup application.  This program is located in the "Programs" folder of 
your installation location.

8. General clean-up of memory leaks.

DataFiles:

1. Errfilter.cfg has been modified to handle new messages generated by Hyperlink.
2. Filetypes.txt has been changed to:

a) Include ladder modules in Duplicate MHD resolution dialog
b) support DGN files
c) automatically select all folders in SODG graphics, B90, AutoCAD, Microstation, DXF, 

RTF and Other files
3. Param.txt has been modified to:

a) support DGN files
b) support new appearance/categorization of filetypes on initial panel of Wizard

4. Output.txt has been modified to correct a problem on FC 136 (Output N+3 was specified as 
binary, not real).
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Version 9.70  October 22, 2004

Wizard:

1. "Back" button response during the search phase has been improved.
2. The ability to select folders with a "." in the name has been enabled.
3. A "Disable" checkbox has been added to the "Root Directory" in the main path specification 

panel.  This checkbox will be set and the Root Directory combo box will be grayed out if 
the user has specified any database(s) in the BuildPlus Project Specifiction dialog.  This is 
to prevent the inadvertent application of the general root directory to the "calculated" 
locations of the user's source files (such as Decomposer1 subfolders, etc.).  It is at the user's 
discretion that this checkbox can be unchecked and the prescribed file locations can be 
overridden with the Root Directory suggestion.

4. "Browse and Add" - Wizard now behaves like the BuildPlus Project Specification browse 
where new paths are added onto the existing list in the edit box.  This means that you no 
longer need to go through the copy-browse-paste sequence in order to retain any previously 
entered paths in the edit box after doing a browse.

5. Concatenated paths now appear in the combo box lists.
6. The folder containing ANALOG1.DY for Bailey Standard Symbols is automatically 

selected.
7. All user symbol psths (not containing ANALOG1.DY) are automatically selected for 

SODG processing.

BuildPlus:

1.  Support for CITECT and .TTG/.TTR databases has been added.  You can now specify
    that CITECT and TTG/TTR databases be included in your project - simply look for
    them under the "Generic" database category in the "Database Specification"
    dialog.
2.  BuildPlus support has been added for our taglist_exporter application.  A new 
    dialog box will appear where you can choose which databases you want to have
    taglist_exporter run on.  These database choices are also shown on the "Project
    Options | Taglist Exporter" page.  Chosen databases will be run through our
    taglist_exporter application which will generate an appropriately named dbf that
    will contain a global taglist.
3.  On existing projects, when a user starts the build from the "GO" button, pre-
    existing project information is retained rather then getting cleared.
4.  The "link_slave_references" directive has been added to the list of default
    suggestions on the "Custom Edit" page of the "Project Options".  For new projects
    this directive will be automatically enabled; if you wish to take advantage of
    this feature in existing projects simply go to the "Custom Edit" page, select
    it from the default list and click the "Insert" then "OK" buttons.  Enabling
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    this feature allows the creation of a class of tags from the reference text on
    slave function blocks.
5.  A new feature to export and import a project has been implemented in BuildPlus.
    These options are available under the "Tools" menu.  When you choose to export
    a project BuildPlus will create a .BPI file that it can use to import the project
    on a different machine (or same machine, different location).  The file contains
    information regarding the registry settings for the current project, selections
    from the Configuration Wizard and project .RAW file information so that there
    should not be any need to specify anything when the project is imported.  This
    option is best used in conjunction with a project that has used UNC naming
    conventions when specifying source file locations.  You can then utilize the
    Import Project option to recreate a project from a BuildPlus generated .bpi file.
    To find out more about these new options, please look at our help documentation
    under "BuildPlus | BuildPlus Menus and ToolBars | Tools" and select either
    "Export Project" or "Import Project".
6.  The ability to rename, clone or move a project has been implemented.  You can
    access the first two options two ways.  Launch the Database Specification dialog
    (press the "GO" button) and change the name that appears - BuildPlus will bring
    up a dialog to see whether you want to rename your project, clone your project
    or retain your old project name.  The other way to get to these new options is
    from the "Tools" menu where you can choose to "Rename Current Project..." or
    "Clone Current Project...".  Both of these options will bring up a dialog box
    which lets you enter in a new name for your project.  To move a project, you can
    choose the "Move Project..." option from under the "Tools" menu where you can then
    choose the new build root and, optionally, new project name that your current
    project should be moved to.  To read more about these new options, please look
    at our help documentation under "BuildPlus | BuildPlus Menus and ToolBars |
    Tools".
7.  For Composer projects, the CLDNames.map and DisplayNames.txt files are now named
    uniquely.  The CLDNames.map name will be based on the EBP file name and
    DisplayNames.txt will use the description found in the console.cfg file as part
    of its name.  This fixes the multiple-cldnames.map-files-with-same-name-in-one-
    chapter problem.
8.  A general "clean up" of resource and memory leaks.
9.  The Management of Change tool to display and print differences between builds
    has been changed.  On the "Management of Change" page of the "Project Options"
    the treeview of changes does not automatically appear as part of the page 
    any longer.  You can choose to see/print the changes by now pressing the "Show
    Changes" button at the bottom of the page which will trigger BuildPlus to
    generate the treeview of changes in a separate dialog.  This will benefit those
    who are not interested in seeing/printing changes at the moment as the treeview
    of changes may take a few minutes for BuildPlus to set up depending on the number
    of builds compared and differences found; this way the user will have access
    right away to the Management of Change options.
10. When rebuilding Composer projects, old versions of user and standard symbols
    and global graphics are deleted from our extracted set of files so that they
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    will not be included in the current build.
11. The method of defining blocks with external sources has been improved.  Users
    now have the ability to define a whole Module, PCU or Loop with external sources
    without having to define the specifics for each Loop, PCU, Module and Block field
    on the "Define Blocks with External Sources" page of the "Project Options".
12. Initial support for a single XDC dump has gone in.
13. The DAO SDK is required to be installed now for all CAD/LAD and PI.XLS builds.
    If BuildPlus detects that DAO is not installed, it will automatically prompt you
    and ask if you wish to install it at that time.  For the most part, you should
    choose to do the installation to ensure that your build will complete
    successfully.
14. More robust handling has been added to handle the case where the build computer
    does not have access to the computer with the source database files after the
    build has started.  If you are doing a manual build and a source file was not
    found then BuildPlus will bring up a warning dialog box which allows you the
    time to logon onto the remote computer (or insert the CD into the drive) and
    try again or to stop the build.
15. If a new version of our DBType program is detected, then all generic DBF type 
    databases will be rerun through it so as to reclassify any databases which may
    now be handled by a new type of processing we have implemented.
16. A list of new tags that were found to have been added since the previous build
    is now created by BuildPlus and listed in the file new_tags.txt located in the
    "Exports" folder of the project directory.
17. The functionality of the "Symbols-to-Graphics Association" dialog has been
    improved when launched during an in-line build.  The selected set of symbol paths
    is retained when moving on to the next new path.
18. When BuildPlus performs its missing and mismatched program/file check, it now 
    performs an additional CRC check to make sure that the installation did not in
    some way corrupt the file.  This error will be clearly indicated in the program
    summary (at the end of DBDOC.err and DBDOC_Summary.err or contained in
    DBDOC_Components.txt) if a CRC mismatch was detected.
19. The process priority level of non-GUI programs and the MediaView compiler is now
    set to the "Below Normal" by default for those who run BuildPlus for the first
    time.  This option is located in the "BuildPlus Options" if you wish to change
    it.
20. The "Project Settings and Selections" dialog is now resizable.  The settings
    are saved so that the next time the dialog is launched it will open up to the
    last used dimensions so that you do not have to continually resize the dialog
    to suit your preferences.
21. All log and system information files are now placed in the Logs folder (sibling
    to the Programs folder of your installation directory).  These files include the
    logs created during a buildall run and DBDOC_Components.txt generated from under
    BuildPlus's "Tools" menu.
22. The error.zip (or error.tgz) file is now located in the ERROR_FILES folder of
    the project directory.
23. The option to the automatically create the error.tgz at the completion of a

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 101 of 156



 DBDOC Release Notes  
    build has been added to the "BuildPlus Options".  By default, this option is
    check when BuildPlus is run for the first time with this option included.
24. The ciumon  settings are now correctly reported in the error files for the user's
    information and review.
25. The option to launch Hyperview without having a current project open has been
    added under the "Tools" menu.
26. A new option to go the GMCL help website has been added under the "Help" menu.
27. The obsolete option "Create Desktop M14 Shortcuts" in the "BuildPlus Options"
    has been removed.

Hyperlink:

1.  CITECT console databases are now supported.
2.  Hyperlink handling has been added to put in the functionality of displaying
    live loop analog values as bar graphs when live loop monitoring is turned on in
    Hyperview.
3.  Support for bitmaps as documented submodels for Conductor NT graphics has been
    added.
4.  CLIF functions are now fully supported.  These are a custom set of function codes
    that use INFI-90 function code numbers with custom implementation.
5.  Hyperlink now checks for duplicate slave addresses.  This is preliminary work to
    detect slave configuration problems.
6.  Attributes are only displayed above exception-reported blocks.  If a tag refers
    to a block that cannot work, we do not show the bogus tag name above it.
7.  FC 36 test is suppressed if there are no inputs and no outputs.  8-input OR blocks
    that are unwired do not need to generate a message.
8.  The IREF and OREF Text is used as scanned tags if no other information is available.
    This new feature, triggered by the link_slave_references directive in the custom
    edit box found in BuildPlus, creates pseudotags out of input and output references.
    This can improve linking to AutoCAD and MicroStation drawings and other tabular
    data.
9.  XDCdump "block" information is now supported.  This support has been added for
    Conductor NT xdcdump "block" information that defines a set of history tags as
    being in one block of data that can be fetched.
10. Direct support for single xdc dump files has been added.  This will handle all
    the xdc file linking and checking using a single file generated by a command
    line like "xdcdump all.xdc" to make support of Conductor NT systems easier.
11. A fix has been implemented to correct a problem where the tags were not showing
    up in the audit window on CAD sheets.
12. The PCU Map support has been enhanced to show all the blocks that are imported 
    from each PCU and all those that are exported from it.
13. Hyperlink will report the number of PCUs and Modules actually configured.  This
    feature will help us guide people who are contemplating adding Serial Port 
    Modules for DBDOC data support.
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14. FC 1 F(x) functions that are discontinuous are reported for inspection.
15. The limits for FC 68 is checked.  REMSET blocks that have a value outside the
    configured limits are reported.
16. Improvements in defining blocks with external sources have been implemented.  
    This works with the latest BuildPlus - refer to #11 in the BuildPlus section of
    the release notes.
17. A diagnostic file has been created for F(x) messages.  The new file, FC001.txt,
    will be created when there are out of order X coordinates, adapted coordinates
    or discontinuous functions to make it easy for us to explain the messages to you.
18. The flat function F(x) messages have been enhanced to show the constant value
    in the message.
19. Alarm Group Zero handling has been corrected.  The case where a tag is defined
    in more than one database but is in a non-zero alarm group in only one of them
    is now being handled properly.  We assume that it will alarm in the console
    using the database where the alarm group is not zero.
20. Hyperlink will now generate a message if the tagname and the tag index in a 
    graphics element do not match.  This for support of old MCS/OIS SODG Graphics.
21. Hyperlink will report modules that have a problem if there is no input attached
    to some blocks.
22. We have corrected checking of the input type for FC 220.
23. Hyperlink checks for duplicated slave channels and now accepts remote I/O functions
    that can duplicate the apparent slave channel.
24. Hyperlink link will translate S4 set to 0 on DAANGI/L and DADIGI/L blocks to
    mean "this loop".
25. When databases contain over 32767 records, hyperlink will create a new file RTF
    file to break up the entries so that we do not encounter problems later with the
    Mediaview compiler limits.
26. Hyperlink will generate a file named Unused_symbols.txt that will give you a list
    of the symbols that are not used in any of the graphics that you built.  Popups 
    will be of special interest as they are difficult to keep track of.
27. TAGTYPEs SPARE and OTHER are now created by Hyperlink.  These can be used, for
    example, for artificial tags created from RTU files.
28. SODG graphics processing has been modified to use the file length information
    included in the header of a DR file, thus preventing non-local exits introduced
    by graphics that have record fragments after the last valid record.
29. Two new databases are generated in the Exports folder of the project directory -
    TAG-GRAPHICS.DBF and GRAPHICS-TAGS.DBF.  These databases will contain information
    about which tags are in which graphics and which graphics contain which tag.
30. Ring (Loop), PCU  and Module information stated explicitly in B90 files will 
    override any other LPM specification for that particular line.
31. B90 comment colors in the M14 file have been darkened to make them more visible.

Hyperview:

1.  Live loop analog values can now be displayed as bar graphs for quick analysis.
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2.  The new feature "Recent M14 Files" has been added under the "File" menu which
    will list the last 4 M14 files that were viewed in Hyperview.  You can use this
    option to quickly navigate between the last few M14 files that were opened.
3.  The Table of Contents can be sized down completely so that the Topic pane takes
    up the full Hyperview window.  You can: (a) manually drag the splitter bar until
    the TOC pane disappears, (b) choose the "Full Screen" option from under the "View"
    menu or (c) press the "F" key on your keyboard.  The latter two will allow you
    to toggle between having both panes displayed and just the Topic pane.
4.  Reverse video on the Block Map has been suppressed if Vegas Lights have been
    turned on.  This is due to the fact that color is meaningful on the Block Map.
    If Vegas Lights are turned off then the reverse video will be in effect.
5.  External blocks with no source did not function correctly on text files when 
    live loop monitoring was turned on or with live loop annotations in previous
    versions.  This problem has now been fixed.
6.  The live loop annotations file (.ahb) is now updated after a live loop annotation
    is created as opposed to at the end of the Hyperview run.  This is for the 
    situation where Hyperview exits unexpectedly in which case the newly entered
    annotations would not be saved for the next run.
7.  A fix has been put to correct where Hyperview would crash on Windows 98 if the
    color depth was set very low.
8.  The ability to refine a full text search has been added to the search results
    dialog.  Click the "Refine Search" button at the bottom right hand corner of 
    the dialog to bring up the search dialog again, filled in with your previous
    settings for easier modification.
9.  Inconsistent live loop monitoring behaviour on Conductor NT graphics has been
    resolved.  The symptom would be that not all live loop hotspots would appear when
    live loop monitoring was turned on and that turning off and on the monitoring
    could result in different hotspots showing up each time.
10. A problem where using the snapshot button did not always get data when certain
    steps were followed has been resolved.
11. The problem with rung blocks continuing to monitor after live loop monitoring
    has been turned off has been rectified.  As well, unpredictable behaviour that
    was discovered when monitoring ladder files has been fixed.
12. Live loop annotations are now minimized and maximized along with the text 
    annotations when the "Minimize All Annotations" and "Restore All Annotations"
    options are selected from the pop-up menu.  As well, the minimized live loop
    annotations will no longer continue to fetch live data until they are restored
    thus reducing the load on the CIU.
13. The live loop update interval now allows for fractional seconds to be entered,
    up to 3 deciminal spots.
14. When you hover over a database name in the Databases chapter in the index, the
    data tip will show the database name and the source that it came from.
15. In TreeView Table of Contents the external modules are now indicated in blue.
16. When a search is performed and no search results are found, a dialog box will 
    appear reporting no matches were found.  It will have a "Don't show me this again"
    checkbox that will allow you to suppress this message box from appearing again
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    when no search hits are encountered.  You can reset this option by checking the
    "Reset to show all suppressed dialogs" option on the "View" page of the "Options".
17. When a bookmark is added via the keyboard shortcut, Ctrl-D, a message box will
    now appear informing you that the bookmark was successfully added.  If you wish
    to suppress this message box from appearing on subsequent additions, check the
    "Don't show me this again" checkbox before clicking the "OK" button to dismiss 
    the dialog.  To reset this, check the "Reset to show all suppressed dialogs" on 
    the "View" page of the "Options".
18. The command line argument /m1 (for Conductor graphics) and /dr, /dis (an alias
    for the /dt argument) have been added.
19. The command line switch /tag has been modified to bring up the CAD source in the
    Topic pane in addition to the index panel in the Table of Contents pane.  If there
    is no source, only the index panel will be called up with the Topic pane containing
    the previous historical document.
20. Switching from demo data to real live data has been fixed.  Previously, you
    needed to restart Hyperview after removing your demo settings and entering in
    your real live loop settings before you would actually get real live data.
21. When "File | New Window" is used, the new Hyperview that is launched will adopt
    the same command line switches as the first Hyperview.    
22. The option to change the stale data text color to white has been added.  This
    is found in "Options | Color Scheme"; by default, the "Use White Text for Stale
    Data" is checked.
23. The "Mark Topics for Printing" interface has been improved.  The option to print
    both general and annotated topics has been added.
24. Creating an identically named bookmark is no longer permitted.
25. It is now possible to open up Hyperview in TreeView Table of Contents mode.  The
    view style is saved when Hyperview is closed so that the next time it is opened
    the user does not have reset it to suit his preference.
26. "Go to Block Map" has been added to the pop-up menu and will be enabled on any 
    CAD sheet.  If you choose this option while the mouse is on a specific block,
    the topic pane will display the specific block map page and the TOC pane will
    display the module block map page.
27. Live loop logging formatting has been improved.  The options of "Log Specs" 
    and "Log only good quality values" have been added to allow the user to more
    precisely define what is getting written to the Hyperview log (available on the
    "Options | View" page).
28. The validity of the live loop logging path (specified on the "View" page of the
    "Options") is no longer checked if the option to log data is turned off.
29. A link to the GMCL Help website has been added under the "Help" menu.
30. If at some point you have chosen to "Reset Preferences to Defaults" and close
    down Hyperview, Hyperview will automatically do a "Restore Preferences" before
    exiting.  If Hyperview does not exit cleanly then the restore will be performed
    when Hyperview is next opened up.
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Decomposer:

1.  A wiring problem that Composer misses will be detected by DBDOC (FC 227 and 228
    S3 requirements).
2.  A problem was discovered where not all SODG symbols were getting extracted in
    Composer projects and has been resolved.

Database Utilities:

1.  A new database utility DBSpec.vbs has been created.  This will add links to the
    various tag dbf files that we have made in spec.mdb.  
2.  The DBType application has been modified to detect CITECT console databases.
3.  A new application taglist_exporter.exe has been created which will create a
    master list of all tags in the system.

CIULink:

1.  A new feature to save, load and delete separate tag lists has been added.  This 
    allows you to switch quickly between lists of tags without having to manually 
    delete and re-enter the desired points each time you want to look at frequently
    monitored, unrelated points.  These lists are saved so that they available to you
    on subsequent runs.
2.  A status bar has been added to the top of the CIULink window to inform the user
    of the latest CIULink status.  The status bar will indicate the following:
    (a) whether or not monitoring is turned on or off
    (b) the frequency at which the updates are being done
    (c) whether or not logging is turned on or off
    (d) the size of the current log and the maximum size allowed
    (e) the name of the log file
3.  A monitoring problem on Windows 98 and NT was fixed where monitoring was blocked
    for valid data points which did not have an assoiciated database entered in
    for verification.
4.  General "clean-up" of memory and resource leaks.
5.  You can now limit the size of the log that is created by CIULink.  Choose "Set
    Log Size Limit" from under the "Tag Monitoring" menu to specify the maximum 
    allowable size of the log.
6.  CIULink settings and preferences that were previously stored in the CIULink.ini
    file have now been converted to be stored in the registry.

CIUMon:

1.  The ability to add CIUMon as a service has been implemented.  This will allow you
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    to specify the launching of CIUMon with a certain configuration after the computer
    has been rebooted without any manual intervention.  This will be of great
    benefit to those users who have CIUMon running a remote central server - this 
    will guarantee that CIUMon will restart even if a person reboots the machine without
    any knowledge of CIUMon or DBDOC.  Multiple instances of a CIUMon service can be
    added to handle more than one CIU on one computer (ie. multiple SPM02-type CIUs).
    To read more about this new feature, look at our help file under "CIUMon | 
    CIUMon Toolbar and Options | Options... | CIUMon As A Service".
2.  Handling of the SPM01 type CIU has been implemented.
3.  Logs created by CIUMon and VirtualPortSetup are now placed in tbe Log folder of
    the installation directory.

DataFiles:

1.  Errfilter.cfg has been modified to handle new messages generated by Hyperlink.
2.  Filetypes.txt has been changed to:
    (a) handle bitmaps as documented submodels
    (b) select all user symbols by default in SODG processing
    (c) update the contextual help in Wizard
3.  Output.txt has been modified to correct a wording problem on FC 30.

CrypKey:

1.  The version of CrypKey has been upgraded to version 6.120.  This version
    includes "clone buster" technology.
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Version 9.61  May 17, 2004
BuildPlus:

1.  Correct issue for AutoCAD customers running programs out of the Overrides
    directory.  The correct Adinit.dat file was not being properly replaced in
    the run.

Hyperlink:

1.  Ensure trend database index is recorded for use in database search in 
    Hyperview.

Hyperview:

1.  Re-enable live loop monitoring on Function Code 1 graphs (timer identity
    issue).
2.  Correct multiple live loop snapshot monitoring problems.  Snapshot will
    now reset on drawing change.  For both snapshot and continuous data
    monitoring, reset timer interval whser first requests monitoring so
    that data fetch begins almost immediately.

CIUMon:

1.  Fix CIUMon continuous retry on connect until succesful reply from the CIU.

Data Files:

1.  Errfilter.cfg has been modified to remove soft hyphens which were
    inadvertently introduced in the document conversion.
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Version 9.60  April 16, 2004
Wizard:

1.  Fixed infinite loop that prevented FINISH button from being enabled.  This
    occurred in cases where a Conductor NT console was being built with its
    source files on more than one machine.

BuildPlus:

1.  A new option has been added on the "Processing Options" tab in the 
    "Project Options" that allows the user to specify Hyperview's local port
    range that is available to bind to in order to communicate with CIUMon
    to fetch live data.  The port range information is written into the 
    baggage file from which Hyperview will read it and bind to the first
    available port in the range.  This option is useful for those who must
    communicate through a firewall and only have specific ports left open.
2.  The "Define Blocks with External Sources" option has been modified to
    make the definition of entire external PCU's and Modules easier.  As
    well, there is an additional option which allows the user to specify 
    whether or not live data can be fetched for the particular external range
    specified.
3.  Multiple tag lists are now extracted out of Process Portal B Access
    database if applicable.
4.  Any files that are produced as a result of database processing on an
    Access database are now placed in separate folders in the project
    directory based on which database they were extracted from.
5.  Multiple tag databases can now be associated with a particular SODG 
    graphics path to get the correct links built in.  Additionally, SODG
    symbol paths have been added to the "Database-Graphics Association"
    panel to allow for database associations.
6.  A new option "Database Selections" has been added.  This allows the user
    to exclude any databases that were extracted from .EBP, .MDB, .PTT and .XLS
    databases that may not be pertinent to the current build.
7.  There is an option to build in the current error files into the M14. This
    is available in the "Advanced Options" on the "Processing Options" page.
8.  BuildPlus will run the program DBSpec.vbs after each hyperlink run to
    automatically generate an MDB with links to the exported FCnnn.DBF 
    files located in the "Exports" folder of the project directory.
9.  Management of Change has been modified to only insert a summary line
    when whole modules or databases have been added or removed from a build.
    This will cut down on the size of the reports.  Additionally, the "moc"
    qualifier has been added to the appropriate lines in the project files
    to speed up the hyperlink processing of the Management of Change files.
10. The file modification times have been removed from the M14 Table of
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    Contents.
11. The Sub-Process message window is now minimized during the Decomposer
    and Hyperlink runs on laptops to minimize CPU time.
12. For RTU processing, Loop, PCU, and Module information that can be parsed
    from the filename or folder name will now be used.
13. The "DBF and MDB Types Detected" dialog box that appeared after the 
    "Database Specification" dialogs has now been removed.  The database
    categorizations can still be viewed in the "Project Options" on the "DBF
    and MDB Types" tab.  Note: BuildPlus will try to categorize any
    databases placed in the UNKNOWN category on each build/re-build so that any
    database that may have been previously "broken" and subsequently fixed
    will be automatically included in the new build.
14. The .bmk, .ann and .hist files are no longer deleted for a project when
    starting a build from GO.
15. The "Rename" button (Cat-to-Dog) has been removed from the toolbar and 
    the option added under the "Tools" menu option.
16. If there is only one M14 present for a project, BuildPlus will automatically
    launch Hyperview at the completion of the build, open to that M14.
17. The failure to launch Hyperview at the completion of a command line build
    (one specified with the /build switch) on Windows 9X and NT 4.0 has
    been fixed.  As well, at times, BuildPlus would crash on the launching
    of Hyperview after a build from the command line with the /build switch -
    this has also been fixed.
18. New command line functionality has been added: /start, /fullcycle,
    /exclude and /override.  The switches /start, /fullcycle and /exclude can
    be used in conjunction with the /buildall switch.  /start allows the user
    to specify which project to begin the buildall with; /fullcycle, specified
    with the /start switch, tells BuildPlus that once it has reached the end
    of the list of known projects, it should restart at the beginning and build
    all projects until it hits that one specified with the /start switch.  The
    /exclude switch allows for the exclusion of a full build root from the
    buildall cycle.  /override tells BuildPlus to use the programs and
    files that currently reside in the Overrides directory for the current run.
19. If the Microsoft WinDiff tool has been installed on the computer, the
    option "WinDiff Files" under the "Tools" menu will be enabled so that 
    WinDiff can be utilized to find differences between error files or folders.
20. Database selection dialogs now show the number of records available in
    each database.
21. The option to stop a build after a pre-processing script failure (user set
    option in "Processing Options") has been added.  One can also specify
    the success code that should be returned from the script so that
    BuildPlus can verify the success or failure of the script run.
22. BuildPlus will automatically open up to the last opened project on
    startup.
23. On the "Processing Options" page in the "Project Options", there is now
    an option available to specify a location to which to copy the final
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    new M14.  This has been implemented to make it easier for the builder to
    get the new M14 into the location where it can be accessed by all users.
24. The CIUMon entries are now listed in DBDOC.ERR for ease of reference.
25. The BuildPlus status bar has been modified to show the time and date
    in the right-hand field.
26. The PI Point Source defaults have been modified to include POINTSOURC,N.
27. The Build Kit version information is now available in the "Help"-"About"
    dialog box.

Hyperlink:

1.  Tags that are not on any graphic are reported in two files.  Tags which are
    not found in Alarm Group and we think should alarm, but are not on any
    graphic, are listed in the file Alarm_Tags.txt.  Unused tags are all other
    tags that are not on any graphic and are reported in unused_tags.txt.  The
    tagtype information is also included in this file.
2.  Tag and data import checking has been implemented.  Tag and block inputs
    are being checked for type and that they come from exception report blocks
    as necessary.
3.  Function code 1 F(x) support has been further improved to show discontinuities,
    out of order coordinates and to make allowances for rounding problems.
4.  Trend support for Process Portal B and PCView graphics has been improved.
    We also export the trend tagname in the function code spec extraction and
    show the trend tagname in Hyperview.
5.  It is now reported if a gain value of zero is found that masks an input
    value or constant.
6.  A warning is now given for slaves that will trip on fault.
7.  Support for Process Portal B graphics links through the object ids has
    been implemented.
8.  Unicode text files are now supported.
9.  Wonderware database tag naming quirks have been accommodated.
10. Rung block outputs in override are reported.
11. Blocks 1 to 9 have a source if there is an EXEC block FC 81 and are checked
    when imported.

Hyperview:

1.  The /save switch lets the user specify a directory where any files
    generated by Hyperview will be saved.  The files affected are those
    which are generated by the following operations: Audit Window File|Save,
    Search Results File|Save, the "Gather live loop data in the following
    path" option on the "View" tab and "Print to File".
2.  Hyperview now binds to a particular local port to use in its communication with
    CIUMon as opposed to using any available port.  The user can either author
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    in a valid port range using BuildPlus or specify a range on the "Live
    Loop Setup" panel in Hyperview.  The default range is 5000 to 5100 and
    Hyperview will check for the validity of the port range entries and 
    report any errors encountered.  The port(s) which Hyperview has bound to
    are shown in the setup list following each live loop setting.
3.  The search features in Hyperview have been combined into a tabbed property
    sheet format which can be launched with one search button on the
    toolbar.  By hovering over the search button, the button will change to
    display the last search type used - full text, database or keyword.
4.  The links from function codes to the function code index have been
    disabled.  This option, however, can be re-enabled by selecting
    the "Function Code Hotspots" option under the "Highlight" menu.  Function
    code specific help can still be accessed via the pop-up menu even if the
    hotspots are turned off.
5.  New functionality has been added to the pop-up menu: access to the block
    map and "Set My Home Page".
6.  Hyperview now displays text logic state descriptors in live loop for 
    digitals and device drivers.
7.  Special handling has been added for quality hotspots.
8.  The close box option (the 'X' in the upper right hand corner) has been
    added to manual live loop windows.
9.  The font size of the static live loop boxes is now authored into the M14
    so that the display is in proportion to the drawing elements.  The live
    loop font size changes made on the "View" page of the "Options" now only
    apply to the live loop annotations and manual live loop boxes.
10. Hyperview now permits live loop monitoring on hotspots that are marked
    external (GPI interface provides access to the data that is actually
    external to the Bailey system).  These external points are specified via 
    BuildPlus (see #2 under the BuildPlus section).
11. The option to set the frequency at which Hyperview updates its live loop
    information is now available.  Previously, Hyperview would ask CIUMon for
    live loop data every second; the user can now configure this to be a
    longer interval by either changing the option on the "View" tab of the
    "Options" or setting the /update switch on the command line to the
    desired interval (in seconds).
12. An error message will appear now when an invalid tag name is entered in
    the Live Loop Annotations option.
13. Printing has been corrected to show specs on a printout when a sheet has
    been added via the right-click pop-up menu.
14. Support has been added to enable the use of the mouse scroll wheel.
15. If the option to have search hits highlighted is turned on and a print
    is requested, all drawing hits in the appropriate print region will be
    highlighted on the printout.
16. The F6 key can now be used to cycle through all open child windows
    including: both topics, search results, topic title search, audit
    window and help.
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17. Support for bitmap records in Conductor NT graphics has been added.
18. The option to abort a print job has been removed from Hyperview.
19. The various print options available, such as adding a caption or
    printing annotations, have been moved into the new "Advanced Print
    Options" dialog.
20. The user may now specify that the document path and filename be added
    to the printout (available under the Advanced print options).
21. An informational live loop message appears when the IP Address of the
    current machine is blocked by CIUMon (see #3 in the CIUMon section for
    more details).
22. Improvements have been made to the "Print Annotated Topics" option.  The
    annotated topics are now shown in the "Mark Topic for Printing" dialog in
    a treeview listing where you can select or deselect the desired documents
    for printing.
23. Additional options are now available in the Audit Window under the "Save"
    option.  The user can save the individual Block, Tag, Function, Reference
    and Miscellaneous lists in various formats.
24. Hyperview will now open the last opened M14 file if no parameter is given.
25. Help can be brought up in the manual live loop windows with a right-click
    to select it from the popup menu.
26. When selecting "File" - "New" from the menu, a new copy of Hyperview will
    be launched, open to the M14 file that is being currently viewed in the 
    copy of Hyperview that launched it.
27. In SODG Graphics where references do not have a tag name, they will be 
    easily identified in the index with the phrase "(blank tagname)".  The
    intent of this feature is to show the user where a link is being made
    purely based on the index number.
28. Support for the RCM block permissive, override and feedback has been
    introduced.
29. Links to documents with short names has been implemented.
30. String specifications are now displayed as strings.
31. A map of the colours used in AutoCAD and MicroStation sheets is now 
    created for user reference.
32. Trend tags now show tagname attribute.
33. The Kit Version is now displayed in the "Help" - "About" dialog.

Decomposer:

1.  SODG Symbol names are now in Composer and Conductor VMS.
2.  Improvements have been made in extracting macros in Composer systems.
3.  Handling has been added for 5-digit block numbers.
4.  A fix has been implemented for a crash found in the CLD Parsing in
    Decomposer on Composer 3.2.
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Database Utilities:

1.  The renumbering of blocks Module 0,0,0 Block 0 has been removed so that
    the tag mismatch messages no longer appear due to this.
2.  Case sensitive taglist/trendlist names are now handled.
3.  New programs and files - DBPPB.vbs, Ppb,mdb and Ppb.dbf - are now part of
    the DBDOC software kit to handle Process Portal B databases.
4.  For Composer systems, a problem was encountered when working with a remote
    read only copy of the LDB file causing a build failure.  This problem has
    been remedied in our new versions of the various database programs and 
    the build should now continue on to completion.
5.  The tagtype field has been increased to 15 characters from 9 to account
    for newer, unknown tagtypes such as ANALOG1_O.

CIUMon:

1.  The saving of multiple configurations on one machine has now been
    implemented in CIUMon.  This allows the user to easily switch between
    configurations without having to discard any previous changes or to
    run multiple copies of CIUMon on one machine if he has multiple CIU's 
    connected to his computer via multiple COM ports.
2.  Handling has been added to respond to the "connstat" command from 
    Hyperview.  This has been implemented to allow Hyperview to check for 
    good communication status between CIUMon and the CIU.  (Note that this
    feature has not been released yet in Hyperview.)
3.  A new option to limit which IP Addresses can do live loop monitoring has
    been added.  This option is accessible through the "CIUMon Settings..."
    option under the "Options" menu.  On the "Approved IP Addresses" tab,
    enter in the range of IP Addresses that are either approved or blocked
    by CIUMon for live data gathering.  If no addresses are entered then 
    full monitoring is allowed for everyone.  A message will be sent back to
    the requestor (either Hyperview or CIULink) if the IP Address is blocked
    so that the person requesting live data is aware that his machine is not
    currently approved for monitoring.
4.  The virtual serial port functionality that was previously built into
    CIUMon has been removed and built into its own application, VirtualPortSetup.
    This has been done to accommodate running multiple copies of CIUMon on a 
    single machine.  The first copy of CIUMon which is started will launch 
    this application automatically and all subsequent copies of CIUMon will 
    reference the same copy of the VirtualPortSetup application.  (Note: this 
    only applies to machines running Windows NT).
5.  The user can now enter in the number of virtual serial ports that can be
    created at one time (up to 9).
6.  The option to launch the RoviSys OPC90 Server Lite software upon CIUMon 
    startup and to set its priority has been added.

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 114 of 156



 DBDOC Release Notes  
7.  Fixes have been implemented to handle the Harmony I/O functions correctly
    (function codes 222 thru 225).
8.  The Kit Version information has been added to the "Help" - "About" dialog.

CIULink:

1.  The user can specify the range of local ports available to CIULink to bind to
    in order to open up a communication channel to CIUMon.  This feature is 
    the same as that which was implemented for Hyperview (see #2 in the 
    Hyperview section for more details).
2.  Time stamp information is now recorded for all points when logging points
    in Export view, not just the first and last points received.
3.  The Kit Version information is now available in the "Help" - "About" dialog
    box.

OPC-90:

1.  A new demo version is now available for trial.  It is version 4.2.6 and
    is found in the RoviSys folder located in your DBDOC installation
    directory (by default, "C:\Program Files\GMCL\DBDOC\Programs").
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Version 9.51  September 29, 2003
BuildPlus:

1.  Fix Management of Change basefile reference to
    automatically renamed M14 file.

CIUMon:

1.  Improve checking of physical COM ports for VSP creation
    and detection to handle internal modems on laptops.

CIULink:

1.  Fix DDE interface with Excel.

Hyperview:

1.  Only log live loop data when requested (set the Option on 
    the "View" tab).
2.  Clears up some static liveloop display problems that were
    introduced by changing the size of some static liveloop hotspots
    and changing of the alignment of others.  Red boxes were not
    being erased appropriately.
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Version 9.50  September 8, 2003
General:

1.  New and improved error filter messages to pinpoint possible
    problems.

Database Utilities:

1.  Blank tags are now suppressed in databases.
2.  Case-sensitivity of WinCAD tag list names is now handled 
    correctly.
3.  Short tags are no longer renamed to TAG_X.

BuildPlus:

1.  Multiple databases can now be associated to a single console
    in the Conductor Console Associations.  The compilation
    handling has been added into Hyperlink to handle this
    situation.
2.  Conductor At-A-Glance support has been added into BuildPlus
    and Hyperlink.  The user may select files in Wizard and
    then associate the files to the appropriate consoles in the 
    Conductor Console Associations tool.
3.  Databases extracted from FoxPro databases, along with their
    corresponding generated error and format files, are now
    placed in TDTn subdirectories in the TAG folder of the
    project directory.
4.  "Display Project Settings and Selections" is a new option that
    has been added to allow the user to see the file selections
    and user made associations for projects on either local or
    remote machines.  For remote use, Administrator privileges will
    be required if working with NT based machines, while the Remote
    Registry Service must be installed on the machines if they are
    Windows 9X based.
5.  Newly added modules of CAD sheets are now automatically detected
    by BuildPlus when the project is started from the "Build" stage
    if they are located in the search path previously specified in
    Wizard.  The user can choose to add them at the time the build
    is run or else make changes to the selections by restarting the
    build from the Wizard stage.
6.  Improvements have been made in the scrolling code for BuildPlus.
7.  The option "Enumerate DBDOC Components" has been added under the
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    "Tools" menu option.  This will generate a file that lists all
    the currently installed programs and files for DBDOC and
    their versions.  Any version mismatches will be reported.
8.  The Database-Graphics Association tool has been modified so that
    all valid tag and trend databases will be listed for association
    with graphics paths.
9.  "Check DeomposerN Directory Sources" displays which numbered 
    Decomposer subfolder in the project directory each selected
    Composer EBP database was extracted into.
10. The option to suppress user defined pre- and post-scripts has
    been added for manual builds.
11. An additional panel has been added to the Project Specification
    series of dialogs to show the user which databases have been
    selected before any processing occurs.  This allows the user the
    opportunity to confirm his choices before any possibly time-
    consuming processing begins.
12. Management of Change processing has been moved to before the
    Hyperlink run so that the text file listing any changes in the
    project files may be built into the current M14.
13. The option to build in symbols and/or submodels as separate
    chapters in the final M14 has been enabled.
14. A new /start command line switch has been added to allow the user
    to specify which build to start a buildall on should he wish to
    skip the beginning sequence of projects.  Please note that NT-based
    OS's use alphabetical processing of projects and Win9x machines use
    chronological order.
15. Default zip tools are now shipped with DBDOC so that a zipped
    error file of all pertinent files can be created even if the user
    does not have WinZip installed on his computer.
16. The "Processing Options" page has been simplified and any
    additional options will be listed under the "Advanced Options"
    page.

Hyperlink:

1.  Hyperlink now generates an alarm_tag report of digital tags 
    that will alarm, but that are not on any graphic.
2.  Unused tags with external sources are now marked with source 
    "External" in the Unused_Tags.txt file.
3.  Better searching in AutoCAD drawings has been implemented via
    Fuzzy-Matching so that meaningful substring matches are located.
    For the sake of compile speed this option can be turned on and
    off via the Advanced Project Options in BuildPlus.
4.  A list of rasterized AutoCAD drawings (ones that do not contain
    any text) is now created.
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5.  Hyperlink now tests for duplicate imports to the PCU.
6.  Composer source document references can now be shown as a stacked
    display on the CAD sheet.  This option can be toggled on and off
    via the Advanced Project Options in BuildPlus.
7.  Duplicate Global OREF's are now reported.
8.  In rendering CAD drawings in Composer systems, Hyperlink will not
    split wires at connectors.
9.  More linking support has been added for Operate IT.
10. New and improved processing of histcfg.xdc files has been added.
11. Trend:nnnn directive is now processed for links and liveloop
    monitoring for trended tags.
12. Support has been added for the point: directive for Conductor NT.
13. F(x) graphing has been implemented as it is in the Bailey system
    with respect to out-of-order co-ordinates.
14. The tag description has been added to the mouse-over datatip.
15. Blk file support has been added.
16. Loop, PCU and Module information has been added to error messages.
17. Exception Report function codes are now handled better.
18. FC 36 (8-input QOR) is checked to make sure there are enough 
    inputs connected to make it work.
19. Flat F(x) functions (ones that return a constant) are reported.
20. F(x) functions with adapted parameters are reported.

Hyperview:

1.  Searching has been totally reworked for more intuitive functionality.
    More advanced search options are now available in an expandable
    dialog so that the basic search dialog is presented in a cleaner
    interface for the standard user.  A rebuild of the project is 
    necessary in order to take advantage of the full functionality
    but it should be noted that this Hyperview is backwards compatible
    with old M14 versions.
2.  Make use of Hyperlink generated adapted specs list to compile
    a bulk "Get Specs" fetch so that adapted values are correctly
    inserted in the live display.
3.  Tag attributes can now be displayed.  They work similar to the
    specs overlay, accessible via the 'A' key.
4.  The ability to add Live Loop Annotations anywhere in the M14 file
    has been added.  You can now monitor any point in your system 
    on any document regardless of whether or not that point is actually
    referenced on the document you are viewing.
5.  The "Home" button is now configurable so that the home pages of
    Table of Contents and Topic pane can be set to whatever document
    the user chooses.
6.  Within the Options property pages, the user has the ability to
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    reset the Hyperview settings to their default standard values
    (ie. those settings that Hyperview would have when run for the
    first time).  The settings can also be restored to the user's
    custom settings with the "Restore Preferences" option.
7.  Icons have been added to the status bar to indicate success or
    failure of live loop logging and to show informational tips.
8.  New command line switches, noOpen and snapshot have been
    added.  /noOpen disables the "Open" menu option under "File";
    /snapshot will disable the continuous live loop monitoring 
    button but leaves the snapshot button enabled to allow the
    user to fetch the live data at the given moment.

CIUMon:

1.  New versions of the VSP files are included with this kit.
    The changes made in CIUMon in combination with these new
    versions should solve the problem that some users were
    seeing with the message that the VSP trial period had
    expired.  CIUMon will detect that different VSP file 
    versions have been installed and will require that the
    machine be rebooted before any VSPs will work with the
    new files.

CIULink:

1.  SPM02 support has been added to CIULink.

CrypKey:

1.  Blank CAD sheets are no longer counted against the total 
    document count.

Support for Other Languages

1.  Documentation of the build messages is available in draft form
    in French and Spanish.
2.  Documentation of the Function Code Help information is also 
    available in French and Spanish.
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Version 9.42  June 26, 2003

Installation:

1. The DBDOC installation program now checks to see if the user is logged on with 
Administrator privileges on Windows NT platforms.  If the user does not have the required 
privileges the installation will abort.

Hyperlink:

1. Batch file processing has been improved.  A message is generated on missing include files.  
The search algorithm for include files has been made more robust so that relative path 
specifications will yield better results.  Improved batch file title generation to include unit 
filename, if present.

2. Attribute handling in AutoCAD drawings has been corrected.
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Version 9.41  May 6, 2003
BuildPlus:

1.  Fix has been implemented to correct the enabling and
    disabling of the toolbar buttons.

Hyperview:

1.  Numeric live hotspots are moved to be right-aligned 
    with respect to their parent hotspots.
2.  Printing from Hyperview on  Windows NT/2000/XP to a
    remote Windows NT/2000/XP mounted printer has been
    fixed.  A remote USB printer is still a problem.

CIUMon:

1.  More robust handling has been added to handle error 10038
    when being run on Windows 2000 platforms which do not have
    Service Pack 2 or above installed.

CrypKey:

1.  Fix has been put into BuildPlus and CIUMon to prevent
    the license expiry warning dialog box from appearing more
    than once per day/session.
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Version 9.40  April 24, 2003
Composer:

1.  Add version dependent ability to access global field for
    use in resolving output references.

Database Utilities:

1.  Allow databases on CD's to be opened.

Wizard:

1.  Special handling for multiple file selections in multiple
    paths (useful for Conductor customers with multiple units).
2.  The Table of Contents re-ordering feature is now optional
    and is defaulted OFF.  This can now be triggered through
    the BuildPlus project options.
3.  Fix crash on duplicate selections where unique files/paths
    are required.
4.  Fixed reported file sizes for sizes less than 1K.
5.  Fix crash in "Check Wizard Input Files".  This is still not
    a useful function to anyone other than GMCL development
    group.

BuildPlus:

1.  The option to add CIUMon settings inline has been added back
    into BuildPlus.  This option is default OFF and can be 
    triggered through the BuildPlus Options.  The CIUMon settings
    are also now saved in the registry for future builds.
2.  Empty files will not be built into your M14.  A list of empty
    files will be written to EMPTYFILES.TXT and included in the 
    Miscellaneous chapter in your M14.
3.  Modified time and date has now been added to all file sub-
    titles (as long as they are not files that have been extracted
    by DBDOC for the purposes of the present build) in the Classic
    Table of Contents view in your M14.
4.  A new BuildPlus option has been added to warn you that you
    will fall below a certain amount of disk space.   Set the 
    disk space minimum in the BuildPlus options and if you fall
    below that level a warning will appear asking if you wish to
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    continue with the build.
5.  Several new project options have been added:  PI Point Source
    (specify your own special point source names and associated
    field names), Error Filter Output Selection (only generate
    those error files that you are interested in) and Custom Edit
    (for the advanced user - add any special build instructions
    especially for AutoCAD color settings).
6.  If you have chosen XLS databases in the Database Selection
    panel, BuildPlus will attempt to pre-extract them so that
    they may be sorted into their appropriate categories (ie. tag,
    trend, PI, generic, unknown) in the sorting dialog box.
7.  More project options are stored in the registry which ensures
    a more consistent build (eg. CIUMon settings).
8.  The Cat-To-Dog rename interface has been improved so that you
    may rename any existing project M14.  It is important to use
    this rename interface rather than manually renaming it through
    Windows Explorer as BuildPlus will then modify any relevant files
    to reflect the new name (eg. Management of Change base files).
9.  Newly generated M14's are now automatically renamed to 
    <project_name>_<date><revision>.M14.  This option may be 
    disabled through the BuildPlus Options.
10. Project registry settings are now exported to a file after
    each build and will be stored somewhere in the ERROR_FILES
    directory (depending on whether you have error file archiving
    turned on or not).  This option can be enabled or disabled 
    through the BuildPlus Options.
11. Suppression of some unnecessary warning messages in Management
    of Change processing.
12. A new command line switch has been added - /exclude.  This can
    be used in conjunction with the /buildall switch to exclude a
    project(s) from being built in a particular build root.
13. If bad files have been excluded from a build and a new version
    of Hyperlink has been detected, the user will be queried as to
    whether or not they wish to attempt to build the bad files with
    the newer version of Hyperlink.
14. The file CLDUnused.txt is now created in the DECOMPOSER# sub-
    directory listing all unused CLD's for a Composer project.
15. Individual build logs are now created for the /buildall process.
    The files will be named BuildAll_<build root>_<date>.log.
16. CAD title extraction has been removed from BuildPlus.
17. Better state retainment for the Main message and Sub-Process
    message windows.

Hyperlink:
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1.  Improved RTF parsing - enhanced code for RTF commands.
2.  Parallel compression of output files in threads to speed end
    stage of Hyperlink processing.
3.  Implemented intelligent AutoCAD tag recognition scheme.
4.  New export_specs feature (dependent on full license) creates
    one flat database per function code.
5.  More exception-reporting function codes are handled.
6.  Fix AutoCAD layout problem by flipping Y axis in drawing 
    functions instead of changing view direction.
7.  Make an index page for SPECDESC.DBF.
8.  Handle binapp files up to 4MB in size.

Hyperview:

1.  Skip S1 for function generator live data display (graph 
    looked like Etch-A-Sketch).
2.  New buttons have been added to the toolbar.  The ability to
    create annotations from the toolbar has been added.  Click
    the button and click on the document where you want the
    annotation to appear.  An Audit Window button has also been
    added to the toolbar.  There is a new Home button which will
    return you to the classic opening view of your M14.
3.  "Vegas Lights" have been added to enhance your target viewing
    experience.  Blinking lights make it easier to spot your 
    hotspot.
4.  Pop-up menu changes include items for searching and copying.
    The topic name is now included in the "Mark Topic For Printing"
    option.  There is also the new option to "Mark linked topic for
    printing".  The option to minimize and restore annotations has
    been added as well.
5.  The Hyperview coordinates are not saved if it is minimized or
    maximized for restoration the next time Hyperview is opened.
    There is the option to "Always open Hyperview maximized"
    which can be set on the "Options..." property pages.

CIUMon:

1.  The disconnect functionality has been fixed by resetting
    the thread priority level to normal.  Commands are no longer
    accepted when a disconnect is in progress.

CrypKey Licensing:
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1.  Limited functionality has now been added to BuildPlus and 
    CIUMon when your license expires.  In CIUMon, you will be 
    able to delete your VSPs (Virtual Serial Ports); in BuildPlus,
    you will be able to launch Hyperview, create the Error.zip
    file, launch Windows Explorer, clean up temporary files and
    rename M14's.  You will be able to access the license dialog
    in both programs.
2.  There is a new dialog which appears when your license expires.
    You will have to option to license now, license later with a
    daily reminder, or license later without a reminder.

Contextual Help:

1.  Contextual help has been updated for both BuildPlus and 
    Hyperview.
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Version 9.31  February 20, 2003
Hyperview:

1.  A problem with live loop monitoring for non-SPM02 setups has 
    been corrected.  This problem was only introduced in our last
    version (9.30) and resulted in not being able to fetch live
    data when the user had a loop setup without a specified PCU
    entered.  This has now been remedied.
2.  Previously if the table of contents were shown in Hyperview 
    in Treeview mode and the focus left in the TOC window, when
    live loop monitoring was turned on, the values would not get
    updated unless the focus was placed on the drawing window.
    This problem has been fixed in this version.

Hyperlink:

1.  Hotspot formatting maximum length has been set to the longest
    tag or document name found to avoid crashing on long text lines.
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Version 9.30  February 13, 2003
Installation:

1.  At the end of the installation, a separate program will run
    to check to see that all the new components have been installed
    for the current kit.  Any mismatches or missing files will be
    reported in the DOS window and recorded in DBDOC_reg.log
    found in the Windows directory.

BuildPlus:

1.  Conductor Console Associations and SODG Graphics-Symbols
    Assocations have been implemented to support the correct
    generation of these two types of graphics into the final M14.
    With Conductor NT and/or Operate IT graphics, a user may wish
    to build multiple consoles of these types of graphics.  If
    this is the case, BuildPlus allows the user to associate 
    different databases, colordef.dat and fontdef.dat files for
    the various consoles, as well as specify different .XDC files
    (graphcfg, trendcfg and histcfg) for each.  For SODG graphics,
    it is necessary to associate the correct sets of symbols to
    use in the  build with each set of graphics.  BuildPlus provides
    an interface in order to make these associations.  For the most
    part, BuildPlus will try to automatically do the associations
    in both cases in order to minimize the amount of manual input
    required to complete the build.
2.  BuildPlus now checks for the required components before running
    programs during the build.  If there is a missing file, the user
    will be informed and the build will not continue.  This will
    prevent the user from seeing disconcerting failure messages
    during the build process.
3.  The user can now set the priority level at which a process 
    will run.  This option is found under the "BuildPlus Options" 
    under the "Tools" menu and controls all non-GUI processes and
    the Mediaview Compiler launched by BuildPlus.
4.  A new program, MDBType.vbs, is now run on all Access MDB databases
    before presenting them in the "DBF and MDB Types Detected" dialog
    box following the Project Specification panels.  This should 
    correctly sort out which databases are Conductor NT and which 
    are Operate IT databases so that they can be grouped together
    and processed correctly.

CIUMON:
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1.  In Windows NT based systems, you can improve the performance of
    CIUMON by making its priority above normal or realtime.  Consult
    with your system specialists and observe the affect on other 
    systems carefully, of course.

Hyperlink:

1.  Graph function on Function Code 1
2.  Batch file processing has been improved.  We now get the loop,
    PCU and module information from the Address.def file, as well as
    showing the include files expanded in-line.
3.  Hotspot formatting has been reworked to provide for better 
    linkages.  Word boundaries are now respected to create more valid
    links to documents.
4.  Eudscp.cf exports are now built into the final M14.
5.  Support has been added for undefined graphics and symbols indices.
    An undefined tags index has been added to the miscellaneous indices.
6.  MHD information is built into the M14.
7.  The module type limits the number of blocks which show up in the 
    block map.
8.  The RTF compilation error has been remedied by implementing one RTF
    file per chapter.

Hyperview:

1.  Graph function on Function Code 1 is available via the right-click
    popup menu.  It provides a static view of your custom F(x) and is
    live-loop capable on a per-graph basis.
2.  Creating a shortcut to the latest M14 in a project has been made
    easier with the wildcard feature.  Create a shortcut that has a
    target pointing at the project directory with *.M14 as the filename
    and when Hyperview is launched, it will look for the M14 with the
    newest creation date and open it.  NOTE:  Windows NT, 2000, XP provide
    file tunneling capabilities so that if you delete a file and create it 
    within the specified caching time period, you will retrieve the file
    creation time of the original (now deleted) file for your newly created
    one.  BuildPlus has been modified to insert the correct creation time in
    any M14 files that you build with this new kit installation.  Old M14 files
    (built before this installation) may not work with this new shortcut method.
3.  Annotation support is better.
4.  TreeView Table of Contents changes have been implemented for better 
    functionality.
5.  More Bookmark support has been added in Hyperview.  There are now
    separate pages for defining and managing the bookmarks in an M14.
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6.  Improved Live Loop support has been implemented including the 
    configuration of multiple SPM02s.  With SPM02s, this allows the
    user to specify multiple SPM02s connected to the same loop but 
    different PCU's, thus simplifying communications between Hyperview
    and CIUMon.
7.  Modifications have been put in to improve the search capabilities
    in Hyperview.  The checkstates of the "Show Search Hit Frequency"
    and "Show Group" options have been retained for the full text and
    database searches.  The column widths in the search results are
    retained for subsequent runs and minimum sizing has been implemented.
8.  Version verification is enabled to provide the best in compatability
    between built M14's and Hyperview versions that you may be running.
9.  Print color reversal for Conductor NT graphics has been implemented.
    If a graphic has a colored background, it will be printed with a
    white background, by default, to save on ink.  If you wish to dis-
    able this, check the "No color reversal" option in the "Print"
    dialog box.
10. Go To Source handling has been improved.  Double clicks on text
    panes now take you to the source.  OREF references are now shown
    in red in the classic and treeview table of contents and are
    registered as a source for a go-to-source feature.
11. "Open Document", "Explore to Document" and "Document Path" options
    are now available on a right mouse click, where applicable.  This
    allows the user to launch a Windows Explorer page opened up to the
    directory to which the source file is located or to display the
    full path to the source file.
12. Generic binary application support has been added.  

CrypKey Licensing:

1.  A warning dialog box now appears in both BuildPlus and CIUMon
    when you have 15 days or less left in your license.  This will 
    allow the user to take the necessary steps in order to ensure
    uninterrupted use of DBDOC.

OPC-90:

1.  In Windows NT based systems, you can improve the performance of
    OPC-90 Lite by making its priority above normal or realtime.  Consult
    with your system specialists and observe the affect on other 
    systems carefully, of course.
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Version 9.20  November 1, 2002
Installation:

1.  The installation has changed from previous distribution/
    update kits.  There is now only one general kit for both the
    full distribution and update.  Before the InstallShield is
    actually launched there will be a setup program which will 
    run first that will back up registry keys, uninstall old
    versions and delete any remnant files that may be left.  
    InstallShield will then be launched and at the end of the 
    installation, if the GMCL registry keys have been removed by
    the uninstallation of the old kit, they will be restored.
    This should resolve any issues that have arisen in the 
    upgrading of the InstallShield program since our version
    8.43 release.

BuildPlus:

1.  Handling for Access MDB databases for Operate IT systems 
    has been implemented.  The "Project Specification" dialog
    box now shows a general "Access Database" category where 
    the user can specify his Conductor NT and Operate IT MDB
    databases.  BuildPlus will then present the selected data-
    bases at the end of the project specification in a treeview
    so that the user can categorize what type of database each
    one is.  This allows support of both .XML and .MDB export
    formats of the Operate IT tag database.  Note that this
    also applies to Process Portal B.
2.  The user has the option of configuring the compression level
    of their M14 build.  This option is available under "Project
    Options" on the "Processing Options" tab.  It is set at level
    3 by default (range 0 (none) to 9 (maximum)).  The only 
    reasons to do this are either a very slow computer CPU or a
    very large system.
3.  There is now revision information in the "About" dialog.
4.  The "View M14" dialog box has changed.  You will now be able
    to scroll horizontally to see really long file names.  You can
    either select the file from the list and click "OK" or just
    double click on the file in the list to open it.
5.  There are two additional command line switches available in
    BuildPlus - /nomsg and /noview.  The /nomsg switch suppresses
    any error message boxes that may appear during an automated
    build.  The /noview switch suppresses the launching of 
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    Hyperview at the end of the build and closes the BuildPlus
    window after the build regardless of whether the build was
    successful or not.
6.  Troubleshoot mode (found in the "Processing Options") is no
    longer available.  With the implementation of the Treeview
    table of contents in Hyperview, hyperlink can build in a
    fully verbose mode without overloading the user with infor-
    mation in the M14 file.  Note two new commands:  ctrl-T, a
    command to toggle between treeview and classic views; and T,
    which collapses the treeview index to the chapter level.
7.  BuildPlus now allows duplicate module headers if either the
    PCU or Module is 0.
8.  ExtTextOut failure (mostly on Windows XP with "switch user"
    login screen) should not be occurring any longer since text
    output to the BuildPlus window has been modified to use a
    different call.

Hyperlink:

1.  New AutoCAD support has been implemented in Hyperlink.  The
    drawing rendering has been vastly improved.
2.  Hyperlink now has improved batch file support.   Comments 
    are shown in green.  Outputs that appear on their own lines
    are now linked.  
3.  Honeywell point databases can now be included in your builds.
    You will need to start from the Wizard in order to include
    these files.
4.  Add _N atoms to liveloop capable list for Conductor NT.
5.  Point source C for PI tags is now being picked up.
6.  Alias AutoCAD files by their true root name (for example,
    CS-M-018_01_R04 aliased as CS-M-018).
7.  In the Classic view of the table of contents in Hyperview,
    anything that is a source is shown in red (just as in the
    Treeview table of contents).

Hyperview:

1.  The Hyperivew help has been fixed to run off the "Start"
    button.

CIUMON:

1.  Physical-To-Virtual connections have now been added to 
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    CIUMON's handling of virtual serial ports.  The user can 
    now essentially connect a NULL modem cable between a phy-
    sical serial port and a virtual serial port through this
    option.  This has been implemented to work with the RoviSys
    OPC90 Server and the multiplexing of Composer and DBDOC.

Wizard:

1.  BLK files are now automatically searched for where CAD 
    sheets occur.
2.  Wizard has been fixed to handle strange characters (such as
    an ampersand) in folder names.
3.  Bailey SODG and user symbols cannot be selected twice (i.e. 
    this means that if you have selected a folder in your Bailey
    SODG it cannot be selected in your user symbols, and vice-
    versa).
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Version 9.10  September 18, 2002
BuildPlus:

1. Interface to support sorting of DBF type databases.
2. Insert "Excluded File List" into DBDOC_SUMMARY.ERR.
3. Remove in-line CIUMON settings dialog.  The adding of CIUMON settings is now only 

accessible through the  Project Options.
4. The "Create Desktop M14 Shortcuts" now creates shortcuts with UNC named directories for 

the "Start In" directory and the path to Hyperview.
5. Super secret option to edit .CFG file before launching Hyperlink.

Database Utilities:

1. Support GUID.
2. Auto-detect for DBF files (DBType.exe).
3. DBDOC.MDB exports alarm priorities numerically and also exports the alarm group.

Hyperlink:

1.  Build compressed M14's.
2.  Split contents of the WMF, SMF and HOT directories among 
    subdirectories with no more than 4096 files per subdirectory.
3.  Fix message indicating apparently circular missing symbol
    or submodel inclusion.

Hyperview:

1.  View compressed M14's.
2.  Movable annotations.
3.  You are now able to suppress the printing of annotations.
4.  Move sockets calls so that their activation is delayed until
    the user sets up CIUMON connections.
5.  Hyperview does not send requests from external blocks to
    CIUMON.
6.  Bookmarks are saved and visible whether the topic is 
    available or not.  If the topic is not built into the 
    M14, the bookmark is grayed out.
7.  Better print abort flag control.
8.  Re-enabled print selection in text documents.

CIULink:

1.  Fixed export log creation for import into Excel.
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Version 9.02  August 28, 2002
Hyperlink:

1. The FillGroup record in Conductor 4.0 M1 files is now
   handled correctly.

Hyperview:

1. A fix has been put in to correct a problem with the 
   bookmarks, history and pop-up menu for live loop data 
   handling on Windows NT and Windows 95 which was introduced
   with the new Microsoft Platform SDK.
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Version 9.00  July 23, 2002
General:

1. This latest release of DBDOC includes CrypKey software licensing.  With this 
implementation, the user will be  given a 15 day trial period to evaluate the software.  After 
the expiration of the trial period, it will be necessary to contact us to either extend the trial 
period or to obtain a license key with the purchase of the DBDOC  software.  Customers who 
have already purchased DBDOC need only to get in touch with us to obtain a site key.

2. Rovisys OPC-90 Lite is a new software package that allows for the multiplexing of DBDOC's 
CIUMON access and WinCAD or Composer.  The RoviSys OPC-90 Lite server supports all 
CIU models including the ICT-03 in both serial and SCSI connections to the Bailey Loop.  Its 
ability to multiplex multiple processes to a single CIU is enhanced by our implementaion of 
virtual serial ports.  A trial version has been provided for examination; if you wish to purchase 
a full version of the Rovisys software, please contact us.

BuildPlus:

1. The Project Specification dialog has been improved for
   easier project setup.  It has been redesigned to resemble
   more closely the DBDOC Configuration Wizard for file 
   selection.

Hyperview:

1. Hyperview now offers the user the option of viewing a Tree-View 
   Table of Contents.  This allows the user to have an at-a-
   glance overall view of all their documents in a particular
   M14 file.

CIUMON:

1. Error reduction in internal handling improves performance.
2. CIUMON has been implemented with code licensed from DDI
   Systems to create and connect virtual serial ports.  This
   option is only available for Windows NT/2000/XP systems at
   this time.  The purpose of this feature is to allow the user
   to add a serial port without actually having to install new
   hardware; this facilitates the multiplexing of CIUMON and WinCAD
   or Composer through the Rovisys OPC-90 software mentioned
   above.
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Version 8.43  June 7, 2002
Decomposer:

1. Minor quirks in Composer system processing have been fixed.
   Problems were found in loop numbers greater than 99.

Hyperlink:

1. Hyperlink now supports 7 character modules correctly.

BuildPlus:

1. Error files generated by hyperlink are now moved into their own
   subdirectory under the project.  A new directory named "ERROR
   FILES" is now created and a subdirectory called "Most Recent" 
   will contain those files from the most recent build.
2. In the "BuildPlus Options...", there is now the choice to 
   "Archive Project Error Files".  When the user turns this option
   on, BuildPlus will start archiving the hyperlink error files 
   in the "ERROR FILES" directory in subdirectories named after
   the date that the build took place.  This allows the user to
   compare the errors between builds.  There is the additional
   option to "Delete Archived Error Files" which allows the user 
   to delete all files or just those between given dates.

Hyperview:

1. The printing of captions, which was broken in the last release,
   has now been fixed.
2. The "Mark Topic for Printing" dialog box now shows checkboxes
   beside all selections added to the list.  This allows the user
   the option of selecting or deselecting a full group of documents
   rather than having to click each individual sub-item.  The dialog
   box has also been made resizable.

CIUMON:

1. The option to add a caption to the log has been added under the
   "File" menu option.  When the user has the logging turned on,
   he now has the ability to add mutliline text into the log file
   when there is something to be noted.
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Version 8.42  May 21, 2002
Database Processing:

1. DBEBP.vbs and DBSynth.exe have been modified to sanitize the exported
   DBF filenames to exclude illegal characters.
2. DBMDB.vbs removes prototype tags (starting with ! and having a 0 LPM)
   from tagdata.mdb.

Decomposer:

1. Preserves cross-reference descriptions which are longer than 30
   characters in Composer systems.

Hyperlink:

1. Patch to prevent Conductor popup links from being created from graphics
   to M2 files.
2. Additions have been made in order to support the new "Go to Source"
   feature displayed in Hyperview.  The user must rebuild their project 
   with this new version of Hyperlink and use the new Hyperview in order
   to take advantage of this feature.
3. Hyperlink has corrected the handling of "unformatted" live loop values 
   on SODG graphics.
4. Warning messages on exception reporting imported blocks, e.g. AI/L, etc.
   have been added.
5. Hyperlink will reconstitute decomposer-generated long cross-reference
   descriptions, i.e. it supports 31 and 32 character Composer cross-
   reference descriptions.
6. Cleans all messages for non-printable characters.
7. Extended maximum tag length to 32 characters for the purposes of scanning
   text for tag links.

BuildPlus:

1. The hyperview button is now disabled during the build process.

CIUMON:

1. CIUMON has been made somewhat backwards compatible with older versions of 
   Hyperview (pre-May 2nd versions).  CIUMON does not crash when it is 
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   run with an older version of Hyperview and does not cause Hyperview
   to crash.  However, due to the new request format of the newer Hyperviews
   the older versions will now only display red boxes rather than the
   true live data.  In order to get the full functionality, it will be
   necessary to update the Hyperview version.

Hyperview:

1. The "Go to Source" option has been added to the popup menu on a right
   mouse click for block inputs and outputs.  This allows the user to go 
   directly to the source and brings up the its related block index information.
2. "Mark for Printing" option has been added to the popup menu to quickly
   add topics to the list to be printed later.
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Version 8.41  May 7, 2002
1.  Patch to fix Conductor NT graphics links.
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Version 8.40  May 3, 2002
Overview of Major Features of Version 8.40:

1. Operate IT and Excel XLS support has been added.  Manual creation of 
   an XML database is still required from the SQL server.
2. The Wizard interface has been modified to improve multiple path handling.
3. Hyperlink can now generate an M14 in "troubleshoot" mode.  This only
   applies to Conductor NT and Operate IT graphics at the moment.
4. Improvements and additions to the Management of Change tools.
5. Bookmarks and Annotations have been added and improved in Hyperview.
6. BuildPlus and CIUMON now have property pages for easier navigation.

Wizard:

1. Wizard now accepts multiple paths to search in for specified files.  You 
   can add additional search paths by separating them with a vertical 
   bar ( | ).
2. The "Browse For Folder" now shows the files in the folder not just the
   folders.  It also shows you the currently selected path at the top of 
   the dialog box when you have chosen a file.
3. A new panel has been added to the end of Wizard which allows the user
   to reorder how the chapters appear in the table of contents in the final
   M14 file.  You are able to drag and drop the topics into the order that
   you wish them to appear.

BuildPlus:

1. Many changes and additions have been made to the Management of Change
   processing.  Messages have been reformatted in the MOC_DIFFERENCES to 
   provide more useful information to the user as to the nature of the
   change and the file itself has been renamed to append the date of the
   comparison.  Two new tools have been added to help the user in analyzing
   the changes occurring - one allows the user to pick and choose the 
   changed documents to print off within a given comparison and the other
   allows the user to compare any two base files within a project.  Please
   refer to the documented help for a more in-depth discussion of these tools.
2. Operate IT and Excel XLS support has been added into BuildPlus.  The user
   is able to specify these databases in the Project Specification dialog box
   in addition to any other databases they wish to build into their M14.
3. Many of the various tools that appeared under the "Tools" menu option have
   been placed onto either the newly designed "Project Options..." property 
   pages or the "BuildPlus Options..." dialog box for easier maneuvering and
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   less complexity.
4. CIUMON settings can now be directly added to M14 files so that the user 
   does not need to rebuild in order for  the live loop settings to take
   affect.
5. You are now able to specify a script to run before or after the build.
6. Database processing attempts to continue in the event that one of the 
   databases encountered is bad (only in a non-interactive build).
7. The Hyperview button is enabled at all times in an open project.  It should
   be noted that if a build is occurring and the user has the project's 
DBDOC.M14
   file open, the Mediaview compiler will fail as it cannot overwrite the M14.
   Make sure to close the file before the compiler runs if you are viewing it or 
else
   rerun from the Mediaview compiler stage to generate the new M14 when you are
   finished viewing it.
8. The Troubleshoot mode has been added as an option.  Note that this mode 
   applies only to Conductor NT and Operate IT graphics.
9. BuildPlus will attempt to be self-correcting in terms of the DAO handling.
   If it detects that certain keys in the registry are missing or required 
   Data Access Objects are not present, it will try to fix these errors and 
   attempt to continue with the database processing.

Hyperlink:

1. Double hotspots on AutoCAD references have been suppressed.
2. Hyperlink now builds in either developer or troubleshoot mode.  Troubleshoot
   mode displays only the "interesting" hotspots thus enabling the operator to 
   quickly understand the drawing contents.  Developer mode lists all the 
   hotspots and generally more information than is required for normal analysis.
   Troubleshoot mode is defaulted on for new projects and can be toggled on
   and off through the "Project Options..." in BuildPlus.  Note that this 
   feature currently only applies to Conductor NT and Operat IT graphics.
3. The tagmap feature has been added to identify inconsistencies between
   databases.
4. DBDOC URL's have been added to preserve information between builds.
5. Support has been implemented for Conductor popups.
6. DXF scaling has been fixed.

Hyperview:

1. Bookmarks and Annotations have been implemented and now persist across 
builds.
   A newly revised and enabled feature which will allow the user to easily docu-
   ment their drawings.
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2. Hyperview now recalls the last document viewed in an M14 before closing and
   will bring up that particular document the next time that same M14 is opened.

CIUMON:

1. All of the options for the CIUMON setup have been changed to appear as
   property pages to make it easier for the user to maneuver through the options
   and make changes.
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Version 8.30  March 15, 2002
General:

1. The order in which the chapters appear in Hyperview has been
   changed so that the configuration appears ahead of the symbols.
   In order to see these changes in effect, the user must rerun
   the project from the Wizard stage.

Hyperlink:

1. AutoCAD type files are assummed to be DWG type unless they have a
   DXF extension.
2. Hyperlink now generates a TagUsage.csv file in the project build
   directory which contains information about which tags appear in which
   databases in the system.

Hyperview:

1. The "Mark Topic for Printing" dialog box now presents the user with a
   treeview interface for groups which the user has selected.  The 
   expanded node shows sub-items within the group which the user can 
   deselect to omit them from printing.
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Version 8.20  March 7, 2002
BuildPlus:

1. Management of Change is defaulted on for all new projects.
2. A fix has been put in to correct a crash which occurred in the previous release of BuildPlus.  

This affected users who had not created at least one build root prior to this installation. 

Hyperlink:

1. Hyperlink is now able to handle colordef.dat files with more than 256 colors and fontdef.dat 
files with more than 11 fonts.

2. Rtf-escape characters are now added around reference descriptions to avoid potential 
MediaView crashes.

Hyperview:

1. Reduced resource leaks in the printing code have decreased the likelihood of crashes 
during bulk printing.

CIUMON:

1. 2- and 3-digit loop and PCU numbers are now being translated correctly for communication 
with the CIU.

2. An option has been added under the SPM02 Configuration settings that allows the user to 
specify the loop and PCU to which the CIU is connected as the environment fetch upon 
connecting does not necessarily return the correct information.
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Version 8.10  February 22, 2002
BuildPlus:

1. BuildPlus has been modified to simplify program updates for 
   Administrators.  It is now possible to install a central set of
   programs on a server which everyone can access.  Each person
   who uses BuildPlus will have their own set of builds local 
   to their machine.  Therefore, when updates are issued for the
   DBDOC program set, it will only be necessary to update one
   program location rather than multiple individual users; this 
   will ensure that everyone will be using the latest versions of
   all the programs to do their builds.
2. A "Toggle ON/OFF Tag-Scan option" has been added under the Tools
   menu.  Turning on tag-scan means that attribute (.ATT) files will
   be generated during the build.
3. On most of the tool options which require that the project be
   rebuilt before changes are in effect, the checkbox option of
   "Rebuild project immediately upon closing" has been added.  
   Once the user has finished making the changes desired and if
   he chooses to check this option, once the dialog box has been
   closed, BuildPlus will immediately start the process of
   rebuilding the M14.

Hyperlink:

1. AutoCAD drawings now have automatic live-loop hotspots.  
2. Function code fixes and additions have been implemented.  The
   function codes affected are 113, 154, 182, 230 and 231.
3. Hyperlink now generates an unused tag report; this appears in
   the project directory and is called Unused_Tags.txt.
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Version 8.01  February 13, 2002
BuildPlus:

1. Additional information and error messages have been added.
2. Fixes have been made to the "Build Symbol Paths as Separate
   Chapters" tool.  Users may exclude paths and change database
   associations from the default settings and rebuild to get the
   desired results.
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Version 8.00  February 8, 2002
Hyperlink:

1. Memory leaks in AutoCAD handling have been fixed.  Other AutoCAD improvements have 
been implemented.

2. Now able to handle both versions of VFY files:  "Block dddd" and "Block Number dddd".
3. Improvements that have been made in Hyperlink should make for better builds for large 

systems.  The following changes have been added:   
a) Module groups are not created unless configuration data (CAD, CLD, ladder, batch) is 

found for that module.  Blocks that are referenced only by database or graphics are not 
assigned a group.

b) Index pages, except for the function index, no longer have a browse sequence.  This is a 
result of eliminating the index/module groups in general.

c) Document-type groups (e.g. CAD sheets, ladder diagrams, etc.) will not be created 
unless documents of that type are in the build.

d) CAD files are no longer built into their own individual RTF files; rather, all CAD sheets 
for a given module are built into a single file.

These changes should mean that a greater number of documents could be built for a particular project 
before hitting the MediaView limitation of approximately 16K separate RTF files.

BuildPlus:
1. Contextual help has been added to all dialog boxes, as well as "What's This?" button to the 

main BuildPlus window.
2. The bulk of the project file rewrite routines have been removed. Any users who have not 

updated their programs recently will have to restart their builds from the Wizard stage in 
order to take advantage of all the new features in DBDOC.

Hyperview:
1. Contextual help has been added to all dialog boxes.
2. The database search has been changed to allow for partial matches on tag names.
3. Tool tips have been added to text pane hotspots.

CIUMON:
1. The format in which the specs are sent to Hyperview to be displayed has been changed from 

scientific notation to floating point.

General:
1. The compiled help has undergone a major reworking.  The file has been broken up into 

multiple smaller linked help files as well as being reorganized.  A "Frequently Asked 
Questions" page has also been added for the interest of all users.

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 148 of 156



 DBDOC Release Notes  

Version 7.30  January 18, 2002
Hyperlink:

1. Some error messages have been reformatted, specifically regarding live wires not being 
connected and duplicate sources.

2. Apps are now sorted by user name within chapters.

Hyperview:
1. Fix bug where resizing of a window containing a stardard pane, after loading a meta pane, 

would cause the contents of the pane to disappear.
2. Minor fixes to improve performance.

CIUMON:
1. An option has been added to the restart dialog boxes where the user can override the value 

being sent out on bytes 4 and 6 (where applicable) for the restart command.  This is for 
testing purposes only and should be used in consultation with G. Michaels Consulting.

BuildPlus:
1. Append module header file name to the path displayed in the tree view of the Duplicate 

Module Header dialog box.
2. All files that are opened by BuildPlus are now closed when the user presses the STOP button. 

This prevents any lockups that may occur on subsequent build runs.
3. WinZip tool has been fixed for users with evaluation versions of WinZip.
4. Minor fixes to improve performance.
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Version 7.22  January 4, 2002

Hyperview:

1. Additional live loop monitoring options are now available.  Users are now able to view 
manual live loop data on text files by right clicking on a given point and selecting "Get 
Output" from the pop-up menu.  As well, a one time snapshot of the live data can be taken by 
clicking the "Live Loop Snapshot" button on the toolbar.

2. Accurate hotspot count should rectify problems encountered with some displays.
3. Search phrase parsing in the "Full Text Search" has been improved.  The user has the option 

of specifying whether or not to use leading and trailing asterisks in his search phrase.
4. Zooming in Audit Window.  When selections are made in the Audit Window the graphic link 

is enlarged in the drawing pane.

CIUMON:

1. Fixes have been implemented in order to handle a known Microsoft sockets problem for 
Windows 2000 systems, i.e. error 10054 and  10038.  In order to take advantage of these fixes, 
those with Windows 2000 systems must have Service Pack 2 installed on their computers. 
Other operating systems are not affected by these fixes.

2. Additional user option under "Configuration" which allows the user to force CIUMON to send 
out all commands on key 0.

Wizard:
1. New Appearance. Due to recent improvements in BuildPlus, Wizard's appearance has been 

streamlined to make choices clearer and less confusing.
 
Hyperlink:

1. Improved AutoCAD Representation.  The text in hotspots now reflect the actual symbol 
names.

2. Improved Operator Graphics Representation.  AutoCAD 2000 support has been solidified 
thus rendering more accurate graphics.  

BuildPlus:

1. 1. Multiple Database Selections now Implemented. The user now has the option of building 
multiple databases of the same type, for example, two EBP databases and four Conductor 
databases.  

2. User Interface for Console.cfg File Creation.  With the new feature of multiple database 
handling in BuildPlus, it is now necessary to be able to associate the user graphics with the 
correct databases.  In the event of multiple tag and trend databases being selected, a dialog box 
will appear asking the user to make the correct associations for their various graphics paths.  
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BuildPlus will then generate a file in the graphics directory named CONS_GMCL.CFG with 
the appropriate information so that it can be read on subsequent runs.

3. New /buildall Functionality from Command Line
◦ If BuildPlus is triggered from the command line with the /buildall switch and specified 

build root, only the projects in that specific root will be rebuilt from the RAW stage.  For 
example,

     
BUILDPLUS /buildall C:\BUILD1

• BuildPlus will only build only the projects it knows of in C:\BUILD1.
     BUILDPLUS /buildall

• will build all known projects in all existing build roots.

4.  Additional System Information in DBDOC.ERR. Information regarding hardware and system 
settings has been added into the Project Settings portion at the end of the DBDOC.ERR file.

5. BuildPlus Main Window Message Log Default ON.  Messages that are generated in the main 
message window of BuildPlus are being logged into a file called 
<Project_Name>_<Build_Date>.LOG. This file is located in the project directory.  This 
option is always ON by default; if you wish to disable logging, select the option under the 
Tools menu option.

6. Additional error reporting in Decomposer. Duplicate references to the same IREFs and 
OREFs are reported.

                      
 
                          

DBDOC for ABB® INFI90® systems, BuildPlus and Hyperview copyright© 1996-2023 by G. Michaels Consulting Ltd. ABB, INFI 90, and related marks are either registered  
trademarks or trademarks of ABB Group.  AutoCAD is a registered trademark of AutoDesk, Inc. RoviSys® and its products are either registered trademarks or trademarks 
of RoviSys Company. PI is a trademark of OSI SOFTWARE INC.

2023-3-7            DBDOC Release Notes — Page 151 of 156



 DBDOC Release Notes  

Version — January 29, 2001
Overview

BuildPlus
1.  Main Window Log
2.  Launch Windows Explorer
3.  Improved Titles in CFG File
4.  New DBDOC_SUMMARY.ERR

Hyperlink
1.  Improved Batch File Reference
2.  Add Aliases for Cross-References
3. Improved "No Source" messages

Hyperview
1. Miscellaneous Text Field in Database Search

BuildPlus

1. Main Window Log – You now have the option of creating a log of the messages that appear 
in the main message window of BuildPlus.  Select the "Log Build Messages" option under the 
"Tools" menu and enter the name of the log file or use the default one provided.

2. Launch Windows Explorer – Windows Explorer can be launched from the "Tools" menu 
option. If you are presently working in a project, Explorer will be opened in that directory.

3. Improved Titles in CFG File –  BuildPlus will parse the DisplayNames.txt file created from 
the Decomposer run in Composer projects and extract the titles created there.  These will then 
be inserted into the project CFG file to provide better titles in the final M14 document.

4. New DBDOC_SUMMARY.ERR – DBDOC_SUMMARY.ERR now contains all error and 
pertinent log files in one complete document.  The entries are sorted by time and date, from 
earliest to latest, to provide an overall view of the most recent build process.

Hyperlink

1. Improved Batch File Reference – Unit filenames have now been added to the batch file 
references in the table of contents in the M14 file.
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2. Add Aliases for Cross-References – Hyperlink is able to make cross-references between the 

CLD and CAD names, as well as the DT short filename and long descriptive name. This 
enables you to search by either name in Hyperview's Topic Title Index.

3. Improved "No Source" Messages –  The "No Source" messages are now generated and sorted 
according to the type of missing source - whether it was found on a CAD sheet, graphic or in 
a database.

Hyperview

1. Miscellaneous Text Field in Database Search – An additional field has been added to the 
Database Search - "Miscellaneous Text".  This allows you to search for text strings in the 
database, either alone or in combination with any other the other fields in the search dialog 
box.
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Version — January 19, 2001
Overview
This version of DBDOC supports fully implemented ABB INFI-90:

 Composer through Version 3.1,
 Conductor VMS
 Conductor NT through Version 2.3
 WinCAD / WinTools
 Ladder
 BATCH
 CADEWS
 MCS/OIS and PC View SODG

Notable New Features

BuildPlus
1. Specialized Composer, Conductor and WinCAD support.
2. Multiple Database Support
3. Full WinCAD / Composer Console Configuration Support
4. AutoCAD and Text File Association

Hyperlink
1. Improved Function Code Handling
2. CAD Titles in Main Table of Contents
3. Batch File Support
4. Allen-Bradley RTU Documentation Support

Hyperview
 Presentation of Bad Quality

CIUMON
 Improved CIUMON Reliability

 
BuildPlus

1. Specialized Composer, Conductor and WinCAD support.

Buildplus will build the majority of systems (Composer, Conductor and WinCAD) with very 
little additional input.  The Project Type Specification dialog has been created to allow 
specification of meaningful combinations of ABB INFI-90 versions.

For many current configurations, simply specifying the Composer project, the Composer NT 
access database or the WinCAD FoxPro database will make most of the build occur 
automatically.
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2. Multiple Database Support

Support has been added to allow for the selection of multiple databases to be built into 
DBDOC.  Multiple tag and trend lists are supported automatically.  In the case of WinTools, 
Composer and Conductor, they are pre-extracted before the Wizard is run. BuildPlus is able to 
preset some of the Wizard settings in order to simplify the file search.

3. Full WinCAD / Composer Console Configuration Support

BuildPlus ensures that graphics are built with the correct database using the Console.cfg files 
which specify the tag and trend databases associated with the graphics.

4. AutoCAD and Text File Association

You can now associate AutoCAD .DWG and MicroStation .DXF drawings, plus Text files 
with a specific loop, PCU and module simply by naming the directory in which the files are 
found DXFLPPMM and TXTLPPMM, respectively.

Hyperlink
1. Improved Function Code Handling -- Links and hotspots have been added for TSTALM 

function code 69.links have been created for blocks 1 to 9 for function code 70.

2. CAD Titles in Main Table of Contents -- In Composer, the titles of the configuration sheets 
are extracted from the project and used in DBDOC automatically.

3. Batch File Support -- Multiple unit files are applied to replicated copies of the same batch 
document found in the same directory.

4. Allen-Bradley RTU Documentation Support -- Support has been added for the processing of 
AB and RTU files.

Hyperview

 Presentation of Bad Quality -- Hyperview now presents values that are Bad Quality in a 
muddy yellow hue.

CIUMON

 Improved CIUMON Reliability -- The reliability of CIUMON has been improved because we 
have learned more about its status messages.
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